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MACtivities is an introduction and guide for first-time users of the
Macintosh®1 computer. The purpose of this text is to help you learn
to use the Macintosh's operating system. The Mac is easy to learn
and quick to put to use. The text also tells how to use word processing and paint and draw graphic programs. With this information
you will soon be able to use the Mac to produce useful documents
efficiently and quickly.
The text is divided into two parts. The first part, Chapters 1-4,
describes the Mac's basic operating system. In this part you will
learn operations of the computer that are applicable to any software program. In the second part, Chapter 5 introduces you to
word processing on the Macintosh. Chapters 6 and 7 introduce features in paint and draw programs. The procedures described in
these three chapters are the same for all software applications of
that type. For example, all word processing programs are similar in
the way they are used to enter, edit, and format text. Chapter 5
describes how to do these basic tasks to create text documents
using the features available in all word processing programs. The
many graphic applications that can create a paint or draw image
also have many basic tools and procedures that work the same way.
Chapters 6 and 7 describe how to create simple graphics using features common to all paint and draw applications. Chapter 8
describes the procedures for printing documents created in the
chapters on word processing or graphics. You can skip to Chapter 8
as soon as you have a document ready to print. The chapter
includes procedures for printing with the ImageWriter 1 ,
LaserWriter 1, or other printers that can be used with the
Macintosh.
'Macintos h is a trade mark of Mcintos h Laboratory, Inc., and is used by Apple Computer, Inc., with its
express pe rmission. ImageWriter, lmageWriter LQ, LaserWriter, Finder, HypcrCard, TeachText, Qu.ick
Draw, and the Apple logo are registered trademarks or copyrights of Apple Computer, Inc.
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Preface

Four appendixes include information about managing disks and
directories, desk accessories, special keyboard characters, and solutions to the chapter self tests.
Each chapter begins with objectives for the chapter and a list of
important terms that identify features of the Macintosh computer
or procedures about which you will be learning. These terms are
defined in the chapter and in the glossary. At intervals within the
chapters, you will find MACtivities, hands-on exercises for practicing the procedures described in. the text. Immediately following
e ach MACtivity is a Screen display, a description of what you
should see happening on the screen as you work through the activity. Near the end of each chapter in Part 1 is More About..., a section
that gives more detail about the items or procedures introduced
earlier in the chapter. At the end of each chapter, a self test will
help you check how well you understood the chapter contents.
The text refers to a number of programs that can be used to
complete activities in Chapters 2, 5, 6, and 7. The word processing
programs include MacWrite 2 , MacWrite II, Micros oft3 Word,
Microsoft Works, Microsoft Write, WordPerfect\ WriteNow5 , and
FullWrite Professional 6 • Graphic programs include Canvas 7 ,
CricketDraw8 , CricketPaint8 , DeskDraw9 , DeskPaint9 , Freehand 10 ,
Ful1Paint6 , Illustrator 11 , MacDraft 12 , MacDraw2, MacPaint2 , and
SuperPaint13 •
' MacWrite, MacDraw, and MacPaint are registered trademarks of Claris Corp.
' Microsoft is a registered trademark of Microsoft Corp.
' WordPerfect is the registered trademark of WordPerfect Corp.
' WriteNow is the registered trademark ofT/Mak er Co.
"FullWrite Professional and FullPaint are registered tradema rks of Ashton-Tate Corp.
'Canvas is the registered trademark ofDenebn Systems, Inc.
'CricketDraw and CricketPa int ore registered trademarks of Cricket Software, Inc.
' DeskDraw and DcskPaint ar e registered trademarks of Zedcor, Inc.
1
°F rechand is the registered trademark of Aldus Corp.
"Illustrator and PostScript are registered trademarks of Adobe Systems, Inc.
"MacDraft is the registered trademark ofinnovative Data Design, Inc.
''SuperPaint is the registered trademark of Silicone Beach Software, Inc.
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The Basic System

ix

Getting Started

Objectives
After completing this chapter, you will be able to:
1. Identify the hardware and software components of the computer.
2. Start the Macintosh computer and load a disk.
3. Identify items on the desktop.
4. Use the mouse and mouse button to select and move items on
the desktop, open and close windows, open and select from the
menu, and edit text in icon titles.
5. Use the keyboard to enter text for icon titles.
6. Eject the disk and shut down the computer.
7. Handle and store your disk to protect it from damage.
Important terms
These terms are defined in this chapter and used in describing
procedures throughout all chapters. The terms and their definitions
also appear in the Glossary at the end of the book.

application
backup disk
clicking
close box
command
Command key
data disk
desktop
double-clicking
dragging
Finder

floppy disk
folder
highlighted
I-beam
icon
insertion point
keyboard
menu
menu bar
mouse

mouse button
Option key
pointer
select
software
startup disk
System file
trash
window
write-protect tab
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Part 1 The Basic System

Before You Can Start ...

The three major hardware components of the Macintosh computer
are the main unit, the keyboard, and the mouse. The main unit
houses the memory and processor board, the internal disk drive,
and the screen. There may be other components attached, such as a
second disk drive unit, which are not essential to basic operations
but offer more flexibility and convenience or perform special functions.
The other item you will need before you begin using the computer is a disk with a System file and a Finder which contains the
instructions that allow you to manage the information you put into
the computer. This disk is called a startup disk. Without these
instructions contained on the startup disk, there is r eally nothing
you can do on the computer.
You may be using a disk that has an application on it and
includes a System file and Finder. An application is programmed to
do specialized work, such as word processing (creating or editing
text), creating graphs or pictures, manipulating numbers or other
data, composing or playing music, playing games, or doing a host of
other tasks. These programs are referred to as software. Some
applications will be described in later chapters in this book.
Starting the Computer

Figure 1-1
Main power switch

The main power switch is at the back of the main unit, on the left
side as you face the screen. It is a rocker switch, just above the
main power cord (Figure 1-1).
Note: If the computer has an external hard disk drive, a separate
unit connected by a cable to the main unit, you will need to switch
it on for about 15 seconds before switching on the computer. An
external hard disk will look like a box, sitting underneath or to the
side of the main unit. For more information about hard disks, see
the More About Disks section at the end of this chapter.

;pii MACtivity 1-1: Starting the computer. Press the top of the
~ main power switch to turn the computer on.

liil Screen display: The computer will sound a tone when you

B turn on the power switch. After a few moment s warm-up, the
dark screen will turn a lighter grey, and a small drawing will
appear in the center of the screen.
The drawing, called an icon, looks like the outline of a disk with
a blinking question mark superimposed on it. Icons are pictoria]
symbols-they identify actions that you perform or functions that
are used in the operation of the computer. The icon you see now is a
symbol asking you to insert a disk.
If the computer has a hard disk, this icon will not appear. A h ard
disk will have the System file and Finder installed, and probably
applications as well. Starting th e computer with a hard disk will
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Figure 1-2
Brightness control dial
on comp uter
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take you directly to the desktop, described later, without loading a
floppy disk .
If the screen does not light up shortly after the power is switched
on, the br ightness control may be turned to dim_ The brightness
control dial is under t he ledge a t the front of the main unit just
below t he left side of the screen (Figure 1-2). You can feel the dial
with the tip of your finger. Turn it clockwise to brighten the screen .

p
SCREEN
BRIGHTNESS
CONTROL
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MACtivity 1-2: Loading a disk. Insert the disk in the drive

~ slot at the front of the main unit just below the screen. The

label mus t be facing up, and the edge with the metal shield must go
into th e slot first (Figure 1-3). A gentle push should slide it into the
slot- if ther e is resistance, ch eck to make sure t h e disk is in the
corr ect position. If your com puter has t wo fl oppy drive slots, load
the disk in th e top slot.
Note: If your computer h as a hard disk drive, you may not need
to load a floppy disk at this time. Most hard drives have the system softwa r e installed on them a nd are the startup disk .
1§1 Scre en display: When you ha ve push ed the disk near ly all
B t he way into the slot , the computer t ak es over and draws it
into po sition. You will h e ar a clunk whe n it is seated . On the
screen , the icon with the question mark is r eplaced briefly by an
icon called Happy Macintosh or a message Welcome to Macintosh .
Soon sever al items begin to appear on the screen- two icons at the
right edge, a white strip across the top of the screen with some
words on it, and perhaps a white, rectangular area that covers part
of the grey background which has more icons on it . This is the desk top (Figure 1-4).
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Figure 1-3
Inserting dishette

Figure 1-4
Opening screen

The Desktop
Loading the disk automatically starts to mak e things happen on
the screen. After the disk drive whirs a moment or two, the first
icon you saw with the blinking question mark was replaced by a
fresh gr ey ar ea covering most of the screen . This grey area is called
a desktop. A whit e strip across the top contains sever al words and
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Part 1 The Basic System

a small icon in the shape of an apple. This strip is called a menu
bar. 'l\vo more icons appear on the desktop. At the top right is the
disk icon for the startup disk you just loaded or a hard disk. The
name of the disk appears below the icon. Another icon, in the shape
of a trash can, usually appears at the lower right on the screen.
This trash icon does exactly what its name suggests- it is a place
to trash, or erase, any unwanted documents on the disk.
You may also see a larger white rectangle appear on the screen,
or perhaps even two or more rectangles overlapping each other.
Each rectangle is a window, an area that displays the icons for the
applications, system software, and documents that are stored on
the disk. If a window is displayed, it simply means that whoever
used the disk last did not close the window before shutting down.
You will learn more about windows later in this chapter and in
Chapter 3.
The Mouse

The mouse is a small box-like device attached by cable to an outlet
at the back of the main unit. The mouse is used for many operations, as you will see as you progress through these chapters. For
now we will limit its operation to those actions you can perform
with it on the desktop.
To operate, the mouse needs a smooth flat space next to the keyboard, approximately 10 inches to 12 inches square. The space can
be to the right of the keyboard if you are right-handed or to the left
if you are left-handed. The surface must be smooth so the ball on
the bottom of the mouse can roll easily. A special fabric-surfaced
pad for the mouse is ideal, but not essential. Be sure the cable
extending from the front of the mouse is free to move with the full
side-to-side and front-to-back movements of the mouse.
Hold the mouse so that your forefinger rests naturally on the
large rectangular button at the top. By moving the mouse on its
surface in any direction and pressing or clicking the button, you
will accomplish a wide variety of actions and send commands to the
computer.
Th e po inter
The pointer is a small graphic symbol on the screen that duplicates the movement of the mouse as the mouse rolls on its surface
(Figure 1-5). The pointer is used to locate the position at which you
want some action to occur.
The shape of the pointer is a slanted arrow much of the time
when working on the desktop, but the arrow is only one form of the
pointer. Pointers appear in many other shapes, depending on what
application you are using and what type of operation you are performing. On the desktop you will also be using the I-beam pointer
and the insertion point, explained later in this chapter. The shapes
of other pointers will be identified in the chapters on applications.

Chapter 1
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MACtivity 1-3: Moving the mouse pointer. Without pressing the mouse button, move the mouse around on its surface
while watching the screen.

~

1§1 Screen display: Moving the mouse forward (away from you)
B causes the arrow to move up on the screen. Moving the mouse
backwards (towards you) moves the arrow down on the screen.
Moving· the mouse to the right moves the arrow to the right.
Moving the mouse to the left moves the arrow to the left. The movement of the pointer parrots the movement of the mouse in all directions.
If an arrow pointer is not already visible on the screen, you
should see one appear from the margins as you move the mouse
around. If you run out of space for the mouse to travel before the
arrow has crossed the full screen width or height, pick up the
mouse and reposition it at a spot that will give you room to continue movement. The pointer will not move unless the mouse is
placed on the surface. The ball on the bottom of the mouse must
touch the surface and rotate to move the pointer.

6
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The mouse button
Just moving the mouse, however, does not accomplish anything except position the pointer at a desired spot on the screen. To signal
the computer that you want it to perform an action , you must press
the mouse button. Some actions require pressing the button without moving the mouse, and some actions require pressing the button in conjunction with a mouse movement.
There are four distinct ways to use the mouse button, or a combination of the mouse button and mouse movement. The four ways
are clicking, double-clicking, pressing and holding, and dragging.
Each is described in the following paragraphs with exercises to give
you practice using these important routines.
CLICKING
Depressing the mouse button once and immediately
releasing it without moving t h e mouse is known as clicking.
Clicking is tapping the button with your forefmger firmly enough
to make certain the button travels to its full down position before
being released. Clicking is used primarily for selecting icons and
placing insertion points in text on the desktop. Other uses for clicking will be explained in following chapters.

I

Trash

;P' MACtivity 1-4: Selecting icons. Move the mouse so the

IDiii

~

arrow point is inside the boundary of the trash can icon and
click the button once.

rel Screen display: The icon reverses; that is, it changes from a
8 drawing with black lines against a white background to a
drawing with white lines against a black background. Click again
with the arrow moved away from the icon, and it reverses to its
original state.
In order to identify which icon you want to take some action
with, you must first select it. The act of selecting alone does not
perform the action but tells the computer to which item you are
going to apply a following command or mouse action. When an icon
is selected, the whites and blacks in the icon are reversed-the
lines and letters that were originally black become white, and the
background that was originally white becomes black. When selected, the reversed icon is said to be highlighted. Selecting and
highlighting are also used when working with text, as you ·will see
later in this chapter.
DOUBLE-CLICKING
Clicking the mouse button twice in rapid
succession without moving the mouse is called double-clicking.
The interval between clicks must be very short-if you have a problem making double-clicking do the operations that are described,
you may need to adjust the double-click interval at the control
panel (described in Appendix B). Double-clicking is used to extend
a command to the next step beyond the single click; for example,
double-clicking on a document or application icon does the same
thing as clicking on the icon to select it, and then selecting the
Open command from the File menu.

Chapter I
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'fl!!!!!l4 MACtivity 1-5: Opening windows. Move the pointer back
~ over the trash icon, if it is not already there_ Click the mouse
button twice in rapid succession (double-click)_

Ril Screen display: A window should appear near the bottom of
B the screen with the name Trash as its title (Figure 1-~). If a
window did not appear, try double-clicking the trash icon again.
Figure 1-6
Double-clicking the trash
can icon opens the trash
window_
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Remember, double-clicking is pressing the mouse button twice,
quickly. Note that when its window is open, the trash icon is
changed from a drawing with a solid black background (selected) to
a shaded area in the shape of the icon. This is useful to remember
since many windows may be open at one time, and some may be
hidden behind others. One way to tell that a window is open is that
the window's icon is an empty grey shape.

'fl!!!!!l4 MACtivity 1-6: Closing windows. Look for a small square

~ box at the top left corner of the trash window. This is the close
box. Move the pointer so the arrow point is inside the box and click

once.
n;H Screen display: The trash window folds into the trash icon,
B disappearing from the desktop. The trash icon will again be
highlighted with a soliq black background, indicating that the icon
is still selected.
We will do more with windows in Chapter 3. For now, if there
are other windows open on the screen, close them by clicl~ing once
on their close box.
Tip: To deselect any icons, move the pointer to any open area of the
desktop or windows and click.
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Simply pressing the mouse button
and holding it down without moving the mouse is called pressing
and holding. Press and hold is used primarily to examine commands in the drop-down menus.
PRESSIN G AN D HOLDING

~

MACtivity 1-7: Opening menus. Move the pointer so its tip
~ is on the word File in the menu bar at the top of the screen.
Press the mouse button and hold it down. Do not move the mouse.

lii1 Screen display: A menu box with a list of words or phrases,
B called commands, drops down from the menu bar (Figure 1-7).
The menu stays down as long as you hold down the mouse button.

Figure 1-7
Pressing the mouse button
with the pointer on a title in
the menu bar reveals a list
of commands.
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A command directs the computer to take an action when the
command word or phrase is selected from the menu. The first step
in selecting a command is to press and hold the mouse button to
open the menu that contains the command. Selecting the command
will be described later in this chapter.
~

Alarm Clock
Calculator
Chooser
Control Panel
Key Caps
Note Pad
i>uzzle
Scrapbook

MACtivity 1-8: Inspecting menus. Release the mouse but~ ton and move the tip of the pointer over the small apple symbol just to the left of the File menu. Press and hold. Open the
menus for the other titles on the menu bar to examine their commands.
1§1 Screen display: The menµ for each title on the title bar drops
B down and stays down as long as you hold the mouse button.

A menu is a list of commands directing the computer to perform
an action. Some commands apply only to icons or other items that
have been selected, such as opening an application or duplicating a

Chapter 1
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document. Other commands perform system management tasks,
such as providing information or shutting down.
On the desktop, the Apple menu lists desk accessories, system
management tools, and other accessories that can be used while in
any application program. You will learn more about desk accessories in Chapter 4 and Appendix B.
The other menus have commands that you can use on the desktop. Each application program you use has its own set of menu
names that appear on the menu bar when the application is open
and in use. Some menus and commands are common for many
applications, while others apply to the specialized functions of the
program.
While examining the menus, you will see some command phrases
that appear grey. The grey, or dimmed, commands are those commands that cannot be used at the moment. Other actions, such as
making a selection, must be done before the dimmed commands
change to solid black letters and can be used.
DRAGGING
Pressing and holding down the mouse button
while moving the mouse is known as dragging. Dragging is used
to move icons, to select commands from menus, and to select text.
Later chapters will explain more uses for dragging.

p

MACtivity 1-9: Moving icons. Move the pointer back to the
trash can. With the arrow point on the can, press and hold
down the mouse button. While pressing the button, move the
mouse to the left and point at another area on the grey desktop.
Release the mouse button.

~

1§1 Screen display: When the mouse button is pressed and held

B

on the icon while the mouse is moved, an outline of the icon
moves with it (see Figure 1-8 on page 10). When the button is
released, the trash can icon jumps to the new position of the
outline.

In the next MACtivity, you will use a command that creates a
folder. Folders on the Macintosh electronic desktop are used much
like you use file folders on a real desk. With file folders you can
organize a scattered assortment of documents into logical groups,
such as personal letters, addresses, or English assignments. In this
chapter you will be creating and editing titles for a folder. In later
chapters, you will be creating and storing documents in folders.

Part 1 The Basic System
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Fig ure 1-8
A n outline of the
icon moues with
the mouse.
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MACtivity 1-10: Choosing a command from the menu.

~ First, open the disk window again if it is not already open. To

open the disk window, point the arrow at the disk icon in the upper
right corner of the desktop and double-click. Move the pointer to
File on the menu bar. Press and hold the mouse button so the File
menu remains open. While still holding the button down, drag the
mouse to move the pointer down the menu until the pointer is at
the first command on the list , New Folder. Stop there and release
the mouse button.

00 E

l(J1 Screen display: On the menu, a band containing the words
B N ew Folder becomes black, or highlighted, with the words in
white. When the mouse button is released, the menu disappears
and a new icon titled Empty Folder appears in the window on the
desktop in the shape of a file folder. (Figure 1-9)
Figure 1-9
The Empty Folder
icon is created by
using the New Folder
command.

78K available

Sys tem Folder

MacPaint
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Warning: Do not select any of the other commands now before
you know what will happen for each command. Other commands
will be described in later chapters.
The Keyboard
The final h ardware component of the Macintosh basic unit is the
keyboard. The keyboard is very similar to the keyboard on a typewriter. The letter, number, and punctuation k eys are in the same
locations as on a typewriter keyboard, as are the tab, return, shift,
caps lock, and spacebar. The feel of th e keyboard when typing text is
much th e same as an electric typewriter. As with some electric typewriters, the keys repeat if they are k ept depressed. Very little pressure is required in typing, malting a deft, light touch a necessity.
There are a limited number of operations that use the keyboard
while you are on the desktop. More information on th e keyboard
and its special keys will be found in the More About... section in this
chapter and in the chapters on applications .

•
•0

Empty Folder
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p

MACtivity 1-11: Titling icons on the desktop. In the disk

~ window, locate the new folder titled Empty Folder that you

created in the last exercise. Select th e folder. Make sure both the
folder icon and the title under it are highlighted. If they are not,
click on the folder again. From the keyboard, enter your first name
followed by th e word folder, as in Susan's folder. Deselect the icon
by moving the pointer to a blank area in the window or desktop
and clicking.

1ii1 Screen display: The name you entered replaces the Empty
B Folder title under the folder icon. Deselecting removes the
highlighting from the folder.

•
•
•
•

Susan's folder

Susan's folder

Susa n's I

Susan's notesl

If the name you entered does not replace the title of the icon,
click on the folder icon again to highlight it and enter the new title
again.
Remember, to deselect items, move the pointer to an empty spot
in the window or elsewh ere on the desktop, away from any icon,
and click. Any items selected become deselect ed. The next time the
folder is selected, both the folder and the title will be highlighted.

p

MACtivity 1-12: Editing t ext w ith the Delete key.

~ Highlight the folder icon you just r e-titled by selectin g it.

Move the pointer to the title area of th e folder icon, just to the right
of th e last letter of the word folder (the pointer changes to an I
shape). Click the mouse button once. Tap the backspace key (Delete
key) six times to erase folder. Enter th e word notes.

fiil Screen display: When you click t h e mouse button , the I
B shape becomes a blinking vertical line. Pressing the Delete (or
backspace) key moves the blinking line to the left, erasing a letter

Part 1 The Basic System
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each time the key is tapped. Typing in the n ew word moves the
blinking line to the right, in front of each new letter.

I

The large I shaped pointer is called an I-beam. The pointer
becomes this shape only when it is over a text area that can be
changed. When the I-beam is moved with the mouse outside the
text area, it becomes an arrow again.
When you click the mouse button, the I-beam changes to a blinking vertical line called an insertion point. The insertion point
locates the spot that the next action from the keyboard will take
place, either to add or delete text characters.

p

MACtivity 1-13: Editing text by dragging. Move the

~ pointer into the text area of your folder icon until the pointer

-

'"'!II.

•

Susan's records!

becomes an I-beam. Position the I-beam just before the word notes
that you entered in the previous exercise. Press the mouse button,
hold it down, and carefully drag over the word notes until the word
is highlighted, then release the mouse button. Enter another word,
such as records.

fii1 Screen display: The new word replaces the old word entirely

B

and leaves an insertion point at the end of the new word .

Highlighting a word by dragging over it with the I-beam is
another way to replace text. In this case, the first letter you enter
for the new word removes all of the old word and places the insertion point after the first letter, ready for typing in the rest of the
letters of the word.
Pressing the Delete (backspace) key after the word is highlighted
eliminates the word, leaving the insertion point where the original
word begins. Pressing the spacebar also eliminates the word, but
moves the insertion point to the right one space.

Warning: Do not make changes to titles on any other icon you see
in the windows or desktop. Such changes can cause an error in
the computer's System file that can result in the loss of information or other malfunction.
Shut Down
If you wish to stop at this point, follow the directions below to clean
up your desktop, eject your disk, and shut down the computer. If
you wish to continue, read the More about... section that follows
and complete the self test at the end of this chapter. Then move on
to Chapter 2.
1. Since you will not be using the new empty folder you created
now, you can remove it from the disk window by dragging it into
the trash. When you drag the pointer and outline of th e folder to
the trash icon, be sure the trash icon is highlighted before you
release the mouse button.
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Warning: Be very careful when trashing any icons! Icons also
represent documents and applications. If icons are stored in
folders, trashing the folder will also trash anything stored in
the folder. If you want to make sure your folder is empty, open
its window by double-clicking the folder icon. Double check
carefully each time you want to trash an item to make sure you
really want to get rid of it forever.

2. Close the disk window by clicking on its close box in the upper
left corner of the window. Close any other windows that are
open. Closing windows is not necessary before shutting down,
but if many windows are open at once, closing them restores
some order to the desktop. Any windows left open when quitting
automatically reopen the next time the disk is used.
3. Press and hold the pointer on Special in the menu bar. Drag
down the menu to select Shut Down. A message box will appear
on the screen telling you it is safe to turn off the computer. Turn
off the power switch.
4. The disk in the internal drive will be ejected. Remove it and keep
it in a safe place (see Handling Floppy Disks in the More
About... section at the end of this chapter).
Note: If your computer has a hard drive, other shut down procedures are required. See Hard disks in the More About... section
that follows.

More About Disks
Disks and the information they contain are referred to as software;
the computer and other mechanical components are hardware. The
3 1/2-inch removable disk in a rigid plastic housing is referred to as
a floppy disk, a term that refers to the flexible magnetic disk
inside the housing where information is stored.
Disks contain all the coded information necessary to enable the
computer to do specialized tasks, such as word processing, drawing,
recording and processing business data, doing mathematical calculations, composing and playing music, playing games, or simply
storing data.
A hard disk stores information on rigid disks. A hard disk combines the storage disks, read-write heads, and electronic components in an integrated hardware unit. More information about
hard disks will be found later in this section.
Floppy disks
The disk is a flexible sheet of plastic, coated with a magnetic surface and shaped like a small phonograph record. The disk is housed
in a rigid plastic cover. At one edge of the disk housing a metal
shutter covers an open rectangular slot in the housing. This slot
exposes a section of the disk surface inside. The shutter protects the
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disk surface from dust and should never be moved aside when handling the disk. When the disk is inserted into the computer, the
disk drive mechanism pulls the disk into place and moves the shutter aside so that the computer can then read information from the
disk or write information to the disk as the disk is turned in its
housing.
The side of the disk housing that should be facing up when the
disk is inserted into the computer is the side that has the larger
portion of the disk label showing (Figure 1-10).
At the center of the bottom side of the disk housing is the disk
hub that engages the shaft of the internal disk drive. The drive
spins the disk past read and write heads that draw information
from the disk or, when you are ready to store a document that you
have created, write information to the disk.
At one corner of the bottom side of the disk housing you. will see
a small square tab in a slot. This is the write-protect tab. Moving
the tab toward the corner exposes a small square opening in the
disk housing. Placing the tab in this position prevents the computer
from writing information to the disk. The tab in this position also
prevents the computer from erasing information from the disk.
However, the computer is still able to read information that is
already on the disk.
A typical floppy disk stores nearly 800 kilobytes of encoded
information, which translates into roughly 300 single-spaced
typewritten pages, or a very extensive term paper.

Fig ure 1-10

Diagram ofa
fioppy disk

PROTECTIVE COVER
(SHUTIER)
READ/WRITE
ACCESS SLOT
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The very minimum a disk must contain to do useful work is a system folder, containing the System file
and Finder, and an application program. Other disks can be used
just for storage or backup of data; to view the icons on these disks,
you need to start the computer with a startup disk that contains a
system folder first.
Startup and Application Disks. Startup disks have a system folder that contains System files, applications used to start the computer and provide system-wide information. System files are necessary to open and run specialized applications for word processing,
graphics, and a host of other programs. System files include the
Finder, which manages the document and application icons on the
desktop and allows you to move information to and from disks.
Other management applications or utilities usually found in the
system folder, such as the printer drivers, scrapbook, and clipboard, can be used with all specialized applications.
Application disks have a program that is used to do a specialized
task. A word processing application, for example, provides the tools
for writing and formatting text. A graphic application will have a
palette of drawing or painting tools, plus other commands, available to produce pictures. Hundreds of application programs are
available commercially to make the comput!'!r useful for a wide
variety of functions.
Disks that have applications on them usually include a system
folder so that all the necessary components to do a specific job, such
as word processing, a're contained on one disk.
Data and Backup Disks. With an application and system folder
on a startup disk, there is often little space left over on the disk to
store documents that you create. A data disk is a disk devoted
entirely to storing these documents. A data disk does not need to
have the system folder or the application on it, so all the storage
space can be used for documents. To gain access to the documents
stored on a data disk, you still need to insert the application disk
you used to produce the document into the computer first. After
that disk has started the program, it can be ejected, and the data
disk containing your document can be inserted and opened.
A backup disk is essentially a duplicate data disk. A backup
disk contains dupbcate copies of the documents you create. Having
a second disk is insurance against losing the document due to an
accident or malfunction that results in the loss of the original disk.
It is prudept to back up your documents at regular intervals, at the
very least each time they are created or modified. If an accident
occurs, this minimizes the amount of time needed to redo the work.
If you heed the precautions listed in the next section, you may
never need the second copy, but there is some security in knowing
one is available.
TYPES OF FLOPPY DISKS

HANDLING FLOPPY DISKS
Although disks are enclosed in a
fairly rugged housing, observing some simple preventive care measures helps insuTe that you have a disk that functions reliably each
time you use it.
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• Do not slide the metal protective cover aside at any time. A
speck of dust or a fingerprint on the exposed segment of disk
could result in losing data on the disk.
• Store the disk where it is not exposed to extreme temperatures
above or below the recommended 50° to 125° range. Keep the disk
out of direct sunlight or away from a heater. Don't put the disk on
top of the computer where it is exposed to magnetism and heat.
Leaving the disk in a car on a sunny day also exposes it to excessive heat and is not a good practice.
• Keep water or other liquids away from the disk. Spilling a soft
drink or coffee on a disk is inviting disaster.
•Keep the disk well away from any magnetic device, such as
household magnets, electric motors or generators, audio speakers, telephones, and even the left side of the Macintosh main
unit, which contains the power supply. The distance away
depends on the strength of the magnetic source-in the case of
the Macintosh main unit, six or eight inches should be a safe
enough distance. Information is stored magnetically on the disk,
and the proximity of a magnet can scramble data.
• If you write on the disk label, do it with a soft pencil or felt or
ball-tipped pen, using very light pressure. Bearing down while
writing can distort the protective cover and force it against the
disk.
USING TWO FLOPPY DISI< DRIVES
On some computers, two
slots, or two disk drives, for floppy disks are available in the main
unit. Also a computer with one disk drive may have an external
second disk drive. Either drive can be used for the startup disk, but
usually the top drive is used for the disk with the system folder
and applications, and the second drive is used for data and backup
disks. Some applications are too large to fit on the same disk with
the system folder; in this case, one drive can be used for the system
disk and the other for the application disk.
With a second drive, it is much simpler to copy documents you
have created to a data or backup disk or to copy entire disks. With
a single drive, to copy a document from one disk to another, the
document must be loaded into the computer's internal memory
from the originating disk, then the disk must be ejected and the
receiving disk inserted so the document can be copied to it . If the
internal memory cannot hold all of the document at one time, it
must be copied in segments, swapping disks for each segment.
With a second drive, both the originating and receiving disks are
loaded at the same time with one disk in each drive. Then, if the
computer needs to read the original document and write to the
receiving disk in segments, it all happens internally and no disks
need to be changed.

Hard disks
As the name implies, a hard disk is made of very rigid material.
Actually a hard disk is a set of disks that act in unison as one disk.
The disk is housed with its own disk drive as a unit. Some hard
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disk units are enclosed within the computer's main unit; others are
in a separate box outside the main unit and are connected with a
cable that plugs into the back of the computer.
A hard disk has a much greater storage capacity than a floppy
disk. Typically a hard disk stores 20 to 100 megabytes (or more) of
information; a 20 megabyte hard disk stores as much information
as twenty-five 800 kilobyte floppy disks.
Since a hard disk has a great amount of storage, it is usually
used as the startup disk; the system folder with the System file,
Finder, printer drivers, and a variety of other utilities are installed
on the disk, plus all the application programs the user needs. Even
with a variety of applications residing on the disk, ample room is
left for many documents. Floppy disks n eed not be used at all; however, backup copies of the information on the hard disk should still
be kept on floppy disks since a hard disk can malfunction or be
damaged (called crashing) causing data to be lost.
A large number of manufacturers offer hard disks for the
Macintosh, so some variation between brands of hard disks will be
found in their startup and shut down procedures. Internal hard
disk drives (those installed and housed in the main unit of the computer) are often integrated with the computer's power supply. That
is, the hard disk is started with the same power switch as the computer. Also the Shut Down command usually parks the read-write
heads on most internal hard disks before the power is turned off.
Usually external hard disk drives need to be turned on for a few
seconds before the computer is switched on. Also, external drives
may have a special routine for parking the read-write heads before
power to the computer is switched off (parking the read-write heads
moves them safely away from the sectors of the disk that store the
data; otherwise, if the drive is moved or jarred, the heads may contact the disk surface and damage the data). If your computer is
using a hard disk, you should consult its manual to see if special
procedures are necessary for either startup or shut down.
More About the Keyboa rd

Two special keys can be found on Macintosh keyboards that, used
in combination with regular keys or the mouse, greatly extend the
capabilities of the keyboard. By u sing many of the key combinations, called "keyboard shortcuts," you can speed up your work. A
third key, the Shift key, is a regular key used in writing text but is
also used with the mouse as a special key for some functions.

(ag

)

The Command key
The key next to the spacebar with the cloverleaf symbol on it is the
Command key. For many menu commands, you can use this key
plus a letter key to perform the same action as selecting the command from the menu with the mouse. Using the keyboard to execute a command is often much faster, especially for executing commands that are used frequently. You will find more information

18

Part 1 The Basic System

about performing keyboard commands in Chapter 4. The Command
key is al so often used in graphic s applications to do certain
operations with drawing and painting tools.
The Option key
The Option key is used in conjunction with other keys to offer a
range of special characters, such as symbols used in math ematics
and scientific text, diacritical maTks used in languages, true open
and closed quote marks, and a variety of symbols used in business
and other wliting. As with the Command key, graphic applications
make frequent use of the Option key for special functions.

)
)

The Shift key
The Shift key also functions as a multi-purpose key, in addition to
its usual use for malting capital letters. With word applications, its
special functions are in conjunction with either the Command or
Option key, occasionally with both. Some word processing
applications, for example, use the Shift, Command, and letter keys
in combinations to format text. The Shift key is used in graphic
applications to control drawing tools in special ways and is used on
the desktop for making multiple selections of icons, as will be
described in Chapter 3.
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Chapter 1 Self Test

Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.
A. Select one of the four choices that completes the sentence correctly.
1. The position of the disk when inserted in the computer should be:

a.
b.
c.
d.

label side up, shield edge into the slot first
label side down, shield edge into the slot first
label side up, label edge into the slot first
label side down, shield side to the right

2. If the mouse is lifted so its ball roller is not in contact with a
surface, the cursor on the screen:
a. moves to the nearest edge of the screen
b. jumps back to the beginning of the mouse movement
c. disappears
d. stays in a fixed position
3. In using the I-beam and insertion point when in a text area:
a . both the I-beam and insertion point move when the mouse
moves
b. the insertion point moves with the mouse, the I-beam moves
when typing
c. the I-beam moves with the mouse, the insertion point moves
when typing
d. the insertion point changes to a pointer when moved out of the
text area
4. The difference between a data and a backup disk is that a data
disk:
a. stores only applications and the backup disk stores documents
b. stores much more information than a backup disk
c. is just for statistical information and a backup disk is for other
kinds of documents
d. contains documents and the backup disk contains duplicates of
documents
5. To adjust the brightness of the screen:
a. you turn a dial at the back of the computer
b. you turn a dial at the front of the computer
c. you select a command from the File menu
d. you are out of luck since there is no adjustment
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B. Select the statement on the right that defines each word at the
left.
1. __ dragging

2. __ clicking
3. __ insertion point
4. _ _ I-beam

5. _ _ pointer
6. __ window

7. __ trash
8. __ menu

a. a device used to erase items on the desktop
b. an area that displays icons representing applications, documents, and folders
c. protects information on a disk from erasure
d. depressing and r eleasing the mouse button
e. a pointer used in text areas
f. moves anywhere on screen as the mouse moves
g. moving the mouse with t he button held down
h. a storage area for documents only
i. a list of commands needed to mak e certain actions occur
j. a blinking vertical line u sed in editing text

9. __ data disk

10. _ _ write-protect
tab

insertion point
Finder
startup
window
Option
menu
arrow
Command
system file
highlighted
icons
I-beam

C. From t h e list of words at the left, choose one to fill in each
blank in the statements that follow.
1. A disk that contains a system folder with an application is

referred to as a

disk.

2 A system folder must contain at least a _ _ _ _ _ _ _ and
a

to manage information on the desktop.

3. The sm all drawings that identify applications and folders on
the desktop am called _ _ _ _ _ __
4. The pointer used to select icons and menu commands is called
the _ __ _ _ __
5. The pointer used to place an insertion point in text is called a
6. Two of the special keys on the keyboard, used in combination
with regular keys are the
key and t he
_ _ _ _ _ _ _ key.
7. The command words that can be selected to perform a certain
action can be found in a _ _ __ __ _
8. You can tell if an icon i s sel ected because i t will be
9. You can d elete a l etter or word in a title by placing an
_ _ _ _ _ _ _ _ _ after it and backing over it with the
backspace or delete k ey.
10. Whe n you double-cl ick on a disk icon you open t h e disk
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D . Enter the letter of the mouse and/or mouse button action that
would be used for the following.
a. Clicking
b. Double-clicking
c.Press and hold
d. Dragging

l. _ _ _ selecting an icon or folder

2.

opening a window for a disk

3.

closing a window for a disk

4.
5.
6.
7.

opening a menu
selecting commands in a menu
moving an icon on the desktop
placing an insertion point in text

8.

selecting words in the title of a folder

.·

i

Creating Your
First Documents

Obj ectives
After completing this chapter, you will be able to:
1. Open an application and create two simple documents .
2. Save the documents and quit the application.
3. Create and title a folder on the desktop and move the documents
into the folder.
Im po rta nt terms
These terms are defined in this ch apter and in the Glossary.
check boxes
dialog box
directory
document

ldlobyte
message box
radio button
text button

I

text field
title bar

Using an Application
When you use an application, such as a word processing or graphic
application, you do so to create a document. Each letter, report, or
drawing is a separate document. In th e first part of this chapter you
will be creating two simple documents u sing a word processing or
graphic application, whichever is available to you. Later in th e chapter, and in Chapters 3 and 4, you will use your docwnent icons to
practice working with the filing and directory system on the desktop.
For this exercise, it does not matter wh ether you have a word processing or graphic application. Either type will allow you to create
simple documents with minimum use of the features of the program.
These features are described more fully in Chapters 5, 6, and 7.
23
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Word processing applications, such as MacWrite, MacWrite II,
Microsoft Word, WriteNow, or the word processor in Microsoft
Works are appropriate to use; or, if your computer has a recent system update, you may find a simple word processing application
included called TeachText. Appropriate graphic paint applications
include MacPaint, FullPaint, or SuperPaint.

Checking for Disk Storage
The amount of storage used by the application, system, and any
documents already on the disk is displayed in the upper center of
the window below the title bar. The title bar is the strip across the
top of the window containing the name of the window (Figure 2-1).
Each disk and folder window has a different title; however, the storage figure under the title, indicating the amount of storage already
used on the disk and the amount still available for new documents,
appears on all windows on the disk. If your computer has a hard
disk, you can expect the storage figures to be considerably larger
than the ones illustrated.
The storage is expressed in kilobytes, indicated by the K that
follows the number. One single-spaced typewritten page (about
2 1/2 screens of type) occupies approximately 3 kilobytes of storage
on the disk. Graphics usually take more storage space; a screen full
of painted graphics may use 5 to 10 kilobytes of storage, depending
on the amount of painting done in the space.
Figure 2-1
The strip across the
top of the window
is called the title bar.
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rlJ!!!!!I MACtivity 2-1: Checking storage. After starting the
~ computer, insert the application disk you will be using. Open

the disk window, if it is not already open, by double-clicking on the
application disk icon. Look for the disk information that shows the
kilobytes of storage available on the disk.
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If you are u sing a hard disk, the application may already be
stored on it. If not, start the computer with the hard disk, then
insert the application disk. The application disk icon appears just
below the hard disk icon on the desktop. Double-click the application disk's icon to open its window.

lii1 Screen display: When a disk window is open, the cunent
B amount of storage available on the disk is displayed n ear the
upper right corner of the window just below the title bar (Figure
2-2).
Figure2-2
The amount of available
disk storage is displayed
at the top of the window.
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If several windows open when you insert the disk, close all the
windows by clicking on their close boxes, then reopen the disk window by double-clicking on the disk icon.
The documents you will be creating need very little storage
space (less than 5K each) if you follow the suggested procedures.
However, it is wise to always check on available storage before
opening the application. Otherwise you may create a document too
large to save on the disk.
Application and Document Icons

Three types of icons that you will use regularly and need to recognize are the folder, application, and document icons. You created a
folder in Chapter 1. It is used for organizing documents and applications on the desktop, and its icon should already be familiar to
you. You open the application icon in order to write or paint a document. After you produce a document, title it, and save it on the
disk, the document will also have an icon on the desktop. This icon
allows you to open the document again at some future date to work
on it or to use it for some other purpose.
Each application icon has its own distinctive image, one that is
usually related to the function of the application. The document
icon created from using an application usually has a family resemblance to its application icon but is different enough so you can easily recognize it as a document and not the application. Figure 2-3
shows icons of six popular applications. Directly below each application icon is its document icon.
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Hiilll ~
Macwr;te

Microsoft Word

Microsoft Works

Macwr;te document

MS Word document

Works document
(word process;ng)
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MacPa;nt document

B

Fu11Pa;nt document

I

SuperP a;nt document

; p MACtivity 2-2: Opening the application. Locate the appli~ cation

icon in the disk window. Double-click on the icon.
Note: If you use the Microsoft Works application, first doubleclick on the Works icon. A window soon appears that has a row of
icons at the top (Figure 2-4). Find and double-click the icon titled
Word Processor or select the icon and click on the rectangle marked
New.
Fig ure 2-4
Opening the
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application
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liil Screen display:

The desktop is covered by a blank white
window. Soon things begin to appear on the window; usually
the menu bar appears first, then other application window components, followed by a pointer.

B

It takes about 10 to 20 seconds for the computer to load the
information that runs the application from the disk into its internal memory. Some programs flash a message on the screen
announcing the name and producer of the program, and often other
details such as a version number and copyright data, before the
working window comes on the screen.
In word applications the pointer is an I-beam. The insertion
point is already blinking in the upper left corner of the window,
ready for text to be entered (Figure 2-5). In paint applications, a
blank window appears which is the working area. To the side and
below the paint window are palettes of tools and fill patterns. The
pointer is usually in the shape of a black dot, which is a paint
brush tool (see Figure 2-6 on the next page).
Figure 2·5
Working area in a
word application
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I.__ INSERTION POINT

I.__ I-BEAM PO INTER
A WORD PROCESSING PROGRAM WINDOW

An alternate way to open an application, or a document or window, is to select the icon of the application you wish to open in the
desktop, then choose the Open command from the File menu. Most
of the time you will probably find double-clicking the icon much
easier and faster.
p l MACtivity 2-3: Making a simple document. If you opened a
~ word processing application, the insertion point is already in
place. Just start typing as you would on a typewriter. Enter a sent ence or two for this document. If you opened a paint application,
the pointer will probably be a paint brush tool that appears as a
black dot on the screen. Paint by pressing the mouse button and
dragging the mouse. Do a quick painting for this document, such as
writing your name with the brush tool.
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Figure 2-6
Worhing area in a
paint application
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Iii) Screen display: In the word processing application, the

12) words appear on the screen just as they would on a
typewritten page. In a paint application, the painted line on the
screen mirrors the path of the mouse movement as long as the
mouse button is held down and the mouse is on its surface.
If you make a typing error while in a word processing program,
backspace over it with the insertion point using the Delete
(backspace) key and re-enter. Do not use the Return key when you
get near the right edge of the screen since the sentence
automatically wraps to the next line. Use the Return key only if you
wish to start a new paragraph. The I-beam can be used to move the
insertion point to any spot in the typed area. If your keyboard is so
equipped, the arrow keys can also be used to move the insertion
point in the direction of the arrow without erasing the letters
already entered. More features of word processing applications are
explained in Chapter 5.
To start a new painted line with the paint tool, release the
button, reposition the pointer, then drag the mouse. If you click on
one of the squares in the pattern palette, the paint brush tool
paints in that pattern . More features of paint and draw
applications are explained in Chapters 6 and 7.

Saving the Document

The things you do in a document, whether writing with a word
application or painting with a paint application, are stored in the
computer's memory until the Save command in the File menu is
used. Until that time, all the work you have done is in temporary
storage. If the electrical power to the computer is shut off, even for
an instant, all the work you have done is lost. Using the Save
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command directs the computer to write a document you have produced in an application to a disk for permanent storage (or for as
long ~s you wish to keep the document).
A document that is stored on a disk has its own icon on the desktop and can be opened again by double-clicking the icon. Opening a
document from the desktop also opens the document's application
exactly as it was when the document was last closed, so additions
or revisions can be made.
The first time you save a document, the computer places a new
window on the screen called a Save dialog box. You must give each
new document a title if you want to save it so the computer can
find it again the next time you wish to open the document. A title
appears under each document icon on the desktop so that you can
identify what each document contains.
When the pointer is moved to the menu bar, it becomes an
arrow. Pressing the mouse button opens the menu. Dragging down
to highlight the command Save and then releasing the button
opens the Save dialog box (Figure 2-7).
Figure 2-7
Choosing Save from the
File menu opens a Save
dialog box.
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MACtivity 2-4: Saving the document. Select Save from the

~ File menu. In the dialog box that appears, enter First

Document and click on the Save button.

fii1 Screen display: A Save dialog box appears on the screen in
B front of the application window. A blinking insertion point is
in place in the title strip, waiting for you to enter a title. In some
applications, the title box is highlighted-the insertion point
appears when you start to enter the title. When you finish the title,
click the Save button. After you click the Save button, the dialog
box disappears, and in a few moments the application window with
the work you have been doing is restored on the screen.
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If you make a mistake in typing the title, backspace over the
error and re-enter. After clicking on the Save button, your document is saved to the disk, and a document icon with the title you
entered identifies it when you return to the desktop.
The Save dialog box appears the first time you save an untitled
document. As you work on a document, it should be saved to the
disk at regular intervals to minimize the loss of your work should a
power failure or other malfunction occur. Once the document has
been titled and saved initially, subsequent Save commands automatically update your document; the dialog box does not appear
after the first save.
Additional inforll1ation about the Save dialog box, other dialog
boxes, and message boxes can be found in the More About... section
at the end of this chapter.

Creating a New Document

Saue as ..•
Page Setup ...
Pri nt ...
Quit
:ICQ

It is not necessary to return to the desktop to create a new docum ent if the new document uses the same application. Closing a
document does not remove the application from the computer's
memory, and a new application window, or an old document done in
the same application, can be quickly displayed.

;pil MACtivity 2-5: Creating a second document. Close the
liiiiii:... current document by selecting Close from the File menu. Open
a new document with a blank window by selecting New from the
File menu. Enter a few lines (or paint) on the new document and
save the document with the title Second Document u sin g the same
procedures as you did with the first document.

liii Screen display: When New is selected from the File menu, a

t rente New Document:
Typo:

B new document working window will appear on the screen.
The same action s should occur with the second document as with
the first.
Note: After choosing New in Microsoft Works, a dialog box,
Create New Document, appears containing several icons and buttons. The icon for the word processing application should already
be highlighted. Click the OK button to produce a new document
working window.
Tip: Most application windows have a close box at the left end of
their title bar. Clicking on the close box does the same thing as
selecting the Close command from the File menu.
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You now h ave two documents that you will use in this and the next
chapter's activities. To return to the desktop, you first must quit
the application. The Quit command, unlike the Close command,
takes you out of the application and back to the desktop.

P

MACtivity 2-6: Quitting the application. Choose the Quit

liiiiii:... command from the File menu.
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B

Screen display: The application window disappears, and in a
few seconds the desktop appears on the screen. Icons for the
documents you have just created appear in the disk window
(Figure 2-8).

Figure 2-8
Icons for newly created
documents appear in the
disk window.
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If you forgot to save your current document, a dialog box
appears asking if you want to save the document. If this happens,
click the Yes button. If you haven't titled the document, a Save dia-

log box appears_ Enter the title and click the Save button.
Documents are always saved to th~ folder that is open in the directory of the Save dialog box when you click the Save button. If you
cannot find icons for your documents in a window that is open
when you return to the desktop, open other folder windows to
locate them.

Back on the Desktop
Once you have a few documents stored on a disk, you will want to
set up a system for organizing the documents. A good filing system
helps you locate documents and reduce the clutter on the desktop.
As you will see in the next chapter on using window features, a
window can contain a great number of document icons, in addition
to the application and system icons. However, after accumulating
icons for dozens of documents, it is efficient to store together all the
documents of similar kind, such as letters or reports. Just as you
use a file folder or a notebook separator to keep similar documents
together, you can use electronic folders to store your electronic
documents.

p

MACtivity 2-7: Creating a folder. Select the command New
from the File menu. While the empty folder is still
selected in the window, enter the title New Documents.

~ Folder
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fEi1 Screen display: Creating and titling this folder follows the

B

same procedures you used in Chapter 1. Review that
information if you have difficulty. When completed, the folder
should look like the one shown (Figure 2-9).

Figure 2-9
Folders are created
to store electronic
documents.
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MACtivity 2-8: Moving documents into the folder. Drag

~ the document icon titled First Document over the top of the

New Document folder icon (Figure 2-10). Release the mouse button.
Repeat the procedure for Second Document.
Figure 2-10
Documents can be
moued into a folder.
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li15I Screen display: When dragging a document icon, an outline

B

of the icon moves with the pointer over the top of the folder
icon. When the folder icon .becomes highlighted and the mouse
button released, the document icon disappears into the folder.

When you have moved both documents into the folder, doubleclick on the folder icon to open the folder window. Th e two
document icons should be visible in the open folder window (see
Figure 2-11 on the next page).
Shut Down
If you wish to stop at this point, close all the open windows on the

desktop by clicking their close boxes. Do not trash the folder or
documents that you have created-these will be used for activities
in the next chapter.
Select Shut Down from the Special menu. After the message box
appears telling you that it is safe to turn off the computer, turn off
the power switch. Remove the ejected disk and keep it in a safe
place.
Read the More About ... section that follows and complete the self
test at the end of this chapter before continuing to Chapter 3.
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Figure 2-11
Documents stored in
a folder will appear in
the folder window.
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More About Dialog and Message Boxes
Many of the commands that you select from menus display a dialog
box on the screen. A dialog box is a window that lists choices you
can make by clicking on a check box or button or by performing an
action such as typing a title. Menu commands that are followed by
an ellipsis (three dots ... ) display a dialog box that must be dealt
with before the command is completed.
Some dialog boxes, such as the Save dialog box that you used to
save the documents you just completed, have a directory that lists
all the documents, folders, and applications on the currently active
disk. The directory is a small window with the icons and titles you
have seen on the desktop. The icons and titles for folders are shown
in solid type, which means you can open the folder to see what is
stored inside by double-clicking the folder icon (or title); each folder
has its own directory which lists all the documents, applications,
and other folders within it. As each folder is opened, all of the contents of the folder are then shown in the directory window. The title
above the directory window also changes to the title of the folder
whose contents are shown. Don't be alarmed if titles of documents
you know to be in a folder do not appear in the dialog box or if a
folder directory shows no titles at all-the dialog box for the Open
command, for example, does not list titles of documents that cannot
be opened with the application being used.
To return to the previous directory display, press and hold the
mouse button with the pointer on the directory title. A small menu
drops down with the title of the previous directory. Drag the
pointer down to select that title, and the directory listing changes
back. Directories are part of the dialog boxes for the Save and Open
commands, two commands that you will use frequently. The contents of the directories reflect the filing system that you organize
on the desktop. You will find more information about organizing
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your documents and folders under The Hierarchical File System at
the beginning of Chapter 3 and in Appendix A.
Many dialog boxes, such as the Save dialog box, have a text
field, an area in the box that receives text so that you can give
your document a title or enter other information. A text field in
most dialog boxes is bordered by a rectangle; wh en you move the
pointer inside the rectangle, it becomes an I-beam. When a dialog
box first opens, often a text field has an insertion point already in
it, ready to receive an entry from the keyboard. Other dialog boxes
may have text fields for entering words or numbers for controlling
certain specifications of features offered by the application. A Page
Setup dialog box in some word processing applications, for example,
has small text fields for entering the number of inches wanted for
the width of margins around the text on a page.
Often text fields in dialog boxes have words or numbers already
entered in the field when the dialog box opens. These are usually
specifications or titles that are either preset as part of the application's design or entered by the user the last time the box was
opened. You can change all or part of an entry already in the field
with the text editing methods you have already u sed; set the insertion point in the field and use the Delete key to remove the current
characters, or drag over the field with the I-beam to highlight it,
then enter the new title or information. Another way to highlight
the text field is to double-click the mou se button with the pointer
anywhere in the field.
Dialog boxes also have at least two or three buttons; some have
many more. Buttons are of two types: those that cause an action to
take place, and those that specify a choice in a list of two or more
options. Rectangular buttons, called text buttons because a title
is written on the button, usually cause an immediate action when
clicked. The title of the button is a command, such as Save, Cancel,
Eject, or Drive. In these examples, clicking Save writes the current
document to a disk, Cancel r emoves the dialog box without making
any changes in the document , Eject ejects a floppy disk from a
drive, and Drive toggles between the internal floppy drive and any
other drives being u sed. Text buttons that have a thick border
around them can be activated by pressing the Return or Enter key
on the keyboard as an alternative to clicking on the button with the
pointer.
Other buttons, u sually small round or square sh aped buttons
with the title to one side, are Check buttons; you click on these to
signal a yes or no decision or to select from a group of options
offered. Small round buttons, called radio buttons, are usually
yes/no or on/off decisions; for example, to say yes to an option
offered in the title of the button, you would click on the button to
highlight it (a black dot in the center of the circle appears). Radio
buttons are often u sed when you must make only one choice among
several options; clicking one button in the group of choices deselects
any other button in the group that is highlighted.
Small square check boxes are most often used for features that
offer a range of choices in which one, a few, or all may be selected.
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For example, in specifying text styles, some applications use a dialog box with check boxes for each style option, such as bold, italic,
outline, etc.; clicking on the italic, underline, and bold check boxes
combines those styles in the text you are using in the document.
Another box that may appear at times, sometimes unexpect edly,
is a message box. A message box contains information, instructions, or warnings and often flashes on when you first open a program to give you data about the application. A message box may
appear when you have made an error in using some feature of a
program and often instructs you on the correct procedure. Other
boxes may forewarn that an action yo u are taking is
irreversible-that you may lose or destroy data if you go further.
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Chapter 2 Self Test

Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.

A Select one of the four choices that completes the sentence
correctly.
1. To find out if you have room to store a document on a disk, you
would check:
a. an information box in the system folder
b. below the title bar in the disk window
c. the disk label
d. by selecting Save in the File menu
2. If you finished a document and wish to create a new one with the
same application, you:
a. must always select Quit from the File menu and double-click
the application icon on the desktop to open it again
b. select Save from the File menu and enter a new title in the
Save dialog box
c. select Close, then New from the File menu
d. select Close, then Open from the File menu
3. On the desktop, to place a document into a folder:
a. the document icon can be dragged on top of the folder icon
b. the folder window must be open before the document is saved
c. you first select the folder icon, then the document icon
d. you drag the folder icon on top of the document icon
4. Document icons:
a. look like all other icons
b. usually resemble their application icons
c. look like the icons of their folders
d. have a different style of type in their titles than other icons
5. When you click the Save button in the Save dialog box:
a . your document is saved to the disk
b. the application is saved to the disk
c. you are returned to the desktop
d. you can no longer work on the document

1. __ directory

2. _ _ message box
3. __ document
4. __ text button
5. __ dialog box
6. _ _ text field
7. _ _ application
8. _
kilobyte

B. Select the statement on the right that defines each word at the
left.
a. a letter, report, or painted image
b. a program the computer uses when you create a document
c. instructs you to take some action before a command is
completed
d. a measure of the amount of storage used by a document
or application
e. an area for entering text in a dialog box
f. signals the computer to take an action
g. a window with information or a warning
h. a window that lists the contents of the disk
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C. From the list of words at the left, choose one to fill in each blank
in the statements that follow.
title bar
dialog box
check boxes
disk
byt es
New
Cloi:;e
Quit
text boxes
int ernal memory
megabytes
Open
radio buttons
message boxes
kilobytes
File command

1. 'I\vo kinds of buttons used in dialog boxes that are clicked if you

wish to choose from a list of options or to turn a feature of an
application on or off are called
and
2. When you complete the procedure to save a document, the work
you have done is saved to the ________

3. When you select Save in the File menu after working on a
document , the next thing you see on the screen is called a
4. When you complete one document and wish to start on another
with the same application, you first select the command
_________ , then
from the File
menu.
5. One single-spaced typewritten page will use about three
________ of storage space on a disk.
D. Mark the following with Tor F for true or false statements.
1. While working in an application, the pointer is always th e

arrow.
2. You will find windows with title bars and close boxes only on the
desktop.
3. When dragging a document icon over a folder icon, the folder
icon must be highlighted before the document will be placed in
the folder.
4. Each document done in one application will have the same icon
but a different title.
5. A dialog box appears immediately after some commands are
selected from a menu.
6. If you forget to save your document before you choose Quit from
the File menu, the document is lost.
7. On the desktop, only document icons can be placed in folders.
8. In a directory window, folders are shown in solid type and may
be opened to view their contents.
9. Buttons that have the action that they perform written on the
button are called Command buttons.
10. You can place an insertion point in a text field only when the
pointer becomes an I-beam.

Working
With Windows
. .

.

Objectives
After completing this chapter, you will be able to:
1. Use the hierarchial file system.
2. Use window features for moving, sizing, and scrolling.
3. Use View menu commands to change the form of a window's
directory.
Important terms
These terms are defined in this chapter and in the Glossary.
scroll box
active window
selection rectangle
hierarchical file system
size box
scroll arrows
zoom box
scroll bar

The Hierarchical File System
Since 1985, Macintosh computers have been equipped with a
directory filing system called the hierarchical file system. This
system is used with the enhanced version of the 512 model (512E),
the Macintosh Plus, SE, SE/30, and the Macintosh II series-all
models that use double-sided SOOK or 1.44 MB disks. The system
enables the Finder to keep track of the contents of nested folders;
that is, folders that may be inside other folders, which are also in
folders, for as many layers as necessary to organize documents
efficiently.
39
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The filing system used by the Finder on the desktop is similar to
a filing system that uses real file folders, file drawers, and file cabinets. A large business, for example, may devote one or more file
cabinets to customer correspondence, other cabinets to product catalogs, and still other cabinets to the records of company finances. In
the customer correspondence cabinets, correspondence with customers from different sales regions may be kept in different drawers and, within each drawer, in different file folders for each customer.
On a disk you may organize electronic documents in much the
same way. For example, you might have a folder in the disk window
called Letters. Within that folder you may wish to divide the letter
documents into two folders called Personal letters and Business letters. Within each of these folders, if you have enough documents to
warrant it, you may have folders that organize the documents
alphabetically, by date, or by some other category that seems appropriate. Nesting folders within folders three or four deep is common
practice if you have auxiliary storage hardware such as an external
floppy drive or a hard disk which can store hundreds or thousands
of documents. You -..vi.11 find more information about organizing data
stored on a hard disk in Appendix A.
Although you can nest folders many deep, it is hardly practical to
do so beyond five or six levels. To uncover a needed document
buried deeply in the nested folders, you must first open all the higher level folders above it.

Using Window Features
Most directory management is done while on the desktop. Here you
can move documents into folders, as you did with your first two documents in the last chapter. You can also move folders into other
folders. To make these operations easily accessible, special features
have been built into disk and folder windows that facilitate viewing
and working with the contents within the windows as well as modifying the size and position of the windows.
Multiple windows
On the desktop you can have as many windows open at once as you
have folders, plus one or more disk windows. As you double-click on
each folder icon, a window opens for that folder. With many windows open at once, you'll find that soon some of the windows are
hidden.
Although your screen can display several windows at a time,
you can perform actions in only the active window. An active
window can be identified by the horizontal stripes in its title
bar (Figure 3-1). To activate another window, simply move the
pointer to any visible portion of that window and click once. That
window comes to the front and becomes active even if it had been
buried several layers deep. Activating that window deactivates the
previous window. Deactivated windows do not have the horizontal
stripes on their title bars.
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Figure 3-1
Horizontal stripes in the
title bar indicate an active
window.
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JQ
'1!f!!!A MACtivity 3-1: Activating windows. If not already open,

lilili;!_ double-click on the icon for the new folder you created in the
last chapter to open it. Click in the folder window and the disk window alternately to see the changes in the title bar and the layering
of the windows.

fii1 Screen display: If the two windows overlap, the one activatB ed by clicking within it appears on top. The title bar in the
active window has the horizontal stripes.
Moving windows
When you have several windows open at once, it is often convenient
to reposition one or more of them so that some windows do not hide
others or so that you can move folders or icons from one window to
another. To move a window, move the pointer to the horizontal lines
or the title in the title bar and drag (Figure 3-2). An outline of the
window moves with the pointer. When the mouse button is
released, the window jumps to the new position.
Figure 3-2
Reposition windows by
dragging on the titfo bar.
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PIJ!!!!l4 MACtivity 3-2: Moving windows. Move the windows that

~ are open on the desktop by dragging with the pointer on the
title bar so that most of the contents of two or more windows are
fully visible.
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liil Screen display: An outline of the window moves with
B pointer as long as the mouse button is depressed. When

the
the
mouse button is released, the window jumps to the position of the
outline.
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Try clicking on each window in turn to activate it and place it on
top of the other windows. It is good practice to arrange the windows
so that some part of each open window is visible no matter which
window is on top. That way when you want to activate or see the
contents of a window that is partly covered by another, you can
click on its exposed pru·t to bring it to the front. Some windows may
need to be resized and their contents scrolled to keep them in view
when the windows are overlapping; sizing and scrolling are
described later in this chapter.

Tip: To move a window without activating it, press the
Command key while you drag the window. The window stays inactive and layering remains the same; to do this, a portion of the inactive window's title bar must be exposed.
Moving icons between folders and wi ndows
Moving icons from one folder to another or from one window to
another can be done in two ways.
In the last chapter, you dragged your document icons over the
top of the folder icon. When the document icon was positioned over
the folder icon so that the folder icon also became highlighted, the
mouse button was released, and the document icon disappeared
into the folder. Any icons for documents or applications can be
moved individually to a folder in this way. Do not try to move a disk
icon or the trash icon into a folder; if you try to do so, you will get a
message box that tells you it cannot be done.
Another way to move icons between the disk window and a folder or between folders is to open the folder window in which you
wish to place the document, and then drag the icon from its original
window to an empty space in the other folder window.
Selecting and moving mu ltip le icons
At times you will want to move several icons at once, either to
move them into or out of folders, to put them into the trash, to rearrange them on the desktop, or to copy a group of documents onto
a backup or data disk. If the icons are scattered around in the window, the simplest method to select more than one icon is to hold
down the Shift key while you click on each icon. All selected icons
remain highlighted as you select additional ones as long as the
Shift key is depressed. If you accidentally select an icon that you
do not want to include in the group of selected icons, a second click
on the icon with the Shift key depressed deselects it, while the others remain selected.
When all the icons that you wish to include in the group selection
are highlighted, release the mouse button. Then move the pointer
over one of the selected icons and drag. All of the other highlighted
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icons move in unison . If you are placing th em all into a folder, move
the icon to the folder. When the folder becomes highlighted, release
the button and all of the highlighted icons are deposited into the
folder. To su ccessfully highlight the folder, th e tip of the pointer
must be within the folder outline.
The second method of selecting multiple icons will work only if
the icons are adjacent to each other. With this method, you drag a
selection rectangle around all of the icons to be selected. To drag
a rectangle, position the pointer above and to the left of the upper
left icon of the group. Drag diagonally to the right and down to
draw a rectangle around all of the icons to be selected (Figure 3-3).
When you release the mouse button, the rectangle disappears and
the icons that were within the r ectangle are highlighted. The group
can then be moved by dragging any one of the icons. This method is
especially fast if you are moving rows or blocks of icons to other
locations.
Figure 3-3
A selection rectangle can
be drawn to select
multiple icons.
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Sizing windows-the zoom box
At the left end of the title bar is the close box; you u sed it when you
closed windows in Cha pter 1. At the right end of the title bar is a
similar box with a smaller box in it, called a zoom box (Figure 34). Clicking with the pointer in the zoom box enlarges the window
instantly to n early the full size of the screen, allowing you to see
m uch more of the contents of the window. A second click on the
zoom box reduces the window to its original size. The zoom box
feature is a convenient way to temporarily enlarge a window on the
desktop , esp ecia lly as more docum e nt an d folder icon s are
accumulated in the window.
Figure 3-4
Window components
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MACtivity 3-3: Using the zoom box. Click on the close boxes
of all windows except the disk window. Click on the zoom box
of the disk window. Click on the zoom box again.
fmi1 Screen display: Clicking on the close box closes the window
B to the next higher folder or disk icon. If you accidentally
closed the disk window, reopen it by double-clicking the disk icon.
Clicking the zoom box enlarges the window. Clicking on the zoom
box again returns the window to its original size
~

You may discover icons for folders or documents that were not
visible in the window before the window was increased in size. The
zoom box, also a feature in many application windows, increases
the size of the window to the maximum size possible on the screen
n(. matter what size the window was originally. On the desktop,
when the window is increased to the maximum size, a one-inch
strip of desktop still shows to the right of the window where the
disk icons and the trash can are normally located. A zoomed window hides other windows that are also open on the desktop; you
will have to click the zoom box again to see them. The enlarged
window does not hide the menu bar.
Sizing windows- the size box
Windows may be changed to many sizes and proportions within the
grey area of the desktop. A window can be reduced to about two
inches square, adjusted to any intermediate size, or enlarged to the
full size of the screen by using the window's size box. The size box
is in the window's lower right corner (Figure 3-4). It is represented
as a small square overlapping a larger square. Place the tip of the
pointer in the size box and drag an outline of the window to
increase or decrease its size or change its proportion (Figure 3-5).
When the mouse button is released, the window assumes the new
size shown by the outline. Only the viewing area of the window
changes size; the contents of the window stay the same size and are
in the same position. When you reduce the area viewed in the window, some of the icons may be hidden.
Scrol l bars
When some of the items in a folder or disk are not displayed in
their window, the vertical bar along the right side of the window or
the horizontal bar at the bottom (or both) is shaded. These bars are
scroll bars (Figure 3-4); the shading indicates that some information, icons in this case, is outside the viewing area of the window.
If you wish to view items in the folder or disk that are not displayed in the viewing area of the window, you can scroll the window with one of the scroll arrows (Figure 3-4). Position the pointer on one of the arrows at either end of the scroll bar, then press
and hold the mouse button. This scrolls hidden parts of the window
into the viewing area.
To avoid confusion about which direction the arrows will scroll
the window, think of all the information accessible in the window
as being displayed on a large fixed board, or storage field, with the
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Figure 3-5
The size box is used to
change the size of a
window.
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window as a mask that reveals only a small portion of the field
(Figure 3-6). To see a part of the field above the window mask, you
must press on the up arrow in the scroll bar. To see the area of the
field below the window, you press on the down arrow in the scroll
bar. Do the same with the left and right arrows on the horizontal
scroll bar to move the window to the left and right in the field. If
you think of the window as moving in the direction of the arrows
over a fixed field larger than the window area, you are less likely to
press the wrong arrow when trying to display items you know to be
in a certain direction in the field.
Figure 3-6
The window viewing area
often must be scrolled to see
icons in other parts of a
larger storage field.
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When the scroll bars are active, they also contain a small white
movable square called a scroll box (Figure 3-4). The box moves in
the direction of the arrows at the ends of the scroll bars as you
press the mouse button on those arrows. Also, you can move the
scroll box independently by moving the pointer to the scroll box and
dragging it along the scro~l bar. Moving the box to the middle of the
scroll bar, for example, immediately moves the display area of th e
window to the halfway point in the larger storage field. The field is
filled with icons starting with the window positioned at the upper
left corner; so if you wish to return to that 'corner of the field, you
can move the horizontal scroll box to the far left of th e horizontal
bar and the vertical scroll box to the very top of the vertical bar.
If you click the pointer in the grey area of the scroll bar, between
the scroll box and the arrow at either end, scrolling occurs in
jumps, one window-full with each click, and moves the scroll box
toward the pointer.

p

MACtivity 3-4: Sizing and scrolling the windows. Drag
the disk window's size box to reduce the height of the window
to its rriinimum height. Reduce the width of the window to about a
half a screen wide. Use the scroll bars to bring hidden parts of the
window into view.

~

fii1 Screen display: An outline of the window shows the new size

E::I as tlie

size box is dragged with the pointer. When the mouse
button l.s released, the window size changes to the outline size. The
icons in the window scroll past slowly if you hold the mouse button
down while the pointer is on a scroll arrow. The window scrolls
quickly if you click on the grey area of the scroll bar, between the
scroll box and a scroll arrow. Dragging the scroll box moves the
viewing area quickly to another part of the storage field when the
mouse button is released.

You will not be able to reduce the window's height or width to
less than about two inches. You should not reduce the width to the
minimum or you may hide some of the window title. Try all the features of the scroll bars to move the hidden parts of the window area
into view.
Changing the form of information in windows
If a large number of documents are stored in a window, the size of
the regular icons plus their titles soon crowd the viewing space on
the screen and may make the window's total storage area very
large. A lot of scrolling may be necessary to see the contents of the
window. The View menu offers commands that can change the form
of the icons into smaller icons or into text that can be listed in a
variety of arrangements. If you wish to try out the different ways of
arranging information in your windows while they are still open,
read the More About... section later in the chapter.

Shut Down
If you wish to stop at this point, close all the open windows on the
desktop. Retain the documents you created in Chapter 2-these
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will be used again in the next chapter. Choose Shut Down from the
Special menu and turn the power switch off. After you have finished readi.Ilg the chapter, complete the Chapter 3 Self Test.
More About the View Menu

On the desktop, the View menu can be used to change the form of
the information in the active window (Figure 3-7). ·Normally, documents, applications, and folders are represented by large icons with
titles under them. The size of the icon makes it easy to recognize a
document produced with a particular application, the application
itself, or a folder. For this reason you will probably want to use the
large icon form most of the time. However, at times, it may be convenient to reduce the size of the icon so that more document titles
may be seen in the viewing area of the window. At other times, you
may wish to see the items in the window listed alphabetically or
chronologically by the date of completion or last revision. The commands in the View menu can be used to change the sl.ze of the icons
or to change the icons into text sorted by name, date, size, or kind.
Note that a check mark appears before one of the commands in the
View menu. This is the command currently in effect for the active
window. As you read through the description of the commands,
choose each View menu command listed below to see how it affects
the active window on your screen.

• py Small Icon. Selecting this command changes all the icons in
the active window into miniature versions of the same icon and
places the title of the icon to the right. The icons can be moved
around, re-titled, and opened in the same way as the larger icons.
With smaller icons, many more can fit into the window of a larger
storage field .
Figure 3-7
The View menu is used lo
ch ange the form of the
information in the window.
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• by Icon. This command changes the items in the active window
back to large-sized icons if the items are in some other form.
• by Name. Choosing this command changes the icons into an
alphabetical listing by the title. This listing includes additional
information-whether each item is a document, application or
folder; the amount of storage space it uses in kilobytes; and the
date and time when it was originated or the date and time it was
last revised.
If you have titled some of your documents starting with a capital
letter and some with a lowercase letter, those with a capital letter
will appear grouped at the top of the list followed by those titles
starting with a lowercase letter. Each group is in alphabetical
order; however, if you wish the whole list arranged alphabetically,
you should be consistent in starting all your titles with either a
capital letter or a lowercase letter. Documents, folders , and
applications can be opened from this listing by double-clicking on
the small icon or anywhere in the line containing the title.
• by Date, by Size, by Kind. These commands list the same information as the by Name command, but in a different order. The by
Date command lists each item in order according to the latest
revision date, starting with the most recent date first. If the item
has not been revised, the date it was originated is used. The time
of day the item was originated or revised is also used to establish
the listing order.
The by Size command places the largest document, folder, or
application at the top of the list followed by the other items listed
by progressively diminishing size.
The by Kind command groups all of the applications, documents, and folders together and lists items alphabetically within
each group.
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Chapter 3 Self Test
Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.
A. Select one of the four choices that completes the sentence
correctly.
1. The hierarchical file system:

a.
b.
c.
d.

saves a document to a disk
keeps track of documents in nested folders
sorts out documents according to size
automatically creates folders to hold documents

2. If more than one window is open, you can identify the active
window because it:
a. is the largest window
b. is at the top of the screen
c. has stripes on its title bar
d. has its name on the title bar
3. To
a.
b.
c.
d.

move a window to another location on the desktop you would:
drag it with the pointer on the title bar
use the scroll bars
close the window, move its icon, and reopen it
click on the zoom box

4. If you select by Icon from the View menu, the items in the active
window will become:
a. very small icons with the title to the right of each icon
b. icons rearranged in alphabetical order
c. selected icons
d. icons with a title under each icon
5. If you wished to view a part of a window's storage area above the
viewing area of the window, you would use the:
a. scrolling arrow that points up
b. scrolling arrow that points down
c. size box
d. title bar to move the window up
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B. Select th e statement on the right that defines each word at the
left.
1. _ _ scroll bar

2. __ View menu
3. _ _ scroll arrow
4. __ title bar
5. __ scroll box
6. __ size box
7. __ Shift key
8. __ zoom box

a . becomes shaded and active if contents of a window are outside
the viewing area
b. used to make the window any desired shape
c. can be used to tell if a window is active
d. enlarges the window to nearly screen size
e. will move the viewing area of the window quickly to another part
of the storage field
f. controls the direction of the window's viewing area when it is
being moved to another part of the storage field
g. used to select more than one document at a time
h. used if you want to change the form of the information in an
active window
C. From the list of words at the left, choose one to fill in each
blank in the statements that follow.

documents
File
hierarchical
Command
folders
Option
tab
applications
selection rectangle
selection circle
View
Shift

1. Three types of icons that you find on the desktop and use

regularly are icons for _ _______
and _ _ __ _ __
2. One way to select several icons at once on the desktop is to
click on each icon while pressing the
key.
3. Another way to select several icons at once, if they are adjacent
to one another, is by drawing a ________ around them
with the pointer.
4. The method the computer uses to keep track of documents in
nested folders is called the
file system.
5. On the desktop, commands from the _ _ _ _ _ _ _ _ menu
ca n be used to chan ge the form of information in active
windows.
D. Mark the following with Tor F for true or false statements.
1. To activate a window and bring it to the front of other windows,

th e h orizontal stri pes on the title bar must be visible at all
times.
2. If you highlight a group of icon s, you can deselect one of them
by clicking on the icon while pressing the Shift key.
3. Double-clicking th e zoom box will expand a window to twice
the size that it would be if you clicked the zoom box only once.
4 . If you want to compare t he sizes of seve ral documents,
s electing by Kind from the View m enu would list them by
progressively diminishing size.
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5. On the desktop, a maximum of five windows can be active at
one time.
6. When the vertical scroll bar is shaded, it means there are more
items hidden above or below the viewable area of the window.
7. When the horizontal scroll bar is shaded, it means there are
still folders in the window that are not open.
8. Scrolling a window can only be done by placing the pointer on a
scroll arrow and pressing the mouse button.
9. When you drag a window to move it, an outline of the window
moves with the pointer until you release the mouse button.
10. When you choose by Date from the View menu, all the items in
the active window will be listed with the most recently created
or revised item at the top of the list.

Other Desktop
Menu Commands

Obj ectives
After completing this chapter, you will be able to:
1. Locate and identify desk accessories.
2. Use commands in the File menu for managing icons and
directories.
3. Use commands in the Edit menu to edit text on the desktop.
4. Use commands in the Special menu.
5. Use the keyboard to execute commands.
Important terms
These terms are defined in this chapter and in the Glossary.
desk accessories
clipboard
I Locked box
Get Info window
comment box

I

I

Menu Commands
This chapter summarizes the commands in menus used on the desktop. You have already used some of the commands in completing the
activities in the previous chapters. Many of the commands in the
File and Edit menus are found in most applications; the functions of
these commands are described in the chapters in Part 2 of this manual also. The remainder of the commands are for a variety of desktop management tasks. You may find that you use some commands
less frequently than others; however, it is important that you understand the function of all of the commands so you can handle desktop
chores efficiently.
53
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- - - - -- --.Alarm Clock
Calculator
Chooser
Control Panel
Key Caps
Note Pad
Scrapbook
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The Apple Menu
The Apple menu , identified on th e menu bar with a drawing of a
small apple, cont ains a list of desk accessories (DAs) that are
available in the System file of the startup disk you are using. Desk
accessories are small applications designed to do specific tasks,
such as control the operating ch aracteristics of the keyboard and
mouse, sho~ the time and dat e, choose a printer, or store notes and
graphics. DA windows can be opened and used while working on the
desktop and in most a pplications .
Some DAs are packaged with the system software that comes
with the computer; many others are available from otqer sources.
DAs can be added to or removed from th e system easily. The number of DA titles that appear in the Apple menu will vary, depending
on the numb er installed on the startup disk you are using. A
description of the DAs you are most likely to find in the Apple menu
is contained in Appendix B.
The File Menu
The File and Edit menus will become very familiar because they,
and many of their commands, appear in most applications as well as
on the desktop. The File menu h as commands that apply to the
management of icons and windows. Following is a list of the commands in the File menu that are used most frequently; some will be
used with the activities in this chapter. Additional commands in
this menu are described in the More About... section at the end of
the chapter.

Open
Print
Close

Print ·
Close
Ge t Info
Duplicate
Put Away

3€ 1
3€0

P.a ge Setup
Print Directory
Eject

3€E

• New Folder. You used this command to create folders in the exercises in Chapters 1 and 2. Each time you select this command, an
icon titled Empty Folder is created in the active window. If you
select the command a second time before re-titling the first folder,
the second folder is called Copy of Empty Folder, a third is called
Copy of Copy of Empty Folder.
• Open. The Open command opens the window of a selected disk or
folder or opens a document. If an application icon is selected,
choosing Open loads the application into the computer and opens
a window for a new, untitled, document. The Open command can
only be chosen when an icon is selected. Double-clicking on an
icon performs the same command as selecting the icon and choosing Open from the File menu.
To open a document, its application must be on the disk currently in the computer. If the document is on a separate disk from its
application, insert the application disk first and open the application. With some applications, you may h ave to first close the new
window of the application before opening the desired document.
To do so, choose Close from the File menu or click the window's
close box, then choose Open from the File menu. In the dialog box,
click the Eject button and exchange the application disk with the
document disk. The name of th e document will appear in the
directory window. Click on the document name in the directory to
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highlight it. Now click the Open button or double-click on the document icon or title.
• Close. Choosing the Close command produces the same result as
clicking on the close box of an active window. As you discovered in
Chapter 2, choosing Close while working on a document in an
application closes the document without removing the application
from the computer's memory.
• Get Info. With an icon selected, choosing this command opens a
Get Info window containing information about the icon's document, application, folder, or disk (Figure 4-1). The information
includes the kind of item it is (document, application, etc.), its size,
the disk and drive it is in, the date and time it was originated, and,
if revised, the last date and time it was modified. If the information is about a document, the application used to create it is identified also. The Get Info command is greyed and cannot be chosen
unless an icon is first selected.
The Get Info window has a comment box fo r enterin g a
reminder about or description of a document, fQlder, or disk. The
comment box is a text field enclosed by a rectangle located at the
bottom of the Info window. Notes may be entered to help identify
the contents of the document or other pertinent information. These
notes are available when the Get Info window is opened while on
the desktop; the document does not have to be opened. Text in the
comment box can be edited with the standard editing commands,
explained later in this chapter.
If you select the icon for an application, such as the System or
Finder icons in the system folder or an application for word processing or graphics, the comment box in the informat ion window
may already contain notes. Thes~ notes are often about the version
number of the application.

Figure 4-1
The Get Info window

~

Locked

D

First Document

Kind: Mac'vtrite document
Size: 1 ,497 bytes used, 2K on disk

Yhere: Mac'w'rite, internal drive
Created: \v'ed, Jul 27, 1988, 8 :15 PM
Modified: 'w'ed, Mar 1 , 1989, 3 :03 PM
Version: not available
COMMENT BOX : This is the place that you can
write a note to remind you about the document's
content or attach other information . I
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The Locked box in the upper right corner of the window can
be clicked if you wish to prevent anyone from trashing your document or changing its name or contents. You can, however, open
and print a locked document. Clicking on the checked box a second time removes the check mark and unlocks the document. You
should be cautious when locking a document. If your computer
allows any modifications to be made on the document after the
document is locked, you have an early version of the System file;
under these circumstances, you cannot save any new work you do
on a locked document. If you have a more current version of the
System file, a dialog box will appear when you double-click the
icon of a locked document to open it, or when you choose the Open
command from the File menu. The dialog box warns that you cannot save changes on a locked document. However, if you do make
changes after opening a locked document, you can save the
changed document as a new document. When you choose the
Save command, the Save dialog box will appear as for a new document. Enter a new title in the title box, then click the Save button. The original locked document will not be changed. The
changed version of the document is saved as a new unlocked document with its own icon on the desktop.
~

MACtivity 4-1: Using the information window. Select the
~ icon for the document you created in the last chapter, titled
First document . Choose Get Info from the File menu. Read the
details about the document in the information window, noting the
size of the document, the application name, the disk it is on, and
the date. Write a sentence in the comment box about the document,
such as This is the first document created by (your name) on the
Macintosh computer. Close the Get Info window.

liiil Screen display: When the information window opens, the

B

document icon and title appear at the top of the window. A list
of data about the document appears below the title. A blinking
insertion point is already in place in the comment box, ready to
receive your keyboard entry. Clicking the window's close box makes
the window disappear.
Since this is information about a document, Kind lists the
name of the application used to malrn the document. Size tells you
the amount of storage space the document u ses, in both bytes and
kilobytes (some early system versions list only bytes- to obtain
kilobytes, divide the number of bytes by 1000). Where provides the
title of the disk on which the document is located. Created gives the
date and time the document was first originated; this date does not
change. The data after Modified is updated each time the document
is opened again, changed, and saved.
More than one information window can be opened at a time.
For example, you may wish to compare information between two
documents and, therefore, wish to have their two information windows side-by-side. When you select the second document and
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choose Get Info, its information window is placed directly over the
information window of the first document; to see both windows, the
second information window must be moved aside by dragging its
title bar to a new position. Information windows need not be closed
to see other disk and folder windows also on the desktop. As with
all windows, clicking on any exposed part of a window makes it
active and brings it to the front.
'lip: If the Get Info window becomes buried beneath other windows,
another way to bring it to the front is to select Get Info again from
the File menu.

New Folder

3€N

• Eject. This command ejects the disk whose icon is selected, or the
one that has a window open and active. If no windows are open or
no disk icon is selected, the computer ejects the disk in the
computer drive. When a disk has been ejected, its icon stays on
the desktop but becomes greyed and hollow.
'lip: Dragging the disk icon to the trash also ejects the disk. This
does not erase or affect the contents of the disk. If the disk is a
startup disk, the disk is ejected, and its icon stays on the desktop;
however, the icon becomes greyed and hollow. If the disk is not a
startup disk, dragging its icon to the trash ejects the disk and
removes the icon from the desktop.

The Edit Menu
Cut

3CH

copy

ace
acu

Paste
Clear
Select All

3CA

Show Clipboard

On the desktop the Edit menu has commands that allow you to edit
the titles of disks, folders, or documents, text in the Get Info comment box, and text or graphics in some desk accessories. This section describes commands that are used most frequently; some are
used in the activity that follows. Two additional Edit menu commands are described in the More About... section at the end of this
chapter.
Most of the Edit menu commands must be preceded by selecting
the text to be edited; that is, text to be cut, copied, moved, or otherwise modified. The selection can include any amount of text from
one letter or word to whole paragraphs or all of the text. To select
text, position the I-beam at one end and drag it over the text to be
highlighted. A single word can be highlighted by placing the I-beam
anyplace within the word and double-clicking. Dragging the I-beam
diagonally through a paragraph or a sentence several lines long
quickly highlights a larger area of text. A long selection may also be
made by highlighting the first word, moving the I-beam to the right
of the last word in the selection, and then pressing the Shift key
and clicking. All of the intermediate text between the first highlighted word and the new position of the I-beam becomes highlighted.
• Undo. This command applies to text fields (areas in which text
can be entered) on the desktop, such as the titles of documents
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and folders, and in some desk accessories, such as the Note Pad.
Choosing Undo cancels the last editing or typing action. For
example, let's say you have deleted a word by double-clicking on it
to highlight it and then pressing the backspace (Delete) key.
Choosing Undo immediately after the deletion restores the word
in the text. A shortcut for the Undo command is to press the
Command key and the letter Z together. To cancel any previous
action, Undo must be used before the next use of the mouse button. The Undo command cannot be used for text in the Get Info
comment box or non-text related actions taken on the desktop,
such as trashing an icon.
• Cut. This command removes the selected text and places it on the
clipboard. The clipboard is a temporary holding place for text or
graphics; you move a selection to the clipboard when you choose
the Cut or Copy command. The clipboard is available in documents or on the desktop for text that can be edited. An item on
the clipboard can be pasted (described below) back into the same
document at any desired location or transferred and pasted into
another document. The clipboard holds one selection at a time. A
Cut or Copy command for anoth er selection replaces the previous
contents of the clipboard.
• Copy. The Copy command also places selected text on the clipboard, but it does not remove the text from the document. The
selected text replaces any previously cut or copied text on the
clipboard.
• Paste. To recover text from the clipboard, move the I-beam to the
spot in the existing text where you wish to insert the text on the
clipboard, click to place an insertion point, then choose the Paste
command. The pasted text appears after the insertion point and
moves the text that was to the right of the insertion point forward. Using Paste does not remove the text from the clipboard. If
you want the same text to appear a second time, establish the
insertion point at the new spot where you wish it to appear and
choose Paste again. Paste is one method (the sole method in many
applications) for malting duplicates of text or graphic items.
The Cut, Copy, and Paste commands work with text in titles of
folders and documents on the desktop, for text and graphics in
applications, and for text or graphics that can be entered in desk
accessories (described in Appendix B).

P

MACtivity 4-2: Using commands for editing. Open the
~ information box for the document used in the previous exer-

cise. Select the words by (your name) from the comment box.
Choose Cut from the Edit menu. Place the insertion point just
before the period at the end of the sentence. Choose Paste from the
Edit menu. Adjust the spacing between words with the space bar or
backspace key if needed. Next, select the whole sentence and choose
Copy from the Edit menu. Place the insertion point after the period
in the sentence. Choose Paste from the Edit menu. Select the sentence again and press the Delete (backspace) key. Close the information box.

Chapter 4

Other Desktop Menu Commands

59

Iii) Screen display. Choosing the Cut command removes the

B

selected text and places it on the clipboard. The gap left in the
sentence when the words are removed closes up, leaving the insertion point at that spot. Choosing Paste returns a copy of the deleted
text at the new insertion point location. Choosing the Copy command makes a copy of the selected text onto the clipboard but
leaves the selected text unchanged. Choosing Paste returns a copy
to the window, beginning at the new insertion point location.
Selecting the text and pressing the Delete key removes the text.

When text is selected, spaces between words are also selected,
just like the characters. Incorrect spacing may appear before and
after the pasted words depending on whether or not spaces were
included with the words being cut or copied. You may need to add
or remove a space at the beginning and end of the pasted text by
setting the insertion point and using the space bar or the backspace
key.

• Clear. The Clear command removes a selection and does not
place it on the clipboard. Using this command does not eliminate
an ite~ already on the clipboard. If you delete an 1.tem by mistake, you can recover it by choosing the Undo command, providing you do so before you continue with other actions. An alternate
way to clear a selection is by pressing the backspace (Delete) key.

Clear

The Special Menu
The commands in the Special menu carry out some housekeeping
chores on the desktop and provide some options when working
between multiple documents, applications, and disks. The two commands that are most frequently used are described here; additional
commands from the Special menu will be found in the More About...
section that follows.

~.t§IMI
Clean Up Window

I

~.t§IMI
Clean Up Win dow I

Shut Down

• Restart. Choosing this command ejects the disk in the computer
and restarts the Macintosh. This is a quick way to change from
one startup disk to another. Restart removes the icon of the original disk; you won't be asked to swap disks if the computer needs
information from the original startup disk. If your computer is
equipped with an external hard or floppy disk drive, Restart
turns only the main unit off and on. It may be necessary to use
this command in case of a system malfunction-the alternative is
to turn the power switch off and on.
• Shut Down. This command should be used when you finish
your work and are ready to turn off the power to the computer. A
dialog box appears telling you it is safe to do so. A Restart button
is available if you wish to interrupt the power momentarily as in
the Restart command described above. On some computers with
hard disks, Shut Down automatically parks the disk's read-write
heads in a safe location, so the disk is less likely to be damaged if
the unit is moved or jostled.
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Using the Keyboard to Perform Commands
Many commands can be executed with a combination of keystrokes
instead of using the mouse to select the command from the menu.
When commands are used frequently, as with the editing commands for long text documents, using the keys saves much time
since many operations can be performed without removing your
hands from the keyboard.
Most applications of all types use the same key combinations for
the most frequently used commands in the File and Edit menus.
Applications of the same type, such as word processing applications, also have other commands in other menus that use common
key combinations.
The key combinations are fairly easy to remember. All use the
Command key with a character key; often the character key is the
first letter of the command. Pressing the Command key and the letter key S, for example, executes the Save command.
If there is a keyboard equivalent for a command, it is shown to
the right of the command word in its menu. Those that are available while working on the desktop are shown (Figure 4-2). The
cloverleaf is the symbol for the Command key. To execute a command, press the Command key first, then the character key; both
may be pressed at the same time. If you enter the character key
first, however, and the insertion point is active in the screen display, that character is entered at the insertion point (the command
is also executed). Menu commands that are followed by an ellipsis
(... )may also show a keyboard combination. If the keyboard is used
to execute these commands, a dialog box appears on the screen for
information to be entered before the command is performed, just as
it would if you chose the command from the menu with the mouse.
Figure 4-2
Key combinations may be
used to execute commands.

KEY COMBINATIONS FOR COMMANDS
FILE MENU

EDIT MENU

New Folder.... OON
Open ......................... 000
Get lnfo .............. 001
Duplicate .......... 000
Eject ....................... OOE

Undo ................. 002
Cut ...................... OOH
Copy ................. OOC
Paste ............... OOU
Select All ... OOA

Shut Down
This chapter completes activities related to management functions
on the desktop. You may drag the icons for the documents and folders you created to the trash, if you choose, or save them to add to
other documents you do in the applications described in the next
three chapters. If you wish to stop at this point, use the shut down
procedures as described in previous chapters, read the More
About... section that follows, and do the Chapter 4 Self Test.
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More About File Menu Commands
Following is a list of File menu commands not covered earlier in the
chapter. These commands are used less frequently than the other
commands found in the File menu.

Close
Get In f o
Dupli cate
Put Away

3€ 1

mm

Page Setup

Figure 4-3
The Print dialog box

• P1·int. Usually documents are printed while the document is
open. Although not a r egular procedure, documents can be printed from the desktop by selecting the document icon and then
choosing Print from the File menu. When the Print command is
chosen on the desktop, the Print dialog box for the applica tion
appears (Figure 4-3) and allows you to elect options before printing. However, documents from a few applications, such as
Microsoft Works, must be opened first a nd then the Print command chosen from the File menu. The information in the Print
dialog box and the printing procedures are described in Chapter
8.
I mageWriter

v2 .1

Quality:

0

Page Range:

@All

Copi es:
Paper Feed:

Best

D

@ Automatic

@ Faster

0

O From:

To:

0

D

Draft

D

n

OK

~

( Cancel )

Hand Feed

Printing from the desktop is used primarily for reprinting a
document or series of documents in which formatting and printing specifications have already been set through the previou s
printing. A group of documents can be highlighted and printed
successively. The order that they print depends on the location of
their icons in the window; selected docwnent icons arranged from
left to right and top to bottom print in that order.
• Duplicate. This command makes a duplicate of any document or
folder whose icon is highlighted. If a folder contains documents or
other folders, t he entire content of the folder is duplicated. The
duplicate is titled Copy of ..(name of original). Use t his comman d
if you wish to make revisions on a document but want to preserve
a copy of the original. The revisions can be made on the copy,
which can then be re-titled as a new document. The Duplicat e
command can be used only when a document or folder icon is
selected.
•Put Away. If you have moved icons of documents, applications, or
folders out onto the desktop or trash window, u sing the Put Away
command returns those selected to their appropriat e folder or
disk. The command is greyed unless item s on the desktop or
trash window are selected. You may move documents onto the
desktop if, for example, you are assembling a group of icons for
documents from several folders that are to be copied. After finishing, selecting the icons and u sing the Put Away command returns
each icon to its original folder or disk.
• Page Setup. This command displays a dialog box (Figure 4-4)
that provides options for page size, orientation, and several other
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choices that apply when using the P rint Directory command
described later. The Page Setup command does not apply to documents printed from the desktop when u sing the Print command.
Page setup options for documents are made in each document
while an application is open. The options available in the Page
Setup dialog box are described in greater detail in Chapter 8.
Figure 4-4
The Page S etup dialog box

l mageWriter
Paper:

v2. 1

O A4 Letter
0 Internation al

@ US Letter
0 US Legal
0 Compu ter Paper

Orientation

Speci al Effects:

Fanfold

D Tall Adjusted
D 50 % Reductio n
D No Gaps Between

n

OK

l

( Cancel )

Pages

• Print Directory. This command prints the contents of the active
window. In some versions of the System files, the command is
Print Catalog. The command first opens a dialog box that gives
several options for printing (Figure 4-5). The options already chosen in the dialog box are those usually used for this command.
You need only to turn on the printer and click the Print button to
execute the printing. More details about print dialog boxes
appear in Chapter 8.
Figure 4-5

The Print Directory dialog
box

I mageWriter
Quality :
Page Range:
Copies:
Paper Feed:

v2.1

0

Best
@All
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@Faster

O From:

0

D

O Draft
To:

D

n

OK

~
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Hand Feed

Note: Pressing the Command and Shift key together and typing
the number 4 also prints the contents of the active window on the
Image Writer printer. Pressing the Command and Shift keys together with the Caps Loc!r key down and then typing 4 prints the contents of the whole screen on the ImageWriter. However, neither of
these key combinations work with the LaserWriter printer.
More About Edit Menu Commands
The most frequently used commands from the Edit menu were
explained earlier in the chapter. This section describes two
additional commands that appear in the Edit menu on the desktop.

3€2

• Select All. Choosing this command selects all the icons in the
active window. If no windows are open, it selects all the items on
the desktop. Once all icons are selected with this command, you
can deselect one or more icons by using the Shift key while you
click on the icon to be deselected. Select All only applies to icons;
the command is dimmed when a desk accessory window is open.
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• Show Clipboa1·d. The last selection made on which you used the
Cut or Copy command appears in a window titled Clipboard
when you choose Show Clipboard (Figure 4-6). These items stay
on the clipboard until replaced with another Cut or Copy selection. They can be pasted into the same document, into another
document in the same application, and in m any documents in
other applications. Items on the clipboard cannot be edited in the
clipboard window and are not saved when you shut down the
computer.
Figure 4-6
Items th.at have been cut or
copied appear on the
clipboard.

•
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More About Special Menu Commands
The Special m enu has additional commands for desktop and disk
management chores.

Restart
Shut Down

• Clean Up Window. When icons are displayed in an active window, either regular icons or small icons, choosing Clean Up rearranges the icons in regular rows and columns to align with a hidden grid. If one or more icons are selected, only those icons are
moved to the n earest horizontal and vertical grid increments.
After u sing the command, you may find some of the icon titles
overlap; therefore, to read the full title, some icons may h ave to
be positioned individually by dragging the icon to a new location.
• Empty Trash. This command eliminates the contents of the
Trash and frees th e storage space on the disk for other uses. The
numbers appearing under a window's title bar that indicate th e
storage used and the amount available are updated. Items in th e
Trash are automatically emptied whenever the storage is n eeded
for new items or when the computer is shut down. However,
using the Empty Trash command notifies you immediately of
how much storage space you have available on th e current disk .
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This is especially important if the storage available on the disk is
getting low and you need to know whether you have room to save
new work.
• Erase Disk. This command completely erases a disk when its
icon is selected unless the disk is a startup disk. The computer
needs information from the startup disk and will not erase it. If
you wish to erase the disk used to start the computer, choose
Restart from the Special menu and exchange the ejected disk to
be erased with another startup disk. After the desktop appears,
eject the new startup disk by choosing Eject from the File menu,
then insert the disk to be erased. Make sure the disk to be erased
is selected before using the Erase Disk command. After erasing
the disk, a dialog box will appear asking if you wish to initialize
the disk. See Appendix A for the procedures used in initializing
disks.
Warning: Erasing and initializing a disk removes all of the
contents of the disk permanently.

~.1§4611

CJean Up Window I

• Set Startup. If you wish to go directly into an application when
you insert a disk instead of first displaying the desktop, select the
application's icon, then choose Set Startup. The next time you use
the disk as a startup disk, the application will be loaded immediately. To use Set Startup, the disk with the application on it must
be a startup disk.
To reset the disk so it opens with the desktop displayed again,
choose Quit from the application, then select the Finder icon
(open the System Folder if n ecessary) and choose Set Startup
again. The disk will open with the desktop displayed when the
disk is used again as the startup disk.
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Chapter 4 Self Test
Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.

A Select one of the four choices that completes the sentence correctly.
1. The comment box in the window that opens when you select the

Get Info command:
a. is the place you lock a document to prevent any changes
b. is a place to write a note about the document
c. identifies the disk and application for the document
d. can receive text but cannot be edited
2. A single word in a block of text can be selected and highlighted
by:
a. placing an insertion point at the beginning of the word and
choosing Select All from the Edit menu
b. back-spacing the insertion point over the word while holding
down the Command key.
c. placing the I-beam within the word and double-clicking
d. placing the I-beam within the word and clicking while
pressing the Shift key
3. When text is selected and the Cut command chosen, the selected
text:
a. is permanently erased
b. stays in place, but a copy is placed on the clipboard
c. is removed, then placed on the clipboard by choosing the
Paste command
d. is removed and placed on the clipboard
4. The clipboard:
a. is a temporary holding place for the last item cut or copied
b. contains all the items cut or copied until the computer is shut
down
c. is saved as a separate document
d. can be used only on the desktop
5. The keyboard can be used to perform certain commands without
using the mouse:
a. only when working on the desktop
b. when the command is first selected from the menu with the
mouse
c. if the key combination is indicated after the command in the
menu
d. only for commands in the Edit menu
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B. Mark the following with T or F for true or false statements.
1. If you choose the Close command while on the desktop, the

disk in the internal drive will eject, and the computer will be
turned off.
2. The Eject command will eject a disk only if all of the disk's
windows are closed on the desktop.
3. The Undo command will cancel the last editing or typing
action if it is chosen before the next use of the mouse button or
keyboard.
4. Most commands that you can execute with keystrokes use a
combination of the Command key and a character key.
5. The Select All command from the Edit menu will highlight all
the icons in all of the open windows on the desktop.
6. When a document icon is dragged to the trash can, the
document is temporarily stored on the clipboard until the
Empty Trash command is chosen.
7. The computer will erase any selected disk icon when the Erase
Disk command is chosen from the Special menu.
8. When you Cut or Copy an item to the clipboard, you can make
multiple copies of the item by repeating the Paste command.
9. One way to eject a disk from the computer drive is to drag the
disk icon into the trash.
10. Choosing the Show Clipboard command will open a window
that displays the contents of the clipboard so that text and
graphics may be edited.
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application
folder
Edit
delete
clipboard
comment box
File
insertion point
I-beam
select
notebook
desk accessories
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C. From the list of words at the left, choose one to fill in each blank
in the statements that follow.
1. The Apple menu contains small applications, called

________ that may be used on the desktop or while
working in other programs.
2. Commands for duplicating documents and folders and for getting information about a document can be found in the
________ menu.
3. Dragging the I-beam diagonally through a block of t ext
will ________ the text.
4. When you Paste a word from the clipboard into a text block, the
words will appear immediately following the _ _ _ __ _ _
5. If you wish to write a note to remind you about the contents of a
document or the contents ~fa disk, you can enter it into the
_ _______ in the information window.
6. To open a document, its _ _ __ __ __ must be on the disk
currently in use by the computer.

l._Cut
2._

Paste

3._Clean Up
4._Getinfo
5._Copy
6. _

Undo

7._Clear
8._ Select All
9._0pen
10. _ Duplicate

D. Match the actions performed on the right with the menu
commands on th e left.
opens the window of a selected disk or folder
opens a window containing information about a document
makes a copy of a selected document or folder
cancels the most recent editing action
removes th e selected text and places it on the clipboard
copies selected text and places it on the clipboard
places text from the clipboard at the insertion point
deletes selected text
lines up all the icons in the active window
j. highlights all icons in the active window
a.
b.
c.
d.
e.
f.
g.
h.
i.
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Word Processing
Applications

Objectives
After completing this chapter, you will be able to:
1. Use a word processing application to write a simple document.
2. Edit the document by adding, deleting, and moving text.
3. Control formatting with tabs, paragraph alignment, indents, and
line spacing.
4. Change the typeface, size, and style of text characters.
5. Save the document and quit the application.
Important terms
These terms are defined in this chapter and in the Glossary.
default
hanging indent
tab marker
first line marker
margin marker
type size
type style
flush
points
font
ragged
typeface
format
screen fonts
wordwrap
Differences in Word Processing Applications

Several word processing applications are available for the
Macintosh computer; popular ones include MacWrite, MacWrite II,
WriteNow, FullWrite Professional, WordPerfect, and Microsoft
Word, Write, and Works. All these applications are similar in the
basic operations used in creating and editing written documents.
The applications differ in their features that perform special functions; for example, some applications can arrange text in more than
one column on a page, sort lists of names alphabetically, add up
columns of numbers, or make outlines. Most W?rd processing appli71
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cations include a utility for checking spelling, and some have a thesaurus as well.
This chapter describes the methods used to write, edit, and format written documents. These methods apply to any word processing application you have available to use. Once you have mastered
the basic operations, you are encouraged to explore additional features that your particular program offers by consulting the manual
for that application.
Preparing Data Disks
If you will be saving your documents on your own data disk, you
need to initialize a disk for that purpose. Initializing prepares the
disk with a format that the computer can read and write data to,
including a directory so it can find documents or folders that have
been saved there. The procedure for initializing disks is described
in Appendix A.
You will be saving the document in this chapter for the first ti.me
at the end ofMACtivity 5-1, and you will be saving it again at intervals throughout its development. You can reopen the document at
any stage and continue working on it at a later date if necessary.
Data disks do not have System files or applications on them. To
open a document on a data disk, you must first use a startup disk
with the document's application on it. If the application is on a different disk than the startup disk, the startup disk is inserted first,
then the application disk, and finally the data disk. The document
on the data disk can then be opened by double-clicking its icon. The
computer asks for any other disks it needs to complete the process.

Opening the Application

copy
disk

638K available

1 acPaint

llMdid

•

From the desktop, locate the icon for the word processing application. It may be in the disk window or in a folder window.
Application icons have a distinctive shape and the name of the
application. Select the icon to highlight it. Choose Open from the
File menu or double-click on the icon to open it. In a few seconds a
blank text window will appear with a blinking insertion point in the
upper left corner. If you are using the Microsoft Works application,
double-click on the Works icon; when a dialog box appears, doubleclick on the icon titled Word Processor. After opening any application, if a grey screen appears with nothing on it except a menu bar,
choose New from the File menu.
The word processing application window has most of the same
features as other windows you have encountered on the desktop
(Figure 5-1). It has a title bar with the title of the document in the
center. A new document has Untitled as its title until you save the
document and give it another name. The menus listed on the menu
bar contain commands used for creating a text document. When you
open these menus, you will see some of the same commands that
you saw in menus on the desktop. These commands perform the
same functions in the document; however, many additional commands are available to perform specific word processing tasks.

Chapter 5

Figure 5-1
A word processing
application window

Word Processing Applications

MENU BAR
S
§0

file

_3

TITLE BAR

Edit Seoroh Format Font

Ii

73

style

~------.

Untitled

~.l...o•••J...o...l • .o••.J.?... L.o..J ...o..J....o.••J.~... L..o•••J...o...l ...o..J.1. .l ...o• •l...o... l ...o.J.?.•.1...o.:;!;,:.o ...l ...o...J.§...1...0..J ...o,.. l • .o..J.?.. .l ...o•••L,;,1,;:. .Q,
~ ~ D 6 lines/i nch ~ [§] ( 3 ~ ~ ~ [§ii •

4

i,___ INSERTION POINT

RULER
I-BEAM POINTER

ill'lllil:
lli!il°j

!1ii!i.

1111

SCROLL BAR

~1
~
121

The window has a vertical scroll bar; most word processing
applications have a horizontal scroll bar as well. As text fills the
window, the window automatically scrolls to keep the text in view
as you are writing. The scroll bar is used to view text that is off the
screen. Placing the pointer on an arrow at either end of the scroll
bar and pressing the mouse button causes the screen to scroll continuously. Clicking on the grey area in the vertical scroll bar above
or below the scroll box causes the box to jump in the direction of the
arrow and move the text in increments of one screen-full of text for
each click.
On some word processing applications, a ruler may appear at the
top of the window when the application is first open ed; on other
applications the ruler is hidden until a Show Ruler command is
selected from a menu (usually the Format menu). The ruler contains icons that set page margins and tabs; some also have icons for
setting text alignment and line spacing. These functions will be
described later in this chapter.
W r iting a Document
In the series of MACtivities in this chapter, you will use the features of your word processing program to write, edit, and format a
simple document. First read the description of the procedures preceding each activity, then follow the directions given.
Entering text
Entering text with the computer is like typing on a typewriter
except for a few important differences. This section describes those
differences as well as the functions of some keys and the mouse.
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USING THE KEYBOARD AND MOUSE
If you are familiar with
the use of a typewriter, the computer keyboard should have few
mysteries. The arrangement of the character keys (the letter, number, and symbol keys) is the same as on most typewriters. There are
a few additional keys; for example, the Command and Option keys,
first identified in Chapter 1, are special function keys that are used
in conjunction with a regular character key or a mouse action. The
Shift key is used for creating uppercase letters or the additional
symbols shown on the upper half of the key face. The Shift key is
sometimes used as a special function key for formatting text also.
Besides the functions using the special keys, all keys on computer
keyboards are repeat keys. If you press and hold a key, the computer will enter its character, space, or backspace and repeat the
action until you release the key. Also, when you enter text, the
Return key is used only at the end of a paragraph, not at the end of
lines within a paragraph. This is described in Using the R eturn Key
in this section.
The insertion point can be placed by moving the I-beam with the
mouse to the desired point in the text and clicking. Once placed, the
insertion point can be moved with the arrow keys. The arrow keys
pointing to the left and right move the insertion point to the left or
right within the line. The arrow keys pointing up and down move
the insertion point to the line above or below. Using the arrow keys
does not delete or modify any current t ext; these keys simply move
the location of the insertion point.
USING THE DE LETE (OR BACKSPACE) KEY This key moves the
insertion point to the left and deletes any text characters it passes
over. Besides deleting the visible letters, numbers, or symbols, format markers are also deleted. Format markers, su ch as space,
paragraph, and tab markers, are u sually invisible. Tapping the
Delete (backspace) key once backs up the insertion point one space
to the left. Holding the Delete key down repeats the backspacing
continuously until the key is released. Larger blocks of text that
have been selected by dragging the I-beam over the text with the
mouse a re instantly removed with a single tap of the Delete
(backspace) key.
USING THE RETURN KEY
The Return key moves the insertion
point to the beginning of the next line, much like the Return key on
a typewriter. However, the Return key on a computer keyboard is
u sed only at the end of a paragraph to start a new paragraph.
When a line of text within a paragraph approaches the right-hand
margin of the text block, it automatically moves to the next line;
this is called wordwi·ap. Never use the Return key to move to a
new line within a paragraph; this creates many problems in the
paragraph layout when you add or delete text in the paragraph or
make other editing ch anges. For example, if you remove several
words from a line in the middle of a paragraph, words in the following line will not move up to fill out the gap to the right margin.
Each line is an independent paragraph if the Return key is used.
In the MACtivities that follow, it is assumed that you know standard keyboard procedures used in typewriting, including the func-
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tion of the spacebar and Shift key. Developed skills in keyboarding
make it easy to enter text rapidly and accurately, but the hunt and
peck method may be used.

p

MACtivity 5-1: Entering text. Open the word processing
~ application. Enter the paragraphs as shown in the MACtivity
Text sample (Figure 5-2). Use the Return key only at the end of the
paragraph (press the Return key where you see the 'II symbol in the
sample). Use the Delete key to correct typing errors.
Figure 5-2
Sample text

MACtivity 5-1: Text
Keyboar ding i s a t er m ' avored by t hose re ferr ing to sk 1· 1s used in t 'le
pr oce ss of wri t ing t ext on key board machines wi th speed and accur acy
Touch ty ping is an older t erm , in use before the days of el ec tri c
t ypew r it e1-s, or el ec tr oni c typewr i t er s or com put er s des i gned fo r w ord
processi ng. Touch typi ng more speci f i cally descr ibes tre exe r ci se of
r eflexes needed t o make the f inger s res pond in a cer t ain w ay on the
k eyboard when a w or d or l et ter pat t ern i s tran scri bed. T'le w ords may
be th ose being rea d and copieo f r om another document , or ex i st only in
contempla t i on or r efl ec t i on.qr
It is i nt er es t ing t hat t hose w ho have l1ighly deve l oped re f l ex es in
toucl1-t yping, who can type 50 words or more a m inute w i t11 gr ea t
accur acy, w i l l usual ly have t o hunt ar ound to v isual ly loca t e a specif ic
k ey on the keyboar d Aw ay f r om t he keyboar d, mos t t ouc h typ i sts could
no t immedi ately name the home key s- tl1e s t art ing pos i : i on and base for
th e ei gllt t ypi ng finger s qi

1iiJ Screen display: When a line of text nears the right side of

B the window, the insertion point automatically jumps to the left
margin of the next line. When you reach the end of the paragraph,
pressing the Return key also moves the insertion point to the left
margin on the next line.
Remember that you can relocate the insertion point at any time
by positioning the I-beam pointer with the mouse and clicking. The
arrow keys on the keyboard also move the insertion point without
affecting text already entered. If you spot a typing error made several words or lines earlier, place the I-beam just to the right of the
error, click to set the insertion point, use the Delete key to
backspace over and remove the necessary letters, then enter in the
correction.
You should save the document at this point. Choose Save from
the File menu and enter a document title in the Save dialog box,
just as you did for documents in Chapter 2. If you are saving your
document to your data disk, be sure the directory for the data disk
is showing in the dialog box before clicking the Save button. The
title of the data disk should be listed just above the buttons on the
right side of the box. If you are using only one drive and your data
disk is not in the drive, click the Eject button to eject the current
disk and insert your data disk. When its directory window is displayed, click on the Save button.
Leave the text you have entered on the screen after saving it .
After you read the next section about editing, you will use this text
for the next activity.
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Editing text

The Delete (backspace) key is used frequently to remove text while
typing, to correct typing errors, or to change single letters.
However, word processing applications include procedures and
commands that allow you to make much broader changes quickly.
These include removing larger segments of text, from a single word
to whole paragraphs, with a single keystroke; moving text segments from one location to another; or replacing text with new text
or with other text copied from another location. All of these procedures begin by selecting (highlighting) the text you wish to remove,
move, copy, or replace.
SELECTING TEXT
A single word can be selected by dragging
over it with the I-beam while pressing the mouse button or by moving the I-beam to any point within the word and double-clicking.
Several words within a sentence may be selected by dragging
over them with the I-beam. Another method is to select the first
word of the group by dragging or double-clicking, moving the 1beam to the end of the last word in the group, pressing the Shift
key, and clicking.
A complete sentence can be selected in the same way as several
words. If a sentence occupies more than one line on the screen,
drag diagonally across the screen from one end of the sentence to
the other end (Figure 5-3). In some applications, moving the insertion point to any point within the sentence and clicking while holding down the Command key selects the whole sentence.
Figure 5-3
S elect text by dragging
diagonally

s

File

Edit

Search

Format

Font

Style

Multiple lines of text, whole paragraphs, or several paragraphs
can be selected by dragging diagonally through them as described
above. If the text to be selected extends beyond the window on the
screen, the window automatically scrolls when the I-beam touches
the bottom or top edge of the window. An alternate method of
selecting a large block of text is to first select the word or letter at
the beginning of the block, move the I-beam to the right of the last
word at the end of the block, scrolling to reach that point if necessary, and click while holding down the Shift key (shift-click).
At times you will want to select all of the text in the document to
make overall formatting changes, as described later in this chapter.
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The quickest way to select an entire document is to choose the
Select All command in the Edit menu, if available in the
application you are using. To se lect the whole document in
Microsoft Word, move the I-beam to the left margin of the window
until it becomes an arrow pointing to the right, and click the mouse
button while pressing the Command key.
ADDING AND DELETING TE XT
New text can be inserted at
any point in a document. Move the I-beam to where you wish to add
the text, click to estabiish the insertion point, then enter the new
text. The new text pushes existing text ahead of it. If you wish the
new text to replace a block of existing text, first select the block you
wish to replace, then begin typing. The first stroke of a character
key (or spacebar) deletes the selected text. The space occupied by
the selected text closes up, and the new text pushes any text to the
right of it forward as text is keyed in. If you wish to simply get rid
of the selected text without replacing it with new text, a tap of the
Delete (backspace) key erases it and leaves the insertion point
where the deleted text began. The text following closes up to fill the
space.

p

MACtivity 5-2: Replacing text. In the top line, highlight the
those. Enter in the words some when. Adjust the spacing
between words if needed.
~ word

liil Screen display: The highlighted word disappears from the
B screen when the first letter of the new text is entered. The text
to the right of the insertion point moves ahead as the remainder of
the letters are entered. Typing a new word permanently erases and
replaces selected text.
Existing text can easily be removed from its
current location and moved to a new location, or existing text can
be copied and duplicated at any spot in the document. First select
the text to be moved or copied. Then, if the text is to be removed
from its current location, choose Cut from the Edit menu. If a copy
of the text is desired without removing it from its current location,
choose Copy from the Edit menu. Either of these commands places
the selected text onto the clipboard. The clipboard is a temporary
holding place in memory for either text or graphics (see the Show
Clipboard command under More About Edit Menu Commands section in Chapter 4). Next move the I-beam to where you wish to
insert the text and click to establish the insertion point. Choose
Paste from the Edit menu. The text on the clipboard flows in starting at the insertion point and pushes existing text to the right
ahead of it. A copy of the text stays on the clipboard until it is
replaced by choosing the Cut or Copy command for another item or
until the computer is shut down. For this reaspn, text can be moved
from document to document by selecting the text, placing it on the
clipboard, opening another document, and pasting.
Since the Cut, Copy, and Paste commands are used frequently in
most applications, it would be efficient to learn the alternate way of
MOVING TEXT
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choosing these commands from the keyboard, which is a much
faster way than using the mouse to choose them from the menu.
Holding down the Command key wh ile typing a letter key accomplishes the same action as choosing the equivalent command with
the mouse. Use Command-X for Cut, Command-C for Copy, and
Command-V for Paste.

MACtivity 5-3: Moving text. Perform the following editing
~ operations on the text you used for the first activity:
-f'1n the fourth line, select the words or electronic. Choose Cut from
the Edit menu. Position the insertion point between electric and
typewriters. Choose Paste from the Edit menu. Adjust the word
spacing if needed. Delete the second typewriter. That part of the
sentence should now read ... days of electric or electronic typewriters, or computers designed for word processing.
2. In the second paragraph select the first sentence by dragging
diagonally through it. Cut and Paste the sentence at the end of
the second paragraph.
Screen display: A highlighted section of text is removed from
1~1 the screen and placed on the clipboard when the Cut command
is chosen. Paste returns a copy to the screen starting at the
insertion point.

Warning: If you accidentally press a key while text is selected
(highlighted), no matter whether it is one word or the whole
document, the text will be erased. To recover the text, immediately choose Undo from the Edit menu. You will not be able to
recover with the Undo command if it is not used before the next
click of the mouse button or before more typing takes place.
It is good practice to save at regular intervals as you work on a
document and before you select a large quantity of text. In case of a
power interruption or an accidental deletion, you will not lose a
large amount of work. Pressing the Command key and the letter S
key together, instead of choosing Save from the menu, is fast and
an easy key combination to remember for this frequently used command.
Your edited document will be used in the formatting activity in
the next section.

FBHRfllH~QlIG~ord used for the layout of text on a page of a written document. When you open a new docll;ment, a basic configuration for the layout of the document is already established. The settings that control the initial layout are called default settings, and
any of these may be easily changed to modify the layout of the
page. The settings include the width of the text block, the alignment of text on the page, the spacing between lines of text, and the
typeface, style, and size of the characters. Often default settings
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are established for tabulation as well. These formatting controls,
available on all word processing applications, fulfill the needs of
simple documents not requiring complex layouts.
Some formatting controls are located on the ruler. If your application does not show a ruler when you open a new document,
search for a Show Ruler command in a menu, usually the Format
menu, and select the command.
In some applications, you must insert a new ruler each time you
change formatting from one part of a document to another. In
MacWrite, for example, a change in the settings on the ruler affects
all of the text. To change the formatting of a section within a document, you need to insert a new ruler at the beginning of that section (Figure 5-4). The New Ruler command can be chosen from the
Format menu.
Fig ure 5-4
A new ruler may need to be
inserted to change
formatting in part of a
document.
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SETTING THE W IDTH OF THE TEXT BLOCK
The width of the
text block is set with the left and right margin markers on the
ruler (Figure 5-5). The default settings for the left and right margin
markers allow the full width of a type block to fit on the screen
without scrolling, or about six inches wide. Since mpst applications
do not hyphenate words automatically, the right margin marker
represents the maximum length of each line to the nearest whole
word.
To adjust the margin markers, move the pointer over the
ruler-the I-beam becomes an arrow. Position the tip of the arrow
on a margin marker, press the mouse button, and drag the marker
along the ruler. With some applications, if you already have text
entered in the window when you make the margin changes, the
changes are immediately reflected in the width of the text blocks in
the window. In other applications, margin changes do not affect
text already present in the window unless the text is selected
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Figure 5-5
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before the margin markers are adjusted or unless the insertion
point is within the text to be changed.
Most applications allow you to set minimum margins between
· the text and the edges of the page when printed; the margins for
each side and for the top and bottom of the page can be established
individually. This is done by typing desired margin dimensions in
appropriate spaces in a dialog box that appears after choosing Page
Setup from the File menu (Figure 5-6). The width of the text block
set by the margin markers must fit within the side margins established in the Page Setup dialog box. If the application you are u sing
does not provide for making these entries in the Page Setup dialog
box, you cannot change the default margins at the top and bottom
of a printed page. However, you can make the side margins wider
(the text width narrower) by adjusting the two margin markers on
the ruler.
Figure 5-6
Desired margin dimensions
are entered in the Page
Setup dialog box in some
applications.
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INDENTING THE FIRST LI NE OF A PARAGRAPH A first line
marker can be set to automatically indent the first line of a paragraph any desired number of spaces. In the default setting, the first
line marker is aligned with the left margin marker; all lines in the
paragraph align on the left. The first line marker may appear on
the ruler as the top half of the left margin triangle icon or as a differently shaped icon (Figure 5-7). Dragging th e icon to the right
several spaces with the pointer causes the first line of each paragraph you write to indent that amount without using the Tab key
(Figure 5-8).
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To create a hanging indent, where the first line in each paragraph starts to the left of all other lines in the paragraph, the positions of the first line marker and the left margin marker may be
reversed. In other words, the margin marker is to the right of the
first line marker (Figure 5-9).
Figure 5-7
First line markers haue
different appearances in
various applications.
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Figure 5-8
Mouing the first line
marker indents the first line
of a paragraph.

t.

LEFT MARGIN MARKER
//.::..FIRST LINE MARKER

..J?....1...o.:J.:·•·..1.. .•...J.1...1....... L...... 1.......l.~...1....... L...... 1.......1.9...1.......1.......1.......1.?....1....... l.:;,1;,:. :
·1ili!l!
1
D 6 lines/inch ~ [§] EJ ~ ~ ~ ~ Ii 1i l

'T-··-...LL...;;:..1.?....
~~

1... d

....... 1.....

1

Much text formatting is done by making adjustments or selections on
the ruler. In some applications (MacWrite, for example), changing the
~osition ~f ~e margin, ta~, o~. first line markers, or selecting. an alternate
Figure 5-9
Mouing the first line marker
to the left of the left margin
marker creates a hanging
indent.

~~~~~~A~~::~~~ER

. Li ...J..~...~-.....1....... ~L~...
1....

i .iii
11 11!!1

Ii .ll!i!JJ!
i;

m!li

.J.'.'.L.......1.:.....1~...~~--.i...o-1...._ 1 .......l.9...1.......L.....1.....:.!:?....1.......1...._

1_ •...1.......1......

~ ~
o 6 l ineslinch I 11 11 I I= 11 -- 11 .rnl
•Any change in formatting is done by intrQ,ducing another ruler
and making the formatting changes on t.Hat. For example, you
may want to include an indented sub-paragraph (adjust the
~ MACtivity

5-4: Changing the margin markers. Do the fol-

~ lowing formatting on the text you entered and edited in the

last activities:
1. Set the insertion point someplace in the first paragraph. Drag

the first line marker to the right about one-half an inch.
2. Move the insertion point to the beginning of the second paragraph. Move both the left and right margin markers about onehalf inch toward the center of the screen.
Note: In Mac Write, set the insertion point at the beginning of the
second paragraph, then choose New Ruler from the Format
menu to insert a ruler between the first and second paragraphs.
Change the margin settings on the new ruler. If you need to
delete a ruler, select it by clicking with the pointer in the upper
part of the ruler and press the Delete (backspace) key.
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liil Screen display: Immediately after the margin markers
B moved and the mouse button is released, the margins for

are
the
paragraph that contains the insertion point adjust to the new settings.

Tab positions, identified by tab markers, are
set on the ruler also. Tab markers locate the spot in the line where
the insertion point moves when the Tab key is pressed. Tabs can be
used instead of the first line marker for indenting paragraphs and
for vertical alignment of lists of words or numbers. Applications
have at least two types of tab markers: left-align tabs and either
right-align or decimal tabs (Figure 5-10). Some applications have
all three, plus one for center-align tabs. A left-align tab makes the
first letter of each word in a list of words line up evenly in a vertical
line, a right-align tab aligns the last letter of each word, and a center-align tab centers each word in the list on a vertical line at the
tab marker. The decimal tab aligns a column of decimal numbers
on the decimal point, as in a column of dollar and cent figures
(Figure 5-11). Each type of tab marker has a distinctive icon,
although the configuration varies slightly between applications.
SETTING TABS

Figure 5-10
Tab markers in word
processing applications
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Various tab settings
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To set a tab in most applications, you first select the type of t ab
you want by selecting its tab marker on the bottom half of the ruler
and then click at the spots you want to place the tab on the top half
of the ruler. Once placed, a tab can be adjusted by dragging it
horizontally along the ruler with the pointer. To remove a t ab,
simply drag it off the ruler, either upwar ds or downwards. The
MacWrite application has two tab boxes (or wells) on the lower left
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part of the ruler: one for left-align tabs and the other for decimal
tabs. To set one of these tabs, click and drag a tab from the box to
t h e upper part of the ruler. The word processing application in
Microsoft Works has left-align and right-align tabs whose markers
become visible when the pointer is positioned in the lower half of
the ruler and the mouse button clicked. One click deposits a leftalign tab marker, and double-clicking deposits a right-align marker. Either tab marker can be moved to a new position by dragging it
with the pointer. Later versions of Microsoft Works include two
additional tab markers: click three times for a decimal tab marker
and click four times for a center tab marker.
Some applications have left-align tab markers preset every half
inch as a default. These tabs cannot be moved or changed but are
superseded (and disappear) if they fall between any new tabs you
set.

This block of text has
the paragraph
alignment set for
fl us h left ( ragged
rig ht) text.
This block of text has
the paragraph
alignment set for
tl us h rig ht ( ragged
left) text.
This block of text has
the paragraph
alignment set for
centered text.
This block of text
has the paragraph
alignment set for
j us ti fi ed text,
Figure 5-12
Paragraph alignment
samples

PARAGRAPH ALIGNMENT
The paragraph alignment in copy
used for many documents is the left alignment; that is, all of the
lines of text are aligned evenly on the left side. Each line in the
paragraph varies in length, depending on the number of whole
words that can be contained within the margin settings. This alignment is often called flush left or ragged right. This alignment setting is the default setting but can be changed easily, either for the
whole document or for individual paragraphs. Other options in
paragraph alignment are right alignment (flush right or ragged
left), centered, and justified. Right alignment is the opposite of left
alignment; in right alignment, the right side of the copy block is
evenly aligned and the left side is ragged. In centered alignment,
each line of copy is centered at the halfway point between the margin settings, so both sides of the paragraphs are ragged. In the justified setting, both the left and right sides of the paragraph are
evenly aligned, such as those seen in newspapers and most books
(Figure 5-12). The computer does justified alignment by stretching
the space between words in a line.
To change the paragraph alignment from the default setting,
click the icon on the ruler that represents the alignment you wish
to use (Figure 5-13) before entering your text. To change alignment
in text already entered, first select the text that you wish to
change, then click on the icon for the alignment you wish to use. If
you wish to change only one paragraph, place the insertion point
anywhere within the paragraph, then select an alignment icon. In
some applications, such as MacWrite, a new r uler must be inserted
each time paragraph alignment is changed in a document.
A few applications do not set paragraph alignment by clicking
an icon on the ruler. In these a pplications, look for an alignment
command in a menu, usually titled Format, or in a sub-menu of
Text (a sub-menu pops down wh en you select a command in a regular menu-if a command has a pop-down menu, a triangular icon
appears to the right of the command).
CHANGING LINE SPACING
Most applications have icons on the
ruler for changing the amount of space between lines of text. The
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Figure 5-13
Paragraph alignment
settings
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default is single space; the other choices are 11/2 space and double
space.
To change the line spacing, use the same procedure as used for
paragraph alignment; select the appropriate line space icon (Figure
5-14) before you begin to enter the text. For text already entered,
first select the text you wish to change, then select the icon. As in
paragraph alignment, placing an insertion point in a paragraph
changes the spacing only in that paragraph. To change to a new
line spacing within a document in some applications, such as
MacWrite, a new ruler must be inserted.
Figure 5-14
The desired line spacing is
selected.
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As with paragraph alignment, icons for changing line spacing
may not appear on the ruler in your application. Look for a command or a pop down menu in the Format or Text menus.
~

MACtivity 5-5: Setting tabs and line spacing. Format the

~ text you entered and edited in the last activities:

1. In the second paragraph, set a left-align tab marker one-half
inch to the right of the left margin marker. Be sure the insertion
point is at the beginning of the paragraph, then press the Tab
key to indent the first line.
2. Place the insertion point somewhere in the first paragraph or
select the paragraph by dragging through it. Click on the line
spacing icon for 1 112 spaces or choose the command from a
menu if the icon is not on the ruler.
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Note: In Mac Write, clicking any icon in the ruler affects only the
text below the ruler and applies to all text up to the next ruler or
the end of the document. Each ruler is used to format the text
immediately below it.

fii1 Screen display: Pressing the Tab key

after the tab is set in
the ruler moves the insertion point to where the tab is set in
the line and pushes the text ahead. After the paragraph is selected,
clicking on either of the non-highlighted line spacing icons immediately changes the spacing between the lines of selected text.

B

size in points '

1
X Y

ascender-·
descender

CHANGING TYPEFACE, STYLE, AND SIZE
Typeface is the
characteristic design of a family of type fonts. Each design is identified by name, such as Helvetica, Times, New York, or Geneva.
Names such as these appear when you open the Font menu. In
applications, the word font is usually used synonymously with
typeface; to a typographer, however, font means only one of what
can be many variants in size and style of a typeface. Type style
refers to variations within a typeface; plain, bold, italic, underline,
outline, and shadow are styles found in the Style menu for almost
all applications used for creating word or graphic documents.
Type size is a measure of its height in points; since there are 72
points in an inch, a 12 point type size is one-sixth of an inch tall.
This size is the default size in most programs. The height of all letter characters is measured from the lowest point of the lowercase
letters with descenders (the lowest point of g, j, p, q and y) to the
top of the letters with ascenders (the top of b, d, f, h, k, 1, t).
To use a particular typeface, style, or size for your text, choose
the appropriate commands before you start typing. For text that
already exists, select the text you wish to change, then make choices from the Font and Style menus. The selected text immediately
changes to the new choices. If the insertion point is placed within a
block of text before choosing one or more of the commands, only
new text entered will have the changes-existing text is not affected. If you wished to make a style change in only one word in a text
block, select the word and choose the command. The style of only
the selected word changes. Except for plain style, you can use more
than one style at a time, such as bold italic. Just select the style
combinations one at a time from the Style menu.
The typefaces listed in the Font menu are those installed in the
system of your startup disk. Type fonts, like desk accessories, can
be added or removed from the system easily, so the number of typefaces listed in your menu depends on the number installed on the
startup disk you are using. If you have a hard disk with abundant
storage space, the list of typefaces may be long. Most floppy startup
disks have room for only a few.
The Font or Style menu also contains a selection of type sizes.
Some applications may have a separate Size menu or include size
as a pop down menu in a Text menu. Some of the sizes are listed in
plain type and some in outline style. The numbers in outline style
are the sizes for which screen fonts are available. Screen fonts are
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files that reproduce the type on the screen or on a dot-matrix printer. Sizes listed in plain style do not have screen fonts; they must be
reproduced by adjusting the available screen font. These sizes will
look distorted and rough on the screen, and they will not print as
well on a dot-matrix printer but will print perfectly well on a higher
resolution printer, such as a laser printer. Screen fonts, on the other hand, look best on the screen and when printing with a dotinatrix printer, such as the ImageWriter (you will find more information on printers in Chapter 8). Many applications also offer the
option of specifying sizes not included on the menu. These sizes are
scaled from sizes installed in the system and look rough on the
screen.
Like type sizes, type styles may be found in a separate Style
menu, in a Format menu, or in a pop down menu within a Text or
Format menu. Each style coinmand name is displayed in the style
that the command will produce.

;pt MACtiVity 5-6: Changing alignment and typefaces. Do the
llili,;!,.. following formatting on the text you entered and edited in the
last activities:
1. Place the insertion point in the second paragraph. Click on the
paragraph alignment icon for justified text.
2. Select the second paragraph by dragging through it with the 1beam. Choose the italics style and 10 point size commands from
appropriate menus.
Note: MacWrite also requires the text be selected when choosing
typeface, style, and size commands.
3. Try changing tl;ie typeface for either of the two paragraphs, or
both, by choosing another available typeface from the Font
menu.
(iii Screen display: After all the steps are completed, the text

13 should appear as shown in Figure 5-15. You may see some
variation in typeface on your screen depending upon what
selections you have available.
Figure 5-15
Final version of sample text
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Keyboarding is a term favored by some when referring to skills used in ~
the process of vvriting text on keyboard machines with speed and accuracy. 1
Touch typing is an older term, in use before the days of electric or
electronic typevvriters, or computers designed for word processing. Touch
typing more specifically describes the exercise of reflexes needed to make
the fingers respond in a certain way on the keyboard when a word or
letter pattern is transcribed. The words may be those being read and
copied from another document, or eXist only in contemplation or reflection.
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Other Features of Word Processing Applications
Most word processing programs offer additional features accessed
through menu commands, key combinations on the keyboard, or
mouse actions. Most also offer methods of making headers and footers, text that prints across the top or bottom of each page in a document that identifies the document and usually contains the page
number. Most applications also have means for searching through
the document for specific words or phrases and for numbering
pages automatically. Some have features like a spelling checker,
th esaurus, style sheets, outline programs, and much more. You are
encouraged to investigate the manual for the program you have
available. As you become more experienced in using an application,
you will want to take ~dvantage of its full capabilities.
Saving the Document
While you are working on a document, the text you are entering is
temporarily stored in the computer's internal memory. When the
command Save is used, a copy of all the work done on the document
up to that point is stored on disk. When you quit a document, it is
removed from the internal memory but remains on disk.
Any interruption in the power to the computer, even a momentary one, will erase all information stored in its internal memory. If
you have been working on a long document at the time of a power
interruption and have not saved it, all of the work would be lost. It
should be apparent that tu save often is the wise course to take.
Fortunately, saving a document, after filling out the dialog box
the first time the document is saved, takes only the amount of time
and effort required to choose a command or tap a key combination.
Get into the habit of saving your work at regular intervals-whenever you pause or leave the computer for a time or at about fifteenminute intervals if you are working at it steadily. In this way, you
have a minimum amount of work to redo if someone trips over your
computer power cord or there is a power outage.
The Save and Save As commands
The Save dialog box appears only when you first save a new docume~t; subsequent Save commands bring the current document file
up to date by recording its current state at the time the Save command is used. If you wish to save a document in its current state
and then modify the same document to create a new document,
first you would use the Save command to bring the current document up to date, then choose the Save As command. The Save As
command brings up the Save dialog box again; the title box has the
title of the current document highlighted in the title entry field.
Typing in a new name, or modifying the current document name,
and clicking Save creates a copy of the current document as a
new document. Creating copies this way can be repeated as often as
desired.
Note that after you click Save in the Save As dialog box and the
box disappears, the title of the document on the screen changes to
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the new title. A copy of the document under the previous title is
stored on the disk as a separate document.
The Save or Save As dialog box
The use of the dialog box was described in the More About...section
in Chapter 2. This is a review of the features that specifically apply
to the Save or Save As dialog box.
In the dialog box, the list with the scroll box is a directory of the
folders, applications, and documen'ts stored on the disk you are
using. If you have a disk in an external disk drive in addition to the
internal drive, clicking on the Drive button displays the titles of
documents on the disk in the other drive.
The titles you first see in the directory are those stored in the
active folder or disk window on the desktop when the document or
application was first opened. When more items are in the folder or
disk than can fit into the directory window, the scroll bar is activated to allow scrolling to other titles. Note that document and application titles are displayed in greyed letters while folders are displayed in solid letters and have a folder icon. If you wish to see
inside of a folder, double-click on the folder icon or title and the
names of items inside that folder will be displayed. When you click
the Save button, the document is saved on the disk, and in the folder, whose directory is on display.
If the directory display shows titles that are in a folder nested in
another folder, pressing the mouse button with the pointer on the
directory title (above the directory window) causes a menu to drop
down that contains the names of all the folder directories that are
above the current one in hierarchical order, with the name of the
disk at the bottom of the list. Dragging down to select one of the
names on the list opens the directory for that folder or disk.
In entering a name for your document in the title field, any combination of key characters can be used except a colon (:). The title
should not begin with a period. Up to 27 characters, including
spaces, can be used in a title, but it is prudent to keep titles fairly
short so they do not take up excessive room when displayed under
the icons in windows on the desktop. Titles in directory windows
are displayed in alphabetical order; however, a title beginning with
a number or symbol character (other than the colon or period) precedes titles beginning with letters.
You will find several other buttons besides the Save button in
the Save dialog box. The Eject button is used if you wish to swap
disks and save the document on a disk not currently in the disk
drive. Ejecting the current disk and inserting another changes the
directory window contents to items on the new disk. The Drive button is greyed (or absent) unless you have a disk in an exterior
drive. The Cancel button is used if you wish to get rid of the dialog
box without taking any action.
Placing Graphics in a Word Processing Document

A print or draw graphic can be inserted into a text document and
printed with an Image Writer, LaserWriter, or other printer that
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can handle graphics. The paint or draw image is transferred to the
text document with the clipboard in the same manner as text is
copied or cut and pasted. To transfer a graphic, you must have the
paint or draw application that can open the document containing
the graphic. If you have a paint or draw application available and
wish to try placing a graphic in your word document, read Using
Graphics with a Word Document at the end of Chapter 6.
Quitting the Application
When you are ready to quit working on a document, you must first
save it. Then choose Quit from the File menu or press Command
and the letter Q key simultaneously. In a few seconds the desktop
will appear on the screen.
Backing Up Documents

Occasionally something happens to a disk that can make the information on it unreadable. Fortunately, if reasonable care is taken
with disks, this occurrence is rare. However, if you value the work
you create with the computer, you will want to keep an extra copy
of valued documents on a separate disk.
Backup copies may be made before quitting a document by saving the document in the regular manner first. Then choose the
Save As command from the File menu and save a separate copy on
another disk. To do this, click the Eject button in the Save As dialog box to eject the disk that contains the first copy of the document, then insert your separate backup disk. Click the Save button
and a copy of the document will be made on the backup disk. You
do not need to change the name of the document for the second
copy as you would if you were saving a second copy to the same
folder on the same disk. Other methods of copying documents to
backup or data disks are described in Appendix A.
Shut Down
If you are stopping work at this point, use the shut down procedures described in previous chapters.
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Chapter 5 Self Test
Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.
A. Select one of the four choices that completes the sentence
correctly.
1. Pressing an arrow key on the keyboard moves:
a. the display on the screen in the direction of the arrow
b. the insertion point in the direction of the arrow
c. the I-beam in the direction of the arrow
d. the insertion point to delete text
2. The Return key is used to:
a . move to the next line within a paragraph
b. go back to a previous line in the text
c. end a paragraph
d. move the insertion point to the next tab marker
3. To format for a hanging indent:
a . select the r ight-align marker for paragraph alignment
b. set a left-align tab to the right of the left margin marker
c. set the first line marker to the right of the left margin
marker
d. set the left margin marker to the right of the first line
marker
4. Most word processing applications use the ruler for:
a . setting margin and tab locations
b. setting the type size
c. moving the text block into view when it extends beyond
the screen
d . showing the default settings only
5 . To change the typeface, size, and style of existing text, you
would:
a . place the insertion point in the text block, then select the
new choices from the menu
b. make the menu choices first, then select the text and click
the mouse button
c. highlight the text, then make the choices from the menu
d. use Cut to remove the text, make the menu choices, then
Paste to return the text to the window
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B . Select the statement on the right that defines each word at the
left.
1. __ default

2. __ points
3. __· format
4. __ typeface
5. __ wordwrap
6. __ type style
7. __ font
8. __ arrow key

moves the insertion point
Helvetica, Times, Geneva, Chicago,
italics, bold, outline, plain text
sets location of tabs and margins
measure of type size
layout of text on a page
an application's preset format settings
alignment of both edges of a text block
i. one size and style of typeface
J. a feature that automatically moves text to the next line when
approaching the right-hand margin
a.
d.
c.
d.
e.
f.
g.
h.

9. _justified
10. __ marker
default
margin
screen font
t ab
fir st line
colon
asterisk
Shift
decimal
insertion point
center
Option
left-align
Command
right-align
menu file

C. From the list of words at the left, choose one to fill in each
blank in the statements that follow.
1. In the menu for type sizes, the sizes shown in outline style

are those that have a
system.

installed in the

2. When you title your document, any combination ofletters,
numbers, or symbols found on the keyboard can be
used except the _ _ _ _ __ _
3. The tab marker used when you want to align a list of dollar and
cent figures is called a
tab.
4. Besides tabs, markers on the ruler that can be adjusted by
and the
dragging with the pointer are the
_ _ _ _ _ _ _ markers.
5. Most key combinations used to execute commands from the keyboard use a character key plus the
key.
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D. Mark the following with Tor F for true or false statements.
1. The arrow keys are used to select text.
2. Multiple lines of text can be selected by dragging through them
with the insertion point.
3. You can choose either Cut or Copy from the Edit menu to place
selected text on the clipboard.
4. The margin markers on the ruler control the width of the text
block.
5. Tab markers can be set by moving the insertion point and
double-clicking.
6. Ragged right means the right side of the lines of a text block
are not aligned.
7. Text must be formatted by setting all the formatting controls
before the text is entered.
8. The Save dialog box will not appear on the screen after the
document is first saved.
9. The Save As command is used only to make a backup copy of
your document.
10. The title for a new document is Untitled until you return to the
desktop and type a title under the document's icon.
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Obj ectives
After completing this chapter, you will be able to:
1. Use a paint application to produce a graphic document.
2. Modify the painting with tools provided by the application.
3. Use text in the painting.
4. Save the document and quit the application.
Important te rms
These terms are defined in this chapter and in the Glossary.
bit-mapped
object-oriented
pixels
FatBits
paint window
selection
grabber
palette
rectangle
lasso

Differences Between Paint and Draw Applications
All graphics and text t h at you see on the screen are made of tiny
square black dots on a background of tiny square white dots. There
are 72 of t h ese dots, or pixels, in each linear inch of the screen,
both horizontally and vertically, or over 5000 pixels in each squ are
inch. When you use a painting or drawing tool or press a text character key, the computer turns individual pixels on or off to form the
visible lines, patterns, tones, or letters you see on the screen.
Paint programs are called bit-mapped programs. The computer
keeps track of the location of each pixel or bit and whether it is
black or white. An assortrp.ent of pointer sh apes, called tools, can be
chosen to change pixels to form lines, shapes, or patterns, just as
the keyboard signals th e computer to ch ange pixels into letters and
95
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ch aracters. For example, when the paint brush tool is chosen, dragging its pointer around the screen with the mouse changes the
white pixels on th e screen to black pixels in the wake of the tool,
just as if you were drawing with a paintbrush and ink on paper.
Once a figure is painted with a tool, it can be modified easily by
making more white pixels black or by making black pixels white.
Each pixel on the screen can be turned on or off individually if
desired. A feature, usually called FatBits, enlarges an area of the
painting so you can see each individual pixel and make very
detailed revisions (Figure 6-1).
Figure 6-1
The FatBits feature enlarges
an area of a painting.
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Draw programs are called object-ol'iented programs. Each
drawn object is an individual entity that the computer stores as
mathematical information. This data identifies characteristics of
the drawn object, such as size, location, fill pattern, and line width.
Drawn images cannot be modified pixel-by-pixel; actions to revise a
drawing must apply to the whole object.
There are advantages and disadvantages in both paint and draw
programs. For example, paint programs have tools that make creating some types of images easier and more fluid. In drawing programs, drawn objects can be stacked and layered and still moved or
changed independently-a l aborious if not impossible task in a
paint program. You will learn about other differences as you work
with the two types of programs.
Some applications combine paint and draw tools, each in separate but superimposed layers. Using these applications is similar to
drawing on two sheets of acetate with one sheet stacked on top of
the other. One layer of the acetate is used for draw tools and the
other for paint tools. An image can be created in either layer or
parts of the image in both layers. Painted objects can be viewed in
th e drawing layer, or conversely, or either layer viewed separately.
The applications provide a command for switching quickly from one
layer to the other.
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The uses of the paint and draw applications that will be
described in this chapter and in Chapter 7 are common to all applications of their type. This chapter describes the features of paint
programs or the paint layer of combined paint and draw programs.
The features of draw programs, or the draw layer of combined paint
and draw programs, are described in Chapter 7. For additional features that may be available in the particular application you are
using, you are encouraged to consult the user's manual for that
application.
Using the Paint Application
Some of the paint applications are MacPaint, FullPaint, DeskPaint,
and Cricket Paint. The graphic tools used in HyperCard are also
paint tools. Programs that combine paint and draw capabilities
include SuperPaint and Canvas. In these applications, the procedures that will be described in this chapter apply to their paint
layer.

Opening the application
To open a paint application, open the application disk window, if
necessary, by double-clicking on the disk icon on the desktop .
Double-click on the application icon or select it and choose Open
from the File menu. In a few seconds, the paint window appears.
The paint window
The paint window is the area you use to create your images
(Figure 6-2). Like other windows, it has a title bar and a close box.
Most paint application windows also have scroll bars, a size box,
and a zoom box. Along the sides of the paint window are rectilinear
strips of icons called palettes that offer choices you can make for
paint tools, fill patterns, and line thicknesses. Across the top is a
Figure 6-2
The paint window
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menu bar with some menu titles that may be new to you. In different applications, the locations of palettes and the titles in the menu
bar may vary from the one shown.
THE PAINT TOOL PALETTE
The vertical strip at the left side
ofthe window has icons for the painting tools. It also has tool icons
for selecting images you can create and for adding text to the paintings (Figure 6-3). Clicking on a tool icon activates that tool; th en
the mouse is used to create the image. In many applications, the
tool palette can be moved to another location by dragging with the
pointer on a bar, similar to a title bar, at one end of the palette.
Often the bar has a close box. Clicking the close box removes the
palette from the window. A menu command or a key combination
makes the palette return. Some applications use "tear-off' palettes
that appear when a Tool menu is opened. To tear off the palette,
drag down through one of the borders of the palette and continue
dragging-the palette will pull away from the menu bar and can be
moved anywhere on the screen.

Figure 6-3
The paint tool palette
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THE LINE THICKNESS PALETTE
Usually located within or next
to the tool palette, the line thickness palette offers several choices
of line thickness when you are using the straight line tool and any
of the shape tools (Figure 6-4). Any of these thicknesses can be
selected by clicking with the pointer on the line. The dashed line
indicates no line and is used when you wish to create filled shapes
without an outline.

Figure 6-4
The line thickness palette
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This palette usually appears as a horizontal
strip across the bottom of the window. It contains tones and patterns used to fill closed shapes in the image (Figure 6-2) .
Depending upon which tool you are using, the shape may be filled
as you form it or at a later time. Clicking on one of the fill boxes
duplicates the fill pattern in a larger box at the left of the fill
palette, indicating which fill is currently active.
MENU BAR
Three of the menu titles will be familiar: Apple,
File, and Edit. Other menu titles, such as Goodies, Font, FontSize,
and Style, may vary depending on which paint program you are
using. All have commands that apply specifically to creating painted graphics.
THE FILL PALETIE

Getting around in the paint area
The paint window displays only a portion of the total field that can
be used for painting. Like windows you encountered on the desktop,
other areas of the larger painting field must be moved into view by
scrolling the window.
Most paint programs have vertical and horizontal scroll bars
that move the full size view window around the larger painting
field. Another method of moving the window viewing area is by
dragging with a tool called the grabber. The grabber is the hand
shaped icon in the tool palette. When selected, the pointer becomes
a hand shape when positioned over the paint window. Move the
grabber to any location in the working area of the window, press
the mouse button, and drag in any direction. Dragging with the
grabber moves the hidden areas of the painting field into the window viewing area. Unlike scroll bars, the grabber can make diagonal as well as vertical and horizontal movements.

p

MACtivity 6-1: Moving around the paint field. Open your
paint application by double-clicking on its icon in its disk window. The paint brush tool will be selected when the window opens,
and the pointer will be in the shape of a large dot. Make a quick
drawing by pressing the mouse button and dragging the paint
brush. Select the grabber icon in the tool palette. Move your drawing around the window viewing area with the grabber, then move
part or all of it out of view.
fii1 Screen display: The paintbrush tool paints lines as you drag
B the mouse. 'lb start a new line, release the mouse button, reposition the pointer to the starting point of the new line, and drag.
The grabber moves the larger painting field into the viewing area of
the window when dragged with the mouse. Most painted images
can be moved entirely out of the viewing area if moved toward the
top or bottom of the screen.
~

A reduced view of the total painting area can be seen by choosing
Show Page from the Goodies menu. In some applications the command is called Reduced View or Zoom Out and is found in a
Windows or View menu. The reduced view of the total painting area
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is displayed in a new window, either centered in the screen (Figure
6-5) or as part of a split screen together with the regular window .
Usually the reduced view shows a dotted rectangle which represents the area of the painting field that shows on screen when in
the full size view. The rectangle can be moved around the painting
field by moving the pointer inside the rectangle and dragging.
When the rectangle is moved to the location of the field you want to
show on the screen, click the OK button and the full-size window
returns. In some applications, choose the Zoom In or Full Screen
from a Window or View menu.
Figure 6-5
Reduced uiew of painting
area
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An image in the painting field is visible in the reduced view, but
detail may be unreadable due to the reduction of the image. In
some applications the image can be moved to another location on
the field by moving the pointer to a spot outside of the dotted rectangle and dragging. You may want to do this to center the image on
the field or to control where the image appears on a page when
printed. However, be very careful when moving the image in the
reduced view; moving it off the edge of the painting field erases the
image. Some applications do not allow you to move the image in the
reduced view. In SuperPaint, for example, the reduced view is part
of a split screen; one part shows the reduced view, and the other
, part shows the full-size view. To move the object to another area of
the painting field, it must be selected and moved in the full-size
view. Selecting painted objects is described later in this chapter.

p

MACtivity 6-2: Viewing the whole painting field. Select

~ Show Page from the Goodies menu (Reduced View or Zoom

Out in a View or Windows menu in some applications). Move the
pointer inside the dotted rectangle and drag the rectangle to
enclose the painted image. Click the OK button.
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1iJi1 Screen display: Selecting the command shows a reduced

B view of the whole painting area. The dotted rectangle represents the window viewing area that you will see on the screen when
the image is full size.

In most applications, you cannot work on an image while in the
reduced view. When you wish to return to the full-size view, click
the OK button. Clicking on the Cancel button also returns the fullsize view but cancels any changes you have made in the image location on the page or to the portion of the viewing area that you see
on the screen.

Paint too ls
Some paint tools are freehand tools. The freehand tools include the
pencil, brush, spraypaint (or airbrush), and the straight line tool.
With these, you paint images with the mouse as you would draw an
image on a piece of paper. The mark these tools produce follows the
mouse movement in any direction. If you press the Shift key while
using the tools, they can be constrained to straight horizontal, vertical, or 45-degree movements. 'l\vo tools, the freehand shape and
polygon tool, are freehand tools; however, they also can make closed
shapes that automatically fill with a pattern. Other tools paint
shapes only. These are the rectangle, rounded rectangle, and oval
tools. With these tools, one straight line drag of the mouse produces
a shape similar to that of the tool icon. These shapes may be filled
with the pattern that is active in the fill palette or may be outlinedonly shapes with the outline thickness selected from the line thickness palette. A square or circle can be made by holding down the
Shift key while the rectangle or oval tool is used. The paintbucket
tool is used to fill closed shapes with the patte1n that is active in
the fill palette after the shapes are first outlined with other paint
tools. Other icons on the tool palette include two selection tools, the
lasso and the selection rectangle (also called the marquee), the text
tool, and the eraser. The selection tools are used to move and duplicate painted images. With the text tool you can enter text from the
keyboard as part of the painting. The eraser tool changes black pixels to white; it can erase any part or all of the image.
Practicing with the paint tools
The next series of MACtivities will utilize many of the paint tools to
produce a club emblem. Before you work on each part of the
emblem described in the MACtivities, try out the tools in a new
document painting window as you read about them.
First click on the close box for the painting window used in
MACtivity 6-2. When a dialog box appears asking if you want to
save the changes, click the No button. This erases the document
and removes the window. Choose New from the File menu. A new
window will open that you can use to try out the tools. When you
finish trying out a group of tools, close the window and again click
the No button when the dialog box asks if you want to save the document.
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Tools that paint shapes and lines will be used to delineate outlines of the emblem forms. To use these tools, you first select the
tool by clicking on its icon to highlight it. Then when the arrow
pointer is moved into the paint window, it changes to one of several
other pointer shapes, depending on the tool selected.
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THE RECTANGLE, ROUNDED RECTANGLE, AND OVAL SHAPE
TOOLS All three of these tools paint their shape with one drag of

the mouse, either as an outline of the shape or as the shape filled
with the pattern currently selected on the pattern palette. Select
the un shaded icon of the tool for just the outline and the shaded
icon for a filled shape. The border width for the outline of the shape
can be selected from the line thickness palette. To use, first select
the tool in the tool palette. If you select the shaded icon of the
shape, then select the fill pattern from the pattern palette. Select
the border thickness from the line thickness palette. When the
pointer is moved to the paint window, it becomes a cross hair with
lines the same thickness that you selected for the border. Start the
drag at a spot in the window you wish to place one corner of the
shape and drag diagonally. If you are using the oval tool, the drag
starts at a corner of an enclosing rectangle. You can move diagonally down, up, to the right, or to the left. When the shape reaches the
size and proportion you wish, release the mouse button. If you
press the Shift key while you drag, the rectangle and rounded rectangle tools make a square and a square with rounded corners; the
oval tool makes a circle. With some applications, pressing the
Option key and dragging paints the shapes from the center of the
shape outward. Pressing both the Option and Command keys and
dragging paints circles and squares from the center outward.
These tools
function much the same way as the other shape tools, except that
the contours of the shapes are drawn with the mouse. Use the freehand shape tool for curved, contoured shapes and the polygon tool
for straight-sided shapes. These shapes can be completely enclosed
with a border around the whole shape or left open by not joining
the beginning and end of the outline. The shapes do not have to be
completely closed shapes if the outline icons of the tools are selected. If the filled icons are selected, the shape closes and fills even
though the drawing of the shape stops short of complete closure.
The computer completes the closure with a straight line between
the beginning and ending points of the screen contour and fills the
shape with the current pattern.
The polygon tool u ses a slightly different painting technique
than other line or brush tools. A mouse click establishes the beginning corner of a shape, then the pointer is moved to the second corner (dragging is not necessary) and clicked, and so on to each corner of the shape. As the pointer is moved, a line stretches behind it
like a rubber band; the line is anchored to the painting area at each
click point. When the shape is finished, whether closed or not, a
double-click finishes the contour. If the filled polygon tool is being
used, a straight line automatically joins the first and last anchor
points, and the shape fills with the current pattern.
THE FREEHAND AND POLYGON SHAPE TOO LS
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THE STRAIGHT LINE TOO L
This tool paints only straight black
lines when you drag the mouse. Lines can be constrained to vertical, horizontal, and 45 degree angles by holding down the Shift key
as you drag. The line width can be changed by selecting an alternate width in the line thickness palette. Some applications allow
you to select a pattern for the line as well.

Making a Painting-The Sailing Club Emblem
The objective of the series of MACtivities in this chapter is to use
the paint application to make an emblem for a sailing club. The
first activity constructs the main image shapes. Activities later in
this chapter add text and additional detail.
Before starting, close any window that you have been using to
try out the painting tools by clicking its close box. Click the No button in the dialog box whep. asked if you want to save the changes.
Choose New from the File menu to open a new window.
;pl MACtivity 6-3: Constructing the main emblem shapes.
~ 1. Select the unfilled oval tool and the two point line (the second of the solid lines in the line thickness palette). Hold down
the Shift key and, starting with the cross hair pointer near the
top left corner of the screen, drag out a circle with a diameter
about three-fourths of the height of the paint window (Figure 66).
Figure 6-6
The oval tool and Shift key
are used to draw a circle.
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2. Select the straight line tool, press the Shift key, and paint a
horizontal line across the circle, about one-third of the way up
from the bottom (Figure 6-7).
3. Select the unfilled polygon tool and the thinnest of the solid
lines in the line thickness palette. Draw the shape of the hull
and the two sails, as shown (Figure 6-8).
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Figure 6-7
Use the straight line tool
and the Shift key to paint a
horizontal line across the
circle.
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Figure 6-8
Use the polygon tool to draw
the hull and two sails.
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liil Screen display: Compare your results with the one illustratB ed (Figure 6-8). Don't worry if your painting differs slightly.
Ways of changing an image will be described later in this chapter.

Note: You should save your image at this point. Choose Save
from the File menu. If you have not saved the document before,
enter a title, such as Emblem, in the Save dialog box. If you are
saving to another disk, click the Eject button and insert the disk
that will be used to store the document. If you are saving to a disk
in a second drive, click the Drive button to open that disk's directory. When the directory of the new disk appears in the Save dialog
box, click the Save button. You should save periodically from now
on as you develop the emblem graphic.
Add ing background and text; selecting objects
The next steps in developing the sailing club emblem are to fill the
background behind the boat, add the name with the text tool, and
use the selection tools to move objects and to invert the lower part
of the image to read as white against black.
Try out these tools in a new window before proceeding with the
emblem. In most applications, you can open another window by
choosing New in the File menu without closing the emblem document. If your application does not allow more than one document
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open at a time, close the emblem document first. Since it has been
saved, it can be reopened when you are ready to continue working
on it in the next MACtivity.
The paint bucket is used to fill closed
shapes with the pattern selected from the pattern palette. To use,
first outline a closed shape with one of the line tools or an unfilled
shape tool. Select the paint bucket tool in the tool palette, then
select the pattern you wish to use for a fill from the pattern palette.
The pattern is chosen by clicking one of the small pattern samples
and is duplicated in the larger box at the left of the fill palette,
indicating that pattern is the active fill pattern.
The pointer becomes a paint bucket shape when moved into the
paint window. The tip of the paint stream pouring from the bucket
is the ''hot spot" of the pointer, the spot from which the fill pattern
flows . Move the tip of the paint stream to the white area within the
boundaries of the closed shape and click the mouse button. The
shape fills with the pattern.
At times the pattern will probably spread to areas outside of the
shape, perhaps even filling the whole paint window. If this happens, don't panic. Before you take any other action, select Undo
from the Edit menu. This removes all of the pattern you just
placed. An alternative to the Undo command is to press the tilde
key (-) at the left end of the number row on the keyboard. In most
applications, you can press the Command key and the letter Z to
undo the last operation. The reason the pattern spreads beyond a
shape is because the shape has a break in its outline. Even a break
of only one pixel allows the pattern to flow out of the outline. Small
breaks may be difficult to see unless enlarged in FatBits (using
FatBits is described later in this chapter), but pixels must be added
to mend the breaks before you can successfully fill the shape with
the paintbucket tool.
The paint bucket can also fill solid black areas with the active
fill. If the black area is small, be very careful that the tip of the
paint from the bucket is inside the edges of the area before you
click the mouse button. Otherwise, the fill will pour into the white
areas around the black.
THE PAINT BUCKET

THE TEXT TOOL
The text tool is usually identified in the toolbox palette with an alphabet letter icon. After selecting the text
icon, the pointer changes to an I-beam when it is over the paint
window. When the I-beam is located at the spot you wish the text to
start, click the mouse button to set an insertion point. Typing on
the keyboard enters letters, numbers, or other keyboard characters
in the window, starting at the insertion point.
As you enter words, numbers, or other characters from the keyboard, the entry is an active text block until you move the I-beam
to another location in the window and click again to establish a
new insertion point. The first block then becomes a bit-mapped
area, the same as any other painted image, and cannot be edited
with the text tool. While a text block is still active, it can be
changed with menu commands. Another typeface can be selected
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from the Font menu. The size of the font can be changed from the
Font or FontSize menu. Font sizes that are indicated in outline
style in the font menu look best in a painted image. The style, such
as bold, outline, or shadow, can be changed from the Style menu.
These commands are described in Using Menu Commands in Paint
Applications at the end of this chapter. Any of these menu commands changes the whole active text block, so the command does
not have to be chosen before entering text; however, any desired
changes must be done before the text block is deactivated.
THE SELECTION TOOLS
The selection rectangle (often called
the marquee) and the lasso are located at the top of the tool
palette. Either of these tools can be used to move an image, or parts
of an image, in the paint window. They are used to copy an image to
the clipboard to be pasted elsewhere in the same document, or in
another document, and to duplicate an image. In addition, the
selection rectangle can be used to change the size of an image,
either in a horizontal or vertical direction or proportionately. An
image selected with the selection rectangle can be inverted (black
pixels changed to white, and white pixels changed to black), flipped
in a horizontal or vertical ·direction, or rotated. Some applications
have other commands, such as Skew or Distort, that apply to painted areas that are selected with the selection rectangle.
When the selection rectangle is chosen, the pointer changes to a
cross hair when moved to the paint window. The selection is made
by dragging diagonally across the image so that all of the area of
the image, or the desired part of the image, is enclosed in the rectangle. When the mouse button is released, the border of the rectangle pulsates. If you move the cursor inside the rectangle, it becomes
a pointer. When it is a pointer, you can drag the whole area inside
the rectangle to move the ·image to another location. A copy of the
selected image will be made if you hold down the Option key and
drag the selection; multiple copies can be dropped along the path of
the drag by releasing the mouse key momentarily, then continuing
the drag. Repeated copies can be made by holding down both the
Option and Command keys while you drag; changing the line width
in the line and border palette determines the space between copies.
Larger images copied in this way will appear to overlap.
To stretch or shrink a selection made with the selection rectangle, hold down the Command key, position the pointer just inside
the border of the marquee, and drag. If you wish the image to be
enlarged or reduced proportionally, hold down both the Command
key and the Shift key as you drag one corner of the selected area.
The lasso selection tool functions in many ways like the marquee. With the lasso selected, the pointer becomes a lasso shape in
the paint window. To make a selection with the lasso, draw around
the image with the tip of the lasso to enclose the image or portion of
the image to be selected. When the mouse button is released, the
selected area shrinks inward to the nearest black pixels of the
image, and the pulsating outline follows the outside edges of the
image. The lasso makes it possible to select an image of irregular
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shape when other images are near it. When an image is selected
with the lasso, it can be moved or copied in the same manner as
with the selection rectangle. However, you cannot stretch or shrink
an image selected with the lasso or perform some of the menu commands that can be used with the selection rectangle.
The selected image, including any white space within the selection area, is opaque and blocks out the parts of any other image
over which it is moved. With most applications, holding down the
Command key while selecting with the selection rectangle causes
the borders of the rectangle to snap in as tight to the enclosed
image as possible without changing its rectilinear shape. In other
words, the maximum height and width of the image is the height
and width of the enclosing marquee. This reduces the amount of
white space around the image and makes it easier to move it close
to other images without blocking them out. Where you must overlap non-rectilinear images, selecting with the lasso may be the only
way to accomplish an overlap with minimum disruption of the overlapped image.

pp MACtivity

6-4: Adding fill and text to the emblem. If you

~ closed your emblem document, choose Open from the File

menu to reopen it. If the Open command is greyed, close the practice window first. Select the emblem document title in the Open
directory box and click the Open button. If the emblem document is
still open, bring its window to the front by choosing its title in a
Windows or View menu.
1. Select the paint bucket tool and the black fill from the pattern
palette. Move the paint bucket pointer to a spot between the
boat or sail outlines and the circular border on the emblem and
click the mouse button.
Note: If the fill spreads inside the boat or sail outlines or outside
the circular border, immediately select Undo from the Edit menu
or press the Command key and the letter Z.
If the fill spreads, there is a gap in the outline. Repair it by
adding pixels to fill in the gap and apply the fill again. If it is
necessary to enlarge the image to find the gap, refer to the
FatBits description which you will find later in this chapter.
If some of the background did not turn black as shown in
the illustration (Figure 6-9), position the tip of the paint stream
inside these areas and click the mouse button again.
2. Select the text tool, position the I-beam pointer in a blank area
of the screen away from the emblem, and click the mouse button
to set the insertion point. Depress the Caps Lock key and enter
the word SAILING. Press the Return key and enter CLUB.
Note: Once the typing is completed, do not deactivate the text by
clicking the mouse button elsewhere until you have completed
the next text formatting steps.
Choose 24 points from the Font Size or Font menu. Choose
Bold and Centered from the Style menu. Try some of the fonts
listed in the Font menu by choosing them in turn. Make a selec-
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tion from one of the fonts listed on your Font menu. The title of
the Emblem is complete (Figure 6-10) except for moving it into
place.
Figure 6-9
A dd fill to the background
using the paint bucket tool.
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Figure 6-10
E nter the title of the
emblem.
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3. Click on the lasso selection tool icon in the tool palette. Drag an
outline around the whole text with the tip of the lasso. When you
release the mouse button, check to see that all the letters have a
pulsating line around them. If not, repeat the procedure. With
all the letters selected, position the tip of the lasso inside one of
the letters of the title. When the pointer becomes an arrow, drag
the title inside the lower third of the emblem and center it as
shown (Figure 6-11).
Figure 6-11
Drag the title inside the
circle.
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4. Click on the rectangle (marquee) selection tool in the tool
palette. Carefully position the cross hair pointer slightly under
the horizontal line in the emblem and just outside the circular
outline. Drag a selection rectangle over the lower part of the
emblem as shown (Figure 6-12). Choose Invert from the Edit
menu (or the Paint menu in some applications). If the results
are different from that shown (Figure 6-13), immediately choose
Undo from the Edit menu (or Command-Z) and try placing the
selection rectangle and choosing Invert again.
Figure 6-12
Drag a selection rectangle
over the lower part of the
emblem.

I
I
I
I
I
I

'---------°""----~

Figure 6-13
The finished emblem

fii1 Screen

B

display: Compare your results with the illustration
(Figure 6-13).

Save your document again at this point. Choose Save from the
File menu or press the Command and S keys on the keyboard
together. The additions you made are saved, but the Save dialog
box will not appear since you have saved the document before.
To try out the tools described next before continuing with the
next MACtivity, open a new window. If you are using an application
that allows more than one window open and your last practice window is still open, activate it for the new trials by choosing Untitled
from a Windows or View menu.
Maki ng changes and adding details to the emblem
The final step in completing the emblem image is to add details.
Some of the details are newly painted parts added to the emblem;
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other details are made by removing black pixels from the current
painting. The most versatile tools for fine detailing are the pencil
and eraser tools used in combination with FatBits.
THE PENCI L TOO L After the pencil tool is selected from the tool
palette, the pointer becomes a pencil when moved into the paint
window. The pencil tool makes a one-pixel width line in solid black
or white when it is dragged with the mouse. The width and pattern
of the pencil line cannot be changed. This tool has special u ses
besides painting a line, particularly in editing.
When the pencil tip is placed on a white pixel when you start a
line, the line will be black. If the tip is on a black pixel when you
start a line, the line will be white; in other words, the pencil erases
black pixels if the tip of the pencil is on a black pixel when th e
mouse button is first pressed. Clicking on a single pixel with the
pencil changes the pixel to its opposite, black or white. Dragging
with the pencil changes a row or line of pixels. The pencil is especially useful in making fine adjustments to images, whether first
painted with the pencil or another tool. These adjustments are usually made in an enlargement of a small section of the paint window,
called FatBits.

To enlarge a section of a painting,
point the end of the pencil tool to the area you wish to enlarge, hold
down the Command key, and click. The paint window fills with an
enlargement around the spot where the pencil point was located
when you clicked. If you see a blank screen, you probably had the
pencil point away from the image on the screen-depress the
Command key and click a second time to return to the original window to t1y again. While in FatBits, a small window in the corner of
the screen shows the original size of the section of the image contained in the enlargement (Figure 6-14). In FatBits, each pixel is
large enough to be easily edited. You can add pixels by clicking
with the point of the pencil on a white space or change black pixels
to white by clicking with the pencil point on a black pixel. Dragging
adds a continuous row of pixels, either black or white depending on
which color is under the tip of the pencil at the star t of the drag.
Pressing the Shift key while dragging constrains the rows to h orizontal, vertical, or 45 degrees; the direction depends on the first
direction you start the mouse at the beginning of the drag. Other
tools may be used while in FatBits, including the selection tools.
Since the window in FatBits contains only a small section of the
image, you often need to move other parts of the image into the
viewing area of the scr een. Select the grabber tool from the tool
palette, or if you are using the pencil tool, press and hold down the
Option key to change the pencil tool into the grabber. On some
applications, the Option key also changes other tools into a grabber
tool; in still other applications pressing the space bar will change
any painting tool into the grabber.
To leave FatBits and return to the full-size window, cFck anywhere in the enlargement window with the pencil tool while pressing the Command key. The pencil tool, in. conjunction with the
FATBITS AND THE GRABBER
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Command key, is the only tool you can use to enter or leave FatBits
directly. Your application may also have a FatBits command in a
menu ; in some applications, this menu is titled Goodies. Choosing
the FatBits command toggles between the enlarged view and the
actual size view. Some applications have a magnifier icon in the
tool palette. When selected, it enlarges the area under the lens
when the mouse button is clicked; clicking outside the painting
area reduces the image to its normal size.
Figure 6-14
A small window in the
upper corner shows the
original size.
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THE ERASER TOOL The icon that looks like a box on the tool
palette is the eraser tool. When selected, the pointer becomes a
small white square when over the paint window. Dragging the
square removes any black pixels the square passes over. The eraser
movement can be constrained to vertical and horizontal movements
by pressing the Shift key while dragging. Be careful not to doubleclick the icon when selecting the eraser tool from the tool box.
Double-clicking erases all of the contents of the paint window.
The eraser tool is useful when editing in FatBits also. The active
erasing area of the tool does not enlarge in FatBits; the area of the
eraser covers only four pixels at a time in the enlargeq view. The
size of the eraser cannot be changed in most paint programs; however, in SuperPaint the eraser reduces to one half of its size when
you press the Option key. In other applications, the eraser becomes
a grabber when the Option key is depressed.

p

MACtivity 6-5: Adding detail to complete the emblem. If
~ the emblem document is still open, bring its window to the
front by choosing its title in a Window or View menu. If the emblem
document is closed, reopen it as described in MACtivity 6-4.
1. Select the pencil tool from the tool palette. Move the tip of the
pencil pointer to the top of the sail at the top edge of the circle.
Press the Command key and click the mouse button. If the tip of
the sail is not visible in the enlarged view, press the Option key
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so that the pencil becomes a grabber and drag the window until
you find the spot.
2. Using the pencil or eraser tool, hold down the Shift key and
erase three vertical rows of black pixels to define the mast a s
shown (Figure 6-15). Remember that to erase black pixels with
the pencil, start on a black pixel and drag down to remove a
whole row of black pixels. If the window for the application you
are using does not scroll when the tool pointer reaches the edge
of the window, press the Option key to change the pencil to a
grabber hand. Move more of the image up into the viewing area
with the grabber hand and continue erasing black pixels until
you reach the hull of the sailboat (Figure 6-16). Repeat the same
operation to erase two horizontal rows of black pixels at the base
of the sail to define the boom (Figure 6-17). Remove or add other
pixels for detail as shown (Figure 6-18) or as you choose.
Figure 6-15
Use the pencil or eraser tool
to erase vertical rules.

Figure 6-16
Erase pixels to define the
boom.

Figure 6-17
Use the same procedure to
erase horizontal rows.
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Figure 6-18
Remoue or add pixels for
detail.

3. Create a flag for the top of the mast and a logo design for the
sail if desired. These may be painted at the spot they are to be
located or painted at an unused portion of the window, selected
with the lasso, and moved to their final location. The flag shown
(Figure 6-19) was painted in FatBits with the pencil tool; it may
be made by painting a simple triangle instead. In the logo
design (Figure 6-20), the larger circle was painted with the filled
oval tool with the diagonal stripe pattern active in the fill
palette. The smaller circle with a white fill pattern was centered
over the larger circle. The pencil tool was used to detail the horizontal stripes.
Figure 6-19
Add a f7.ag to the top of the
sailboat.

Figure 6-20
Add a logo to the sail.
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~ Screen

display: Compare your results with the final emblem
design (Figure 6-21). Save your new additions. If you wish to
print the document, printing procedures are described in Chapter
8.

B

Figure 6-21
The final emblem design

Other Paint Tools
Although these paint tools were not used in creating the emblem,
you should try them out to become acquainted with the function
they can fulfill in future paint documents. Open a new paint window or activate the practice window you used for previous trials.
The paintbru sh too l
The paintbrush tool is usually the default tool present when you
open most paint applications. The pointer becomes a roundish dot
when in the paint window. To paint, press the mouse button and
drag the dot; the dot leaves its track, duplicating the movement of
the mouse until the button is released.
The paintbrush paints in the pattern shown in the active pattern
box at the left of the pattern palette. To change that pattern, click
on one of the smaller boxes that has the pattern of your choice. This
new pattern then fills the larger box, and any further painting you
do leaves tracks in this pattern.
The initial brush size and shape can be changed also. Doubleclick on the brush tool icon in the tool palette. A new palette will
appear with a variety of brush shapes and sizes (Figure 6-22). The
current brush is outlined in a box. To choose one of the other
shapes, click on it. The brush palette disappears, and the new
brush shape appears in the paint window as the pointer.
The paintbrush can also be used to erase black pixels from previously painted areas by clicking on the small white box in the pattern palette; the paint pattern will then be solid white. Choose any
of the brush shapes or sizes from the brush shape palette. This is
often useful when editing an image because the paintbrush tool can
be made much smaller in size than the eraser tool.
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Figure 6-22
The brush size and shape
can be changed.
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The spraypaint too l
Dragging with the spraypaint tool mimics an airbrush or spray
can. A single pass deposits a light tone that darkens as repeated
passes are made (Figure 6-23). The spray pattern conforms to the
pattern that is currently selected in the pattern palette. If solid
white is selected in the pattern palette, the spraypaint tool lightens
the blacks in an image. The spraypaint tool can also be constrained
to horizontal, vertical and 45-degree directions by holding down the
Shift key.
Figure 6-23
The spraypaint tool mimics
an airbrush or spray can.
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Using Menu Commands in Paint Applications
The number of menus and the commands in each menu vary in
different paint applications, depending on features available in the
application. Menus, such as the File, Font, and Style menus, have
the same commands found in similar menus for other applications
used to produce text or graphic documents. The Edit menu has a
group of these generic commands but also includes commands
specific to the paint application you are using.
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The Fil e menu
The commands described in the following section are common to all
paint applications. To learn about other commands you may see in
· the menus of the particular application you are using, read the
application's manual.
• New. If you wish to start a new document in the same application you are currently using, select New to open a new, untitled
window. When saved, the new window becomes a new document.
Most applications allow several document windows to be open at
the same time in the same application. With older versions of
MacPaint, the current window must be closed before a new window is opened. The active window, the window you can paint in,
will be on top of all other windows. Any of the windows can be
made active so that it can be worked in by clicking the pointer
anyplace inside its visible borders. You may have to resize and
move windows around to see some part of each window. Refer to
Chapter 2 if you have forgotten how to move and resize windows.
• Open.. This command opens a dialog box with a directory of document and folder titles on your current disk. Any one of the documents can be opened by clicking its title in the directory to select
it and then clicking the Open button. The document window
opens on top of the window (or windows) already open.
Only titles of documents that you can open appear in the directory window. If you have documents made in other applications
stored on your disk, these names do not appear. However, folder
names show on the list. These are identified by the folder icon
preceding the title and may be opened by double-clicking on the
folder name or by selecting the folder name and clicking on the
Open button. Any documents stored in the folder that can be
opened appear in a new directory window.
If you wish to see the contents of folders at a higher level in
the hierarchy of folders, move the pointer over the small title bar
just above the directory window and press the mouse button. A
menu of folder names in the hierarchy will drop down, with the
name of the disk at the bottom of the list. Drag down to the level
you wish to see and release the mouse button; the contents of the
folder at that level will appear in the directory window.
If you have documents stored on a disk other than the one currently in the drive, click the Eject button and insert the other
disk. The directory of that disk will appear in the dialog box.
Select the document and click the Open button to open the document. If you have only one disk drive, the computer asks for the
disk it needs to continue with your work.
If you have two disk drives, the application disk should be in
one drive, and the document disk in the other. Click the Drive
button to toggle between the directories for the disks in either of
the two drives.
• Close. Selecting this command closes the active window in the
application. Choosing the Close command does not remove the
application from the internal memory. Use this command if you
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wish to immediately open another document created in the same
application or to open a window for a new document. The Close
command functions in exactly the same way as the close box on
the window. If you have not saved the changes you have made in
the window, a dialog box appears asking if you wish to save the
changes. Clicking on Yes saves the changes and closes the window. Clicking on No closes the window without saving the
changes. If you click on Yes and the document has not been titled,
a Save dialog box appears.
• Save/Save As ... AB described in Chapter 2, the Save command
is used to save a new document onto your disk. The computer
keeps the contents of the document only in its internal memory
until the Save command is used, then it writes whatever is currently in the document onto disk. If power is interrupted to the
computer, all the internal memory is lost, as is all the work you
have done on the document since you last saved it. You should
use the Save command periodically while working on a document
at 15 to 20 minute intervals, or at convenient pause points, to
avoid doing much of the work again.
The Save dialog box only appears when you first save a new
document. Later saves on the same document simply update the
document to the current state of the work without calling up the
dialog box again. If you wish to save a version of the work as one
document and then revise the work and save it as a second document, use the Save AB ... command. Selecting Save As ... makes a
copy of the current work and brings up a dialog box, identical to
the Save dialog box, in which you can change the title and save
the copy as a new document. When the Save As ... dialog box
appears, it has the title of the current document in the title strip.
Either replace the title or add characters to it to change it slightly. If the title is not changed before the Save button is clicked, a
dialog box appears asking if you want to replace the current document with the new document of the same name.
The Save As ... command is often used when a document is to
be written to more than one disk. The Save command writes the
document to the disk currently being used in the computer. The
Save As ... command can be used to place a second copy on another disk, such as a backup disk. By using the buttons in the Save
As ... dialog box to eject the current disk, you can insert the backup disk, then click the Save button to write to that disk. If you
have a second disk drive, clicking the Drive button and the Save
button saves a copy to the disk in the second drive.
After the Save AB ... procedure is completed, the new copy of
the document replaces the original copy on the screen.
• Print. The results of using the Print command are described
in Chapter 8.
• Quit. This command closes your document and the application
and takes you back to the Finder desktop. If you have not saved
the latest changes to your document, a dialog box appears asking
if you wish to save the changes.
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Th e Edit menu
The Edit menu contains some editing commands that perform similar actions in most applications and on the desktop. Other com mands apply only to paint programs and may vary in different
paint applications. The ones described in this section are typical. If
you see other commands in the application you are using, consult
the application's manual.
• Undo. The Undo command revokes the last action taken in the
paint window. The start of another action, such as choosing
another tool or painting another image, cancels the effect of the
undo for the previous action. For example, if an area is accidentally eliminated or a fill spills beyond the area desired, immediately choosing the Undo command corrects the error. Choosing
the Undo command also undoes an undo action if you change
your mind.
• Cut/Copy/P~ste/Clea1·. These commands perform the same
actions in the paint window on objects selected with either the
selection rectangle or the lasso as they performed on the desktop
described in previous chapters. Cut removes selected areas from
the paint window and places them on the clipboard. Copy copies a
selected area without removing it f~om the paint window and
places the copy on the clipboard. Paste places a copy of the current contents of the clipboard into the paint window (remember
that the clipboard contains only the item last cut or copied). Clear
removes the selected area entirely without saving it to the clipboard. Using the Clear command does not affect items already on
the clipboard.
Using the Copy and Paste commands is an alternate method of
creating multiple copies of selected areas. Once copied to the clipboard, the selection can be pasted as many times as needed, until
it is replaced by performing another Cut or Copy command.
When a selection on the clipboard is pasted into a paint application window, the pasted image appears in the middle of the
screen as a selected image (the borders are pulsating). You will
find that it is often deposited on top of an image already on the
screen. When that occurs, immediately move the pointer inside
the border until the pointer becomes an arrow. Then drag the
selection to its intended spot away from other images on the
screen before it is deselected. If the copy is deselected while on
top of another painted area, it replaces anything underneath it. If
the copy is accidentally deselected, immediately choose the Undo
command.
• InvertJFill. Areas selected with either the lasso or the selection
rectangle are affected by these commands. Invert reverses the
video image of the selected area; the white areas become black,
and the black areas become white. All the area within the pulsating edges of the selection are affected. Selecting an area, choosing
a pattern, then choosing Fill covers the area of the selection with
the pattern.
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•Flip Horizontal/Flip Vertical/Rotate. These commands can
only be used with image areas selected with the selection rectangle. Flip Hbrizontal reverses the selected image left to right . Flip
Vertical reverses the image top to bottom. The reversed images
are exact min-or replicas of the original image. Rotate turns the
image 90 degrees in a counterclockwise direction. Choosing
Rotate again rotates the image another 90 degrees. Most applications allow free rotation to any degree, but often parts of the
image are slightly mangled and must be cleaned up in FatBits.
The Goodies menu (Paint menu in some applications)
This menu provides commands for special program features and
varies with different applications. In all applications, some of the
commands found in this menu are alternate commands to doubleclicking the tool icon in the tool palette, such as enlarging an area
for editing pixels (double-clicking the pencil icon), selecting an
alternate brush shape (double-clicking the brush icon) or modifying
a fill pattern (double-clicking on a pattern in the pattern palette).
Some applications have a ruler command which places a ruler at
the top and side of the paint window, and some can show evenlyspaced grid lines to aid in aligning parts of images. The most
important of these commands is one that shows a reduced view of
the entire printed page. On some applications this command may
be found in a menu called Windows.
• Show Page (Reduced View or Zoom Out in some applications).
This command shows the entire printing area of the document in
a reduced view. The features of Show Page are described in
Getting around in the paint area at the beginning of this chapter.
Some applications split the screen in the reduced view, showing the reduced full page on one half of the screen and a full-sized
view on the other half. You can continue working in the full-sized
view, u sing the paint tools or moving selected images, and the
results will be visible in the reduced view.
The Font menu
The Font menu lists the names of the typefaces that are installed
in the System file on your startup disk. A typeface is a particular
design of letters and symbols used in writing t ext. At least two
typefaces, Chicago and Geneva, are required for system operation
and are found in all font menus. Other typeface names are varieties of type designs. Additional typefaces can be added to a System
file, and those not required by the system can be removed. For this
reason the names and quantity of typefaces in this menu may vary
considerably depending on what is installed in the system on the
startup disk you are using.
A font is one style and size of a typeface. Most p aint applications
use the Geneva typeface in the 12 point type size as the default
font. A check may appear before its name in the font menu, indicating it to be the active typeface. Another font design can be selected
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by choosing its name in the menu. Refer to the description of the
text tool earlier in this chapter for applying the font design to the
text in the paint window.

T he FontSize menu
A selection in the FontSize menu changes the size of the typeface
as you see it in the paint window and when printed. The size is
always listed in points. A 12 point font size, for example, is the
height of the type from the bottom of the lowercase descenders (the
bottom of the letters p, y, or g) to the top of the lowercase ascenders
(the top of the letters 1, t, d, or h, and all capital letters). Since
there are 72 points in an inch, a 12 point font size occupies a maximum of 1/6 inch of vertical height.
The font sizes listed in the menu in outline style are those sizes
of fonts installed in your System file. Using one of the sizes shown
in that style produces better looking text on the screen and in
printing. Choosing other sizes in the menu that are not shown in
outline style produces text of the correct size, but the text will look
more ragged on the screen and in the printed copy.
As with the typeface, the font size may be changed at any time
before or while the text block in the paint window is still active. See
the description of the text tool earlier in this chapter for additional
details.
The Style menu
The Style menu in most applications lists the six standard styles
available for each typeface. The style names appear on the list in
the same style that will show on the screen and printed copy. The
Plain style is the default style. The other five styles are Bold, Italic,
Underline, Outline, and Shadow. All but the plain style can be used
in combination; for example, selecting both Italic and Outline in the
menu produces an outline italic style.
The Style menu usually includes text alignment commands also.
These align the text to the left of, centered on, or to the right of the
spot where the insertion point is first placed for a text block. If you
wish several lines of text to line up on the left side of the block, you
would select the Align Left command, which is also the default
selection. Choosing the Align Middle command centers all lines of
type within the block, and Align Right lines up the right ends of
each line.
Using Graphics With a Word Document

Once you have become familiar with the features of a basic painting program, you will be able to incorporate graphics with the text
in word processing documents. Graphics are transported from a
paint document to a word document by using the clipboard.
Graphics stored in the scrapbook desk accessory, described in
Appendix B, are also transferred to a word document using the clipboard. The procedure described below for moving graphics into
word documents applies to most word processing and graphic appli-
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cations. A few word processing programs may have special procedures for placing graphics. If you cannot place a graphic into your
word document, you may need to consult the manuals for the word
and graphic programs you are using.
To move a graphic into a word document, open the paint document that contains the graphic you wish to use . If you have a word
processing document open that is the destination for the graphic,
Quit (File menu) the text document first. Select the graphic with
the selection rectangle or lasso, then choose Copy from the Edit
menu. Quit the painting application and open the word document
that is the destination of the graphic. Place the insertion point at
the spot in the text where the graphic is to be located. Choose Paste
from the Edit menu. The graphic appears in a horizontal space
below the insertion point, moving any current text down to accommodate the vertical height of the graphic (Figure 6-24).
In most applications, a graphic occupies a horizontal band across
the page, slightly higher than the height of the graphic. You cannot
use the empty space on either side of the graphic to enter text. If
text is to be used within these spaces, it should be entered as part
of the graphic before the graphic is transported.
Figure 6-24
Graphics can be moued into
a word document.
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In most applications, a graphic occupies 6 horizontal band across the
page, slightly higher than the height of the graphic, and you will not be
able to use the empty space on either side of the grephic to enter text. If

Once the graphic has been placed in the word document, it may
be resized or moved. To resize a graphic, first click on it to select it.
An outline of a box should appear around the graphic with black
squares at a few locations around the perimeter. The squares are
called handles. Dragging a handle changes the size of the box and
the graphic within. Drag a corner handle to change both height and
width of the graphic. Drag one of the handles in the middle to
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change the height or width alone. The corner handles change the
size of the graphic and maintain the same proportion as the original size. In some applications, the Shift key must be held down
while dragging a corner handle to size the graphic proportionally.
Use the middle handles with caution because only one dimension
changes and the graphic can become distorted horizontally or vertically. To move a graphic horizontally, drag with the pointer on one
of the vertical borders of the graphic box away from any handles. In
some applications, the horizontal movement is limited to alignment
with the left side, center, or right side of the line length set by the
margin markers; the paragraph alignment commands are used to
move the selected graphic. To move a graphic vertically, you may
have to paste the graphic again; place the insertion point in the
text where the graphic is to be placed and use the Paste command.
To open up space between the text and the graphics, place the
insertion point in front of the text immediately following the graphic and use the Return key to open up additional space below the
graphic. Place the insertion point after the last line of text preceding the graphic and use the Return key to open up space above the
graphic. A graphic can be removed by selecting it and using the
Delete (backspace) key.

p

MACtivity 6-6: Creating a letterhead. Open the emblem
document that you completed in MACtivity 6-5. Select
the whole emblem with the selection rectangle or lasso. Choose
Copy from the edit menu. Quit (File menu) the paint document.
Open a new word document by double-clicking on the word
processing application. After its window opens, choose Paste from
the Edit menu. Select the graphic and drag the bottom right corner
handle toward the upper left to reduce the size of the image to
about half size.
~ paint

liil Screen display: Selecting and copying the paint image places

B it on the clipboard. The Paste command places a copy of the
image from the clipboard on the new document. Dragging the
corner handle reduces the size of the paint image proportionally.
Some applications require that the Shift key be depressed while
dragging the handle to make proportional changes in size.

When you reduce a graphic in a word processing document,
details in the paint image may appear to be lost when viewed on
the screen. Fill patterns and lettering may show as solid blacks
when reduced greatly in size. The reduced image prints with much
of its original detail intact if you use a laser printer; however, if a
dot-matrix printer is used, the printed result appears much like
you see it on the screen.
Some applications are limited, or have other procedures, on how
graphics may be placed, sized, or moved. You may need to consult
the manual for the word processing application you are using for
specifics about importing images from graphic applications.
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Graphics stored in the scrapbook use the same copy and paste
procedures as described above. If a series of graphics is to be used
in a text document, it is more efficient to store each graphic in the
scrapbook first, then move each one into the word document as
needed. You can place graphics stored in the scrapbook without
quitting your word document. Using the scrapbook is described in
AppendixB.
Quitting the Application

When you are ready to quit working on a document, save it, then
choose Quit from the File menu or press Command and the letter Q
key together. In a few seconds the desktop appears on the screen.
Backing Up Documents

Occasionally something happens to a disk that can make the
information on it unreadable. Fortunately, if reasonable care is
taken with disks, this occurrence is rare. However, if you value the
work you create with the computer, you will want to keep an extra
copy of valued documents on a separate disk.
Backup copies may be made before quitting a document by
saving the document in the regular manner first, then choosing the
Save As ... command from the File menu and saving a separate copy
on another disk. To do this, click the Eject button in the Save As ...
dialog box to eject the disk that contains the first copy of the
document, then insert your separate backup disk. Click the Save
button and a copy of the document is made on the backup disk. You
do not need to change the name of the document for the second
copy as you would if you were saving a second copy to the same
folder on the same disk. Methods used to copy documents are
described in Appendix A.
Shut Down
If you are stopping work at this point, use the shut down procedures described in previous chapters.
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Chapter 6 Self Test
Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.
A. Select one of the four choices that completes the sentence correctly.
1. Most of the paint tools can be contrained to move horizontally or
vertically if you drag the tool while pressing the:
a. Command key
b . Option key
c. Shift key
d. appropriate arrow key
2. To change the thickness of a line in a paint program, you would
make a selection on the line thickness palette:
a. before the line is painted
b. immediately after the line is painted, but before doing any
other painting
c. after the line is selected with the lasso
d. after the line is selected with the sel.e ction rectangle
3. The typeface, style, and size of type used in the paint window:
a. must be chosen before text is entered
b. can be changed while the entered text is still active
c. can be changed by selecting the text with the selection
rectangle
d. can be changed after highlighting with the I-beam
4. The pencil tool can paint a black on white or white on black line
depending upon:
a. what fill pattern is active
b. whether the Shift key is depressed or not
c. the color of the pixel the pencil is on at the start of the drag
d. whether the view is FatBits or normal
5. After using the Paste command for a cut or copied painted
image, the pasted image appears on the screen:
a. centered at a spot you selected by clicking the mouse button
b . in the center of the paint window
c. in the center of the overall painting area
d. with the upper left corner of the image where you set an
insertion point
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B . Select the statement on the right that defines each word at the
left.
1. - - bit-mapped
2. - - grabber

3. - - palettes
4. - - lasso

5. - - selection
rectange
6. - - pixels
7. _

fill

8. - - Fat Bits
9. - - paint bucket

a.
b.
c.
d.
e.
f.
g.
h.

an enlarged view of a section of an image
a pattern used inside closed shapes
closes the selection area tightly around irregular shapes
used to fill closed outlines with pattern
used if you want to rotate a painted image
contains the painting tools and fill patterns
the black and white dots that define the image
can be used to change individual black dots to white and
white dots to black
i. identifies how the computer keeps t rack of pixels in a paint
application
J. can be used to move the painting area outside the window
into view

10. - - pencil

C. From the list of words at the left, choose one to fill in each
blank in the statements that follow.

freehand
paint tools
Option
Shift
fill patterns
rectange
grabber
space bar
arrow keys
polygon
Command
Tab

1. Palettes in paint applications offer choices of _ _ __ _ __

and _ _ _ __ _ __
2. As an alternate to using the scroll bars, you can move parts of

the painting area that are outside the window into view with
the _ _ _ _ _ __
3. You can outline irregular shape s that will automatically fill
with the active pattern by using the _ _ _ _ __ _ _ and
_ _ _ _ _ _ _ shape tools.
4. A copy of a painted image can be made by first selecting it,
t hen moving it while pressing the

key.

5. When dragging the eraser, it can be constrained to vertical or
horizontal movements by pressing t he

key.
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D . Mark the following with Tor F for true or false statements.
1. The paint window displays only a portion of the total area that

can be used for painting images.
2. To edit text in a paint program, first select it by dragging over it
with the I-beam.
3. When dragging to make a rectange with the rectangle shape
tool, you must always start at the upper left corner and drag
diagonally to the lower right corner.
4. The Undo command cancels the last painting action taken if the
command is chosen before any other painting is done.
5. Some menu commands can be chosen if a painted object has
been selected with the selection rectangle, but not if selected
with the lasso.
6. Only the pencil and eraser tools can be used in an enlarged
view such as FatBits.
7. The paint brush can be used to erase black pixels by making
the white fill pattern active.
8. The directory in the Open command dialog box lists only titles
that can be opened by the paint application you a.r e u sing.
9. To rotate an object, you first select it with the lasso, then choose
Rotate from the menu.
10. Pressing the Shift key while moving an object leaves a copy
behind.

GraphicsDraw Applications

Objectives
After completing this chapter, you will be able to:
1. Use a draw application to produce a graphic document.
2. Modify the drawing with tools provided by the application.
3. Use text in the drawing.
4. Save the document and quit the application.
Important te r ms
These terms are defined in this chapter and in the Glossary.
constrain
grabber
grid

grid snap
group
handles

layering
tool palette
text block

Differences Between Paint and Draw Applications
Some of the characteristics of bit-mapped paint applications and
object-oriented draw applications are described at the beginning of
Chapter 6. Read that section now, if you have not already done so,
for a comparison between the two types of graphic programs.
The main advantage draw programs have over paint programs is
that object-orien~ed programs can take advantage of the mediumto high-resolution printers. Resolution is measured in the number
of black dots per inch (dpi) that make up a letter of text or a line in
a drawing. If you look closely at a curve or diagonal segment of a
letter or line on your screen, it appears ragged instead of crisp and
smooth. This stair-step appearance (called jaggies) is because the
screen shows the dots (pixels) at the relatively low resolution of 72
dpi. Medium-resolution printers, such as the LaserWriter, print at
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300 dpi-over 4 times the resolution that you see on the screen.
High-resolution printers can print up to 2540 dpi, about 35 times
the screen resolution. Higher resolution means that more, smaller
dots can be used to form lines and letters, thus making their edges
smoother (Figure 7-1).
Figure 7-1
Object-orumted programs
make use of high-resolution
p rinters to produce
smoother drawings.

BIT-MAPPED

OBJECT-OR IENTED

In draw programs, information about an object you draw on the
screen is stored as a routine, or command, that describes its
appearance. All the details of the object are described, such as line
thickness, fill pattern, location, or size. This description is much
like a written command-the printer executes the command at the
resolution it is capable of printing. Unlike images made in bitmapped paint programs which print much as you see them on the
screen, images in object-oriented draw programs are resolution
independent-the higher the resolution of the printer, the sharper
the image will be.
Using a Draw Application
Some draw programs, such as MacDraw and MacDraft, use graphic
commands built into the Macintosh system, called QuickDraw.
Other draw programs, such as Illustrator, FreeHand, and Cricket
Draw, use an additional page description language, called
PostScript, that expands the features available for drawing images,
such as gradated fills, precise rotations, and exact scaling.
Some programs, such as SuperPaint and Canvas, combine paint
and draw capabilities in the same window but in separate layers.
For these applications, the procedures described in this chapter
apply to their draw layer.
The number and kind of features vary greatly between different
draw applications. Those described in this chapter are available in
most programs. However, the program you are using may have
many more features than those described. Once you become familiar with the basic drawing tools, you are encouraged to consult the
user's manual for the application you are using and explore its
additional drawing features.
Open ing the application
To open a draw application, open the application disk window, if not
already open, by double-clicking on the disk icon on the desktop.
Double-click on the application icon, or select it and choose Open
from the File menu. In a few seconds, the draw window appears.

131

Chapter 7 Graphics-Draw Applications

Programs that combine paint and draw layers usually open with
the paint layer active. To switch to the draw layer, look for an icon
that toggles between the two layers. In SuperPaint, for example,
the icon is a paint brush image overlapping a drafting compass.
Clicking on the icon brings the compass to the front, indicating that
the draw layer is active.
Practicing with the draw tools and commands
The series of MACtivities in this chapter will guide you through the
process of drawing a personal bookplate. Prior to each MACtivity is
a description of the tools that will be used in that activity. Before
starting on the bookplate document, practice with each of the tools
as you read about them. Open the draw application as just
described and use the new draw window to try out each of the tools
or procedures.
The draw window
The draw window is the area you use to create your images (Figure
7-2). Like other windows, it has a title bar and a close box. The window also has scroll bars, a size box, and a zoom box. On the left side
of the draw window is a rectilinear strip full of icons, called a tool
palette, representing drawing, text, and selection tools. There is a
menu bar across the top with some titles that may be new to you.

Figure 7-2

The draw window
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The vertical strip at the left
side of the window has icons for all the tools available for drawing
(Figure 7-3). It also has a selection arrow and a tool to add text to
the drawings . Clicking on a tool icon activates that tool, then the
mouse or keyboard is used to create the image or text.
THE DRAWING TOOL PALETTE
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MENU BAR Three of the menu names will be familiar: the
Apple, File, and Edit menus. Other menus, such as Font, Layout,
Arrange, Fill, Lines, and Pen, may vary depending on which draw
program you are using, but all have commands that apply specifically to creating draw graphics.
Figure 7-3
The drawing tool palette
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Some draw programs have a fill palette that appears in the window when the application is opened. The fill palette offers a selection of textures and tones that can be selected to fill closed shapes
or to use in lines. In other applications, the fill selections are stored
in a Fill or Pattern menu. In most applications, the fill palette (if
any) and the tool palette can be moved to a different location in the
window by dragging with the pointer on a bar, resembling a title
bar, at one end of the palette. The palettes can be removed from the
window entirely by clicking the close box in the bar- a menu
command or a key combination returns the palettes to the window.
The drawing window that first appears when the application is
opened may have a grid pattern in the working area. The grid,
called ruler lines in some applications, is made up of evenly spaced
vertical and horizontal dotted lines. This pattern can be used in the
draw window as a guide for sizing and aligning objects as they are
being created; the grid lines will not appear on printed copies of
your drawing. The grid can be removed from the drawing area with
a menu command, such as Hide Ruler Lines from a Layout menu.
Most drawing programs have an option to show grid lines and
rulers as an aid to drawing. These can usually be customized with a
menu command, such as Custom Rulers from a Layout menu, that
brings up a dialog box with choices of spacing intervals and dimensional units, such as inches or metric measures. Picas and points
may be offered as a measurement choice in some applications.
Getting around in the draw area
The drawing window shows only a portion of the total usable area
for drawing; the remainder can be accessed by scrolling areas outside the viewing area into view with the scroll bars. Some applica-
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tions also use a grabber, a scrolling tool in the shape of a hand. By
clicking on the hand icon in the tool palette, the pointer becomes a
hand shape when moved into the drawing window. By dragging the
grabber (or hand) with the mouse, hidden parts of the drawing field
can be moved into the viewing area. In some programs, pressing
the space baT changes the pointer for any drawing tool cunently
selected (except the text tool) into the grabber.
All drawing programs offer a reduced view, diminishing the size
of the drawing so that more of the drawing field can be seen in the
window (Figure 7-4). The total area that can be used for drawing is
about 8 by 10 1/2 inches, the size that can be printed on a standard
8 112- by 11-inch paper. In many programs, the drawing field can be
much larger. Drawings that extend beyond the single page format
are printed on multiple pages which can be assembled. For
example, MacDraw has options that can increase the total drawing
field so that it would require up to 65 pages to print the maximum
size drawing area of 48 by 96 inches. The drawing field can be
reduced to one-half and one-fourth the actual size so that parts of
two or four pages can be seen on the screen at a time. Other programs offer even greater reductions, although most do not have a
maximum size drawing area that large. Many applications enlarge
the drawing in the viewing area as well as reduce it. Making fine
adjustments in details of the drawing is much easier in an enlarged
view. Some applications can increase the size of the drawing in
increments to as much as 16 times the actual size.
Figure 7-4
Drawing applications offer
a reduced view.
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Draw tools
Some draw tools, such as the perpendicular line tool and the
straight line tool, are line-only tools. You draw lines with a mouse
movement as you would draw lines with a pencil and ruler on a
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piece of paper. Two tools, the freehand shape tool and the polygon
tool, are line tools that can also make closed shapes filled with a
pattern. Other tools, the rectangle, rounded rectangle, oval, and
arc, are shape drawing tools; one straight line move of the pointer
with the mouse produces the shape indicated by the tool icon. The
rectangle, rounded rectangle, oval, and arc tools, in combination
with the Shift key, also make true squares, squares with rounded
corners, circles, and quarter circles. Other icons on the tool palette
include a text tool for adding text to the drawing and an arrow tool
for malting selections in the drawing area. Some applications have
additional tools in their tool palette that draw other shapes or perform other functions.
This section describes the shape drawing tools, the procedures
used to modify the shape, once drawn, and the procedures used to
move the shapes around the drawing area. Other drawing tools
are described later in the chapter.
To use shape tools, you first select the tool by clicking on its icon
to highlight it. When the pointer is moved into the drawing window, it changes into a cross hair.
Some applications revert to the selection arrow each time an
action is completed with a drawing tool; in these applications you
have to select a drawing tool again before drawing the next shape.

D

0
0

THE RECTANGLE , ROUNDED RECTANGLE, AND OVA L SHA PE
TOO LS All three of these tools draw the shape indicated by their

icon with a single drag of the mouse. The rectangle tool is used for
drawing rectangles with square corners; the rounded rectangle
tool, for rectangles with rounded corners; and the oval tool, for
ellipses. After selecting a tool, position the cross hair at the spot in
the drawing area where you wish to place one corner of the shape.
Drag diagonally toward the opposite corner. The drag can be in any
direction- you will see the shape forming as you drag. Release the
mouse button when the shape is approximately the size and proportion you wish to have. Don't worry if the shape is not exactly to
your liking; the final dimensions can be easily changed as
described in Selecting and modifying objects later in this chapter.
Pressing the Shift key while drawing with one of the tools constrains the shapes. Constraining limits a tool's action. Pressing
the Shift key and drawing with the rectangle tool produces a
square; the rounded rectangle tool produces a square with rounded
corners; the oval tool produces a circle. Some applications may
have a separate circle tool also.
In some applications, clicking on a letter next to the icon in the
tool palette or double-clicking the icon makes the tool draw the
shapes from the center outward. In other applications, pressing
both the Shift and Option keys while drawing the shape makes the
tool draw from the center outward.
TH E PO LY GON TOO L
The polygon tool is u sed for making
straight-sided shapes other than the regular shape of the rectangle
or square. The outline of the polygon shape is drawn with mouse
movements and clicks of the mouse button to establish corner
points.
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With the polygon tool selected, click the mouse button with the
pointer in the drawing area to establish a starting point. Move the
mouse toward the second corner of the shape. Dragging the mouse
is unnecessary when iµoving between corners-a line stretches
behind the pointer like a rubber band until the next cFck of the
mouse buttop. Clicking glues the line to the drawing area at each
corner point around the ·~p.ape. A double-click ends the outline and
frees the line from the pointer.
·
Shapes made with the polygon tool can be completely closed or
left open. If a fill is chosen for a polygon, it fills the shape whether
open or closed. If left as an open shape, a straight·edge is automatically established between the beginning point and the ending point
of the outline; this edge i's not a ·line but is the border of the fill for
the shape.
The polygon can be modified in additional ways with commands
from the Edit menu. The Smooth commanq rounds all the corners
and sides of the polygon. The Unsmooth command changes it back
to a figure with straight segments.
1

Selecting and modifying objects
After an image is drawn with one of the tools , it automatically
becomes selected. Small black boxes appear at the corners of the
rectangle or, for the oval and polygon shapes, at the corners of what
would be an enclosing rectangle. Some applications have additional
boxes at the center of each side of the rectangle. These small boxes,
calleq handles, indicate that the object is selected (Figure 7-5) and
are used to modify the shape.
•Figure 7-5
Handles indicate that an
object has been selected.
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A filled shape can be selected at any time with the arrow selection tool by either clicking on a line or inside the shape; a shape can
be deselected by clicking anywhere outside the line or shape. One
or more objects can be selected in one operation by dr awing a selection rectangle around them with the selection arrow tool; this is the
same technique as the one used on the desktop to select a group of
adjacent icons, described in Chapter 3. Drag the pointer diagonally
from one corner of a rectangle to fully enclose all parts of the object
or objects to be selected. To select a line or shapes that are not filled
with a pattern, click with the pointer on the line or the outline of
the shape. Note that black and white are treated as fill patterns-a
shape with a white fill may look the same as a shape with no fill if
both are over an empty area on the screen, but the filled shape is
opaque and the unfilled shape is transparent. More information
about fills can be found in the section of this chapter preceding
MACtivity 7-2.
A handle is the place to position the tip of. the arrow pointer
when you wish to make certain modifications to the image. To
change the height or width of a shape, place the pointer on a handle at the center of one side and drag. To increase or decrease the
height of the shape, drag the handle at the center of the top or bottom side up or down. To increase or decrease the width, drag the
handle at the center of the left or right side, left or right. Dragging
one of the corner handles in a diagonal direction changes both
height and width with one drag. To change the size of the shape
without changing its proportion, put the pointer on a corner handle,
press and hold the mouse button, hold down the Shift key, and drag
in a diagonal direction.
In some applications, such as SuperPaint, only corner handles
appear on selected shapes. Dragging a handle changes both size
and proportion. Dragging and key combinations are used to constrain the changes in specific ways. For example, dragging a handle
with the Shift key depressed changes only the height or width,
depending on which direction the pointer is moved first. Dragging a
handle with the Shift and Command keys depressed changes the
size only and maintains the same proportion.
After the shape made with the polygon tool is completed, it
appears with handles at each corner of an invisible rectangle that
encloses the whole shape of the polygon. These handles can be used
to resize or stretch the polygon just as the handles are used with
the other shape tools. However, the polygon can be modified in
additional ways by selecting it and then choosing the Reshape
Polygon command from the Edit menu. The Reshape Polygon command places handles at each change in the line direction in the
drawing (Figure 7-6). Any handle can be dragged with the pointer
to modify the shape of the polygon.
Moving shapes
To move an object to another location in the drawing area, click on
it to select it. It is selected if the handles are visible. If the shape is
filled, position the pointer inside the object and drag. Do not
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Figure 7-6
Handles are placed at each
change in line direction
when the Reshape Polygon
command is used.
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drag with the pointer on one of the handles. If the shape is not
filled with a pattern or black or white, you need to place the pointer
on the outline of the shape between the handles to move it.
To remove a shape entirely, select it and press the Delete
(backspace) key. Selected objects can be copied or cut to the clipboard and pasted back into the current document or other documents (use the Cut, Copy, and Paste commands in the Edit menu)
just as you did with text in Chapter 4.
If the outlines of the shapes seem to jump in short hops as you
are drawing, resizing, or moving a shape, it means a grid snap
feature is turned on. Grid snap causes the pointer to jump from one
ruler interval to the next so that objects drawn with most of the
tools, or objects being moved in th e drawing area, align with an
invisible vertical and horizontal grid. The grid interval is usually
one-eighth of an inch when the rulers are in inches. Grid snap is
useful when you wish to draw an object to an exact measurement of
a ruler interval, or to precisely align edges when moving objects.
Grid snap can be turned off or on with a menu command, usually
Turn Grid Off or Grid Snap Off from the Layout menu. To size or
position objects between grid intervals, turn off the grid snap feature.
Mal<ing a Drawing-A Personal Bookplate

The objective of the series of MACtivities in this chapter is to use
your draw application to make a personal bookplate. Bookplates
are traditionally adhered to the inside cover of books in your personal collection to identify their ownership. Bookplates are often
highly prized by collectors, whether discovered alone or in an old
book. They may be valued because the former owner of the book
was someone of note or because the bookplate was created by a
prominent artist.
In the first activity, you will construct the main module, a shape
unit used in the decorative portion of the bookplate. In activities
later in the .chapter, you will duplicate and assemble the module,
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add fill to the shapes, construct th e background, and place your
name and other text in the design.

;pl MACtivity 7-1: Basic book shape module for the bookliliii;!.. plate. Choose New from the File menu to open a new window.
The new window will appear in front of the practice window. Follow
the steps in drawing the book module in the views illustrated
(Figure 7-7).
Figure 7-7
T hese shapes will be
produced to develop a
bookplate.
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1. Select the rectangle tool. At one side of the window, draw a rect-

angle about 1/4 inch wide and 1 1/2 inches high. Select the polygon tool and draw a polygon that looks similar to the one in View
A Adjust the long side of the polygon to match the height of the
rectangle. If a shape fills with a pattern after you draw it, choose
the white or no fill from the Fill menu.
2. Select the polygon and move it so its long side is adjacent to the
side of the rectangle as in View B. This is the basic shape for the
book module.
3. With the rectangle tool, draw a small rectangle that is slightly
nan-ower than the spine of the book module as in View C. With
the oval tool, depress the Shift key and draw a small circle that
has a smaller diameter than the spine of the book module.
4. Drag the small rectangle and circle to fit on the spine of the book
module as shown in View D. Center them between the vertical
sides of the spine. If the objects jump when moved, choose Turn
Grid Off in the Layout menu (Options menu in some applications).

1iiJ Screen display: At this stage your image should look similar

B

to the one in View D (Figm·e 7-7).

Use the handles for adjusting sizes and proportions if the shapes
you created did not come out as you expected. Drawing the shapes
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with no fill makes them easier to assemble. The module will receive
a variety of fills in the next MACtivity.
You should save your document at this point and at r egular
intervals throughout the next MACtivities. Choose Save from the
File menu. Enter a title, such as Bookplate, in the title box of the
Save dialog box and click on Save. If you are saving to another
disk, click the Eject button and insert the disk that will be used to
store the document. If you are saving to a disk in a second drive,
click the Drive button to open that disk's directory. When the directory of the new disk appears in the Save dialog box, click the Save
button.

Adding fill and duplicating objects for the bookplate
The next step in developing the bookplate is to add the fill patterns
to the module, group the parts of the module together, duplicate it,
and assemble all the copies. You should try the grouping and duplicating commands with shapes you have created in your practice
window before continuing with the bookplate.
Bring your practice window to the front by choosing its title (or
choose Untitled if it has not been saved) from the Windows menu.
If your application does not have a Windows menu, you must
reduce the size of the window in front with the size box until you
can see a portion of the window behind. Refer to Sizing windows in
Chapter 3 if you have forgotten how. Click on an exposed portion of
the back window to bring it to the front. If you had closed your original practice window, open a new window for practice by choosing
New from the File menu. Draw several shapes in the practice window with the shape tools, if needed, to try out the commands
described.
USING MENU COMMANDS FOR FILL AND LINE TH ICKNESS

In

most applications, the default settings for shape tools result in
shapes with an opaque white fill and a black outline thickness of
one point (one pixel). The fill, outline width, and the pattern of the
outline can all be changed quickly in selected shapes by choosing
appropriate menu commands. A Fill menu or palette offers a selection of patterns, including black, white, and no fill. Clicking on one
of the small pattern boxes places that fill in the selected shape. The
no fill box is for shapes that are to be outlines only-if you move
outline shapes over other shapes, they do not block out the shapes
underneath.
The thickness of the outline is chosen from the Lines menu.
Several choices of line thickness are available in the menu. The
dashed line indicates no line; if chosen, the shape does not have an
outline but can be filled with a pattern. The line can be white or
made up of a pattern chosen from the Pen menu.
Applications vary in the way fills and line thicknesses are chosen. For example, the draw layer of SuperPaint has a line thickness palette located in the tool palette for selecting a line width;
the fill and line pattern are selected from a separate fill palette
that occupies part of the drawing window. By clicking on one side
or the other of an active fill box located at the left end of the palette
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and then clicking on a pattern selection, you can choose the fill pattern for either the inside of the shape or for the outline around the
shape (Figure 7-8).
Figure 7-8
Use the fill palette to select
a line thickness and fill
pattern.

ACTIVE LINE PATTERN
CLICK FOR ADDITIONAL FILLS OR LINE PATTERNS

SUPERPAIN T FILL PAL ETTE

If these methods of changing fills or line thicknesses do not
apply in the application you are using, consult the manual for your
application.
GRO UPING OBJ ECT S
Group is a command that bonds two or
more selected objects into a single object. Multiple objects are first
selected by holding down the Shift key while clicking on all the
objects to be grouped. Also, the pointer can be used to draw a selection rectangle around the group of objects to select them. The
Group command from the Arrange (or Draw) menu is then chosen
to group the selected objects. Once several objects are grouped, all
actions taken with them apply to the group as if they were one
object. One click with the selection arrow selects the whole group. A
menu command affects all objects in the group. Grouping follows a
hierarchical pattern-a group can be combined with other groups
or objects, grouped again into one unit, and then grouped again
with additional objects or other groups (Figure 7-9).
Figure 7-9
Grouping combines selected
objects into one object.

•

•
SELECTED OBJECTS

AFTER GROUPING

What can be grouped can also be ungrouped. Select the group,
then choose Ungroup from the Arrange (or Draw) menu. All the
individual objects in the group are independent again, and all are
selected individually immediately after the command is used. If
objects were grouped in stages, ungrouping follows the reverse of
the sequential order used when the objects were originally grouped.
You may have to ungroup several times to select an individual element that has been part of several grouping actions.
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DUPLICATING OBJECTS
Selected objects or groups can be
quickly duplicated by choosing the Duplicate command from the
Edit menu. Multiple selections made with the selection rectangle or
Shift key are duplicated with the command also. Immediately after
the command is chosen, a copy appears overlapping the original.
When the copy appears, it is automatically selected. The copy can
be duplicated again by choosing the Duplicate command once
again. If you move the first copy while it is still selected to a new
location and choose the Duplicate command again, the next copy
appears the same distance and direction from the first copy as the
first copy is from the original (Figure 7-10).
Figure 7-10
Objects can be duplicated
by choosing the Duplicate
command.

D[]DD DDDDD
SELECTED
OBJECT

AFTER
DUPLICATE
COMMAND

COPY PLACED
IN POSITION

AFTER THREE ADD ITIONAL DUPLICATE
COMMANDS

If you duplicate objects many times, it is much faster to use the
keyboard combination for the Duplicate command rather than
choosing the command from the menu for each copy. In most applications, press .the Command key and the letter key D. If this does
not work in your application, look for the command in a menu and
note the key combination listed to the right of the command word.
An alternate way to duplicate an object is to use the Copy and
Paste commands. After the Copy command places a copy of the
object on the clipboard, any number of copies can be pasted back
into the drawing window, until you use the Cut or Copy command
again.
The next MACtivity continues the drawing of the bookplate
started in MACtivity 7-1. If the document is still open, bring it to
the front by choosing its title from the Windows menu.

p

MACtivity 7-2: Adding fill and duplicating the bookplate
Bring the bookplate document to the front if it is still
open. If it is closed, choose Open from the File menu, select the document title in the Open dialog box directory, and click on the Open
button. Follow the steps for filling and duplicating the module in
the views illustrated (Figure 7-11 and Figure 7-12).
1. Select the polygon shape in the drawing area that outlines the
book cover and click on the black square in the Fill menu. The
result should appear as in View E. With the polygon selected,
choose the white square in the Pen menu. This last choice does
not show in the drawing window until the final assembly.
2. Select the larger rectangle, the book spine, and choose a medium
tone from the Fill menu. While the rectangle is still selected,
choose the second solid line from the Lines menu, then choose
the solid black square in the Pen menu. The result should look
like View F.
~ module.
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Figure 7-11
Use the Fill menu to add
fill to the shapes.
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Use the Duplicate
command to ma Im copi.es of
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3. Select the small rectangle and the circle separately and choose a
pattern for their fill from the Fill menu. While each is selected,
choose no line (the dashed line) from the Lines menu. Compare
the results with Views G and H.
4. Draw a selection rectangle around the whole module to select all
of its parts. Choose Group from the Arrange menu (View I).
5. With the module selected, choose Duplicate from the Edit menu.
After the command, the drawing should look like View J .
6. Move the selected copy to the right of the original copy so the
bottoms align and there is a n arrow space between the original
and copy, as shown in View K. Be careful to avoid deselecting
the image after it is positioned.
7. Choose the Duplicate command five more times, or hold down
the Command key and press the letter key D five times. The
modules should line up as in View L.
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8. At this stage, if you wish, select each of the small rectangles and
circles on the book spines and choose different fill patterns for
each. A sample of this variation in pattern is shown later in this
chapter (Figure 7-16).
9. Draw a large selection rectangle that surrounds the whole row
of modules. When you are sure everything is selected, choose
Group from the Arrange menu.

lii1 Screen display: After the first copy is positioned and before

B it is deselected, choosing the Duplicate command places the
third and subsequent copies at the same intervals as you set up for
the first copy. Your image should look much like View L (Figure 712) at this stage. Save your changes.
Adding background and text to the bookplate
The final steps in completing the bookplate are to draw and fill a
background for the decorative modules, to add your name and other
text, and to assemble the parts. Again, bring the practice document
to the front to try out layering and text controls before proceeding
with your bookplate document.
CHANGING THE LAYERING ORDER OF OBJECTS
Shapes can
be stacked over other shapes, called layering. While shapes can
overlap or completely cover other shapes, each shape will retain its
entity as a separate unit. Although a filled shape blocks out any
other shape it covers, it does not change the shape underneath. It is
as if each shape were drawn on a separate piece of transparent
film; the pieces of film can be assembled in any order or stacked
with the objects in any position relative to one another. The last
drawn shape appears on top of or in front of the other shapes it
overlaps; however, the layering order of the objects can be changed
easily with the Bring to Front or Send to Back commands, usually
found in a menu titled Arrange or Draw. For example, an object
that is behind other objects in the drawing can be selected, if any
part of it shows. Then choosing the Bring to Front command places
the object in front of all other objects (Figure 7-13). Objects anywhere in the layering order can be moved ahead or behind all other
objects with these commands.
ENTERING TEXT Since an object-oriented draw program takes
full advantage of the higher resolution available in printers, such
as the LaserWriter and LQ ImageWriter, text and lines in drawing
documents look much crisper when printed on these or similar
machines than they appear on the screen.
Text in draw programs is entered and can be edited much like
the text on the desktop or in word processing programs. After you
select the text tool, the pbinter becomes an I-beam when it is in the
drawing area. Clicking the mouse button sets an insertion point.
The text is entered by typing. In most draw programs you may also
drag the insertion point to define the width of a text field, or text
block. The text block may be any width that you define as you drag
but is only one line deep. As you enter text, the width you defined is
the maximum length of the lines you enter; the text automatically
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Fig ure 7-13
The layering order of objects
can be changed.
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wraps to the next line, and the depth of the text block increases
according to the number of lines. If you cannot drag a text field in
your application, then you must use the Return key to start a new
line.
The text tool must be selected when you do any editing. Some
programs allow you to edit text more freely than others. All programs allow you to drag the I-beam to select a word or group of
words to be replaced or deleted or to be copied or cut onto the clipboard. The insertion point can be placed by clicking the I-beam
anywhere in the text area. Some programs allow you to change the
typeface, style, or size of the text of individual words by dragging
over them with the I-beam to highlight them and then making a
choice from the Font and Format menus. Other programs do not
allow the typeface, style, or font size of the text to be mixed within
the same text block; in other words, choosing a menu command to
change any of these properties applies the choice to the whole text
block. In these programs, to use a variation of typefaces, styles, or
font sizes, a new text block must be started for each one.

p

MACtivity 7-3: Completing the bookplate. Bring you r
bookplate document window to the front or open the document
if it is closed. Follow the steps for completing the background and
adding text as illustrated (Figures 7-14 to 7-20).
1. Select the rounded rectangle tool. With the pointer just to the
left of the row of books and down about one-fourth of the vertical height of the row, drag out a rectangle about 2 1/2 inches
high and wide enough to extend past the right side of the row
(Figure 7-14). Don't be alarmed that it covers part of t he
books-that will be changed later. Choose a light tone from the
Fill menu and the thinnest solid line from the Lines menu.

~
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Figure 7-14
Using the rounded
rectangle tool, drag out a
rectangle.
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2. Draw another rounded rectangle slightly smaller than the first
and center it on top of the first rectangle (Figure 7-15). Choose a
medium dark tone from the Fill menu and no line (the dashed
line) from the Lines menu.
Figure 7-15
Draw another rectangle
slightly smaller than the
first one.

3. Select the row of books by clicking inside the part that is above
the new shapes. Choose Bring to Front from the Arrange menu
(Figure 7-16).
Figure 7-16
Bring the books to the
foreground.

4. Draw two more rounded rectangles that fit in the space below
the books. Use the illustration as a guide (Figure 7-17). Choose
the black fill for both rectangles. Choose the two point line width
for each new rectangle, the second of the solid lines in the Lines
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menu. For the border line patterns, choose white for the larger
r ectangle and light grey for the smaller rectangle from the Pen
m enu as shown.
Figure 7-17
Draw two more rectangles
and add fill.

5. Select the t ext tool. Click an insertion point in an unused space
below the image of the bookplate. Press the Caps Lock key and
enter FROM THE LIBRARY OF. Try different typefaces from
the Font menu. In some applications you may have to drag over
the words to highlight them first. Select a font to use and choose
Bold, then Outline, from the Style menu. Choose 14 point type
size from the Font menu (Figure 7-18).
Figure 7-18
Enter text and choose a fon t
a nd point size.
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6. Select the text block and move it into the space above the smaller of the two black rectangles. Center the block between the left
and right margins of the larger rectangle as shown (Figure 719).
Figure 7-19
Moue the text into the
rectangle and then enter
your n ame.

FROM THE LIBRARY OF
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7. Set another insertion point in an empty space below the emblem
and type your name in upper and lowercase letters. Choose
Bold, Outline, and 18 point size from the Style and Font menus.
You may have to choose 14 point if you have a long name. The
result should look similar to that in the illustration (Figure 719).
8. Select your name text block and move it inside the smaller black
rectangle. Center it in the space as shown (Figure 7-20).
Figure 7-20
Moue your name into the
smaller rectangle.

lii1 Screen display: This completes the bookplate design. The
B result on your screen should be similar to that in the illustration (Figure 7-20). If you print the bookplate on a laser printer or
other medium- or high-resolution printer, the printed copy looks
like that shown in Figure 7-21.
Figure 7-21
If the bookplate is printed
on a laser printer, the
drawing appears much
smoother.

FROM THE LIBRARY 0

Jane Marie Doe

If you would like to print copies, you can print several on each
page. First, select the whole bookplate; either drag a large selection
rectangle around the whole bookplate (Figure 7-22) or choose Select
All from the Edit menu. Then choose Group from the Arrange menu
and Duplicate from the Edit menu. Repeat the Duplicate command
for as many copies as you wish to print on one page. Arrange them
on the page so they do not overlap. Moving is much more simplified
if you use the Reduce command in the Layout menu so you can see
more of the page at a time. In some applications, such as
SuperPaint, the command for reducing the size is called Reduce
View, found in the Windows menu. You should be able to fit at least
six plates on a page. Refer to Chapter 8 for printing procedures.
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Figure 7-22
Select the bookplate and
then duplicate it.

----
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Other Draw Tools
Although these tools were not used for drawing the bookplate, practice using the tools so that you are familiar with how they work.
Save and close the bookplate document. If your practice document
window is closed, open it or open a new document.

+

Straight line tools
The perpendicular line tool and the line tool are line-only tools . You
can enclose areas with line tools but you cannot fill them. After
selecting one of these tools from the tool palette, the pointer
becomes a cross hair when moved into the drawing area.
The perpendicular line tool draws only horizontal or vertical
lines, but does so without being constrained by pressing the Shift
key. The direction of the line, vertical or horizontal, depends on the
direction the pointer is moved at the start of the drag with the
mouse. Some applications also draw a 45-degree line if the pointer
is dragged diagonally.
The line tool draws a straight line by dragging the pointer in any
direction. The line can be constrained to horizontal, vertical, or 45
degrees by pressing the Shift key as you drag. For all other line
angles, the beginning of the line is set in the drawing area at the
location of the pointer when the drag is started; the other end of the
line follows the pointer in any direction until the mouse button is
released. Unlike the polygon tool, with the line tool the mouse button must be kept depressed while drawing the whole length of the
line.
The thickness of the line for both tools is chosen from the Lines
menu, or the tool palette in some applications. The lines appear in
the pattern that is active in the Pen menu or, in some applications,
in an active line fill box in the fill palette.
Th e freehand too l
The freehand tool is a shape tool that, like the polygon tool, can be
used for line-only drawing. The freehand tool draws curved freehand lines that replicate the movement of the mouse as the pointer
is dragged in the drawing window. When the mouse button is
released, selection handles appear at each corner of an invisible
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rectangle that would enclose the whole figure . The shape drawn
with the freehand tool does not have to be a closed shape; however,
if a fill pattern is active, a straight edge joins the beginning and
ending points of the drag, and the enclosed spaces are filled with
the pattern. No fill in the fill palette should be active if you want
the line only. Like the other tools, line thickness is chosen from the
Lines menu or from the line thickness palette in some applications.
The lines appear in the pattern that is active in the Pen menu or
fill palette.
Like a drawing made with the polygon tool, a drawing made
with the freehand tool can be modified with the Smooth,
Unsmooth, or Reshape Polygon commands in the Edit menu. To use
the Reshape Polygon command, you may need to choose the
Smooth or Unsmooth command first. The Smooth command has
only a slight effect on lines that are already curved; however, the
Unsmooth command changes curved lines into straight segments-when the Reshape Polygon command is theri used, a handle appears at each corner point in the line segments. When the
Smooth command is used and then the Reshape Polygon command
is chosen, handles appear at intervals along or near the contour of
the line. These handles are control points that can be moved to
increase or flatten the curvature of the line on either side of the
handle, or to move segments of the line to new positions. A little
experimenting is the best way to grasp how the control handles
work.
The arc too l
When this tool is selected, you can draw a one-quarter segment of
an ellipse as you drag the pointer in a diagonal direction across the
screen. A segment of a circle can be drawn if the Shift key is
depressed while dragging. The direction of the curve depends on
the direction the mouse is moved at the start of the drag. If a fill
pattern is active, vertical and horizontal edges from the ends of the
arc enclose the pattern into a shape like a wedge or slice of pie. The
fill pattern and the line thickness are chosen from appropriate
menus or a palette, just as with other shapes.
The handles that appear when the arc shape is selected are positioned at each corner of an invisible, enclosing rectangle and are
used to change the size and proportion of the arc in the same way
as with other shapes. The Reshape Arc command in the Edit menu
must be chosen if you wish to shorten or lengthen the arc; a handle
at each end of the arc then appears. Dragging one of these handles
increases the length of the arc while maintaining the same degree
of curvature. You can lengthen the arc to make a complete ellipse
or circle if you wish. The arc may also be shortened by dragging the
handle back along the arc line.
When you are through practicing, click on the practice window's
close box. When the dialog box appears asking if you want to save
the changes, click No. The window will close, and the practice work
will be erased. If you wish to save the practice document, click on
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the Yes button, give the document a title in the Save dialog box that
appears, and click on Save.
You may want to keep the window open to investigate some of
the menu commands that are described in the following section.
Your application may have many more commands and features
than those described. Refer to its manual for more detail.

Menu Commands
Some menus, such as the Edit, File, Font, and Style menus, have
commands that are found in all draw applications, or in any application that is used to produce text or graphic documents. The File,
Font, and Style menus do not vary greatly from appiication to
application since the commands all relate to system management
or resources that are part of the System files ill all startup disks.
The Edit menu has a group of these kinds of commands but also
includes commands specific to the draw application you are using.
The first group of commands described in this section are the
commands found in the four menus just cited. Following that is a
selection of useful commands that are part of most draw applications.

The File menu
The File menu in draw programs contains most of the same
commands found in this menu in all other applications. The following is a description of each command.
• New. If you wish to open a new draw document in the same
application as you are currently using, selecting New opens a
new, untitled window. When saved, the new window becomes a
new document. Most applications allow several document windows in the same application to be open at once. The active window, the window you can draw in, is on top of all other windows.
Any of the windows can be made active and worked in by clicking
the pointer anyplace inside its visible borders. You may have to
resize and move windows around to see some part of each window. Refer to Chapter 3 if you h ave forgotten how to move and resize windows.
• Open ... This command brings up a dialog box with a directory of
draw documents and folder titles on your current disk. Any one of
the documents can be opened by clicking its title in the directory
to select it, then clicking the Open button. The document window
opens on top of the window (or windows) already open.
Note that only titles of documents that you can open appear in
the directory window. If you have documents made in other applications stored on your disk, these names do not appear unless
they can be opened by your application . However, folder names
show o:h. the list. These are identified by the folder icon preceding
their title. They may be opened by double-clicking on the folder
name or by selecting the folder name and clicking on the Open
button. Any documents stored in the folder that can be opened
appear in a folder directory window.
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If you wish to see the contents of folders at a higher level in
the hierarchy of folders, move the pointer over the small title bar
just above the directory window and press the mouse button. A
menu of folder names in the hierarchy drops down, with the
name of the disk at the bottom of the list. Drag down to the level
you wish to see and release the mouse button; the contents of the
folders at that level appear in the directory window.
If you have documents stored on a disk other than the one currently in the drive, click the Eject button and insert the other
disk. The directory of that disk appears in the dialog box. Select
the document ~d click the Open button to open the document. If
you have one disk drive, the computer asks for the disk it needs
to continue with your work.
If you have two disk drives, or an exterior floppy drive, the
application disk should be in one drive and the document disk in
the other. Click the Drive button to toggle between the directories
for the disks in either of the two drives.

• Close. Selecting this command closes the active window in the
application. Choosing the Close command does not remove the
application from the internal memory. This command is used if
you wish to immediately open another document created in the
same application or open a window for a new document. It functions in exactly the same way as the close box on the window. If
you have not saved the changes you have made in the window, a
dialog box appears asking if you wish to save the changes.
Clicking Yes saves the changes and closes the window. Clicking
No closes the window without saving the changes. If you click Yes
and the document has not been titled, a Save dialog box appears
that must be completed before saving.
• Save/Save As ... As described in Chapter 2, the Save command
is used to save a new document onto your disk. The computer
keeps the contents of the document only in its internal memory
until the command is used; then it wTites whatever is currently
in the document onto disk. If power is interrupted to the computer, all the internal memory is lost, as is all the work you have
done on the document since you last saved. You should use the
command periodically while working on a document, at 15 to 20
minute intervals or at convenient pause points, to avoid doing
much of the work again.
The Save dialog box only appears when you first save a new
document. Later saves on the same document simply update the
save to the current state of the work without calling up the dialog
box again. If you wish to save a current version of the work as
one document and then revise the work as a second document,
use the Save As ... command. Selecting Save As ... makes a copy of
the current work and brings up a dialog box, identical to the Save
dialog box, in which you can change the title and save the copy as
a new document. When the Save As ... dialog box appears, it has
the title of the current document in the title strip. Either replace
the title or add characters to it to change it slightly. If the title is
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not changed and the Save button is clicked, you will see a dialog
box appear asking if you want to replace the current document
with the new document of the same name.
The Save As ... command is used when you have already
saved a document and wish to make another copy to use as the
basis for a new document. For example, a draw document completed for one project may be useful, with minor modifications, for
another project. Using the Save As ... command retains the original copy of the document on disk unchanged; the copy can then be
revised and used as a new document. After the Save As ... procedure is completed, the new copy of the document replaces the
original copy on the screen.
• Print. Using the Print command is described in Chapter 8.
• Quit This command closes your document, as well as the application, and takes you back to the Finder desktop. If you have not
saved the latest changes to your document, a dialog box appears
asking if you wish to save the changes.

The Edit menu
The Edit menu has several commands with the same functions in
draw programs as are found in applications of all kinds . Edit
menus in draw applications also have a few commands that apply
specifically to drawing operations.
• Undo. The Undo command revokes the last action taken in the
drawing window. The start of another action, such as choosing
another tool or drawing another image, cancels the effect of the
undo for the previous action. If an area is accidentally eliminated
or you want to retract a drawing action, immediately choosing
the Undo command corrects the error. Choosing the Undo command also undoes an undo action if you change your mind.
In early versions of MacDraw, the Undo command can be chosen only after deleting an object or text with the Delete
(backspace) key or with the Clear command. For other actions,
the command is greyed and cannot be chosen.
• Cut/Copy/Paste/Clear. These commands perform the same
actions in the draw window with selected objects as they perform
i;vith text on the desktop, as described in Chapter 4. Cut removes
selected objects from the draw window and places them on the
clipboard. Copy copies a selected area 'lvithout removing it from
the draw window and places the copy on the clipboard. The Paste
command places a copy of the current contents of the clipboard
onto the draw window (remember that the clipboard contains
only the item last cut or copied). Clear removes the selected area
entirely without saving it to the clipboard. Using the Clear command does not affect items already on the clipboard.
Using the Copy and Paste commands is an alternate method of
creating multiple copies of selected areas. Once copied to the clipboard, the selection can be pasted as many times as needed, until
it is replaced by performing another Cut or Copy command.
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When a selection on the clipboard is pasted in a draw application, the pasted image appears in the middle of the screen as a
selected image (handles appear around the object). You will find
that it is often deposited on top of an image already on the
screen. Just drag it to its appropriate location.
Duplicate. Choosing this command makes a copy of any selected
object. It also makes a copy of grouped objects or multiple objects
selected while the Shift key is depressed.
Select All. This command selects all the objects in the drawing
including objects that are outside the viewing area of the window.
Reshape. The Reshape command makes it possible to modify
shapes made with the polygon, freehand, and arc tools. The command becomes Reshape Polygon if that shape is selected or
Reshape Arc if the arc is selected. Reshape may be dimmed for
selected shapes drawn with the freehand tool but becomes active
ifthe Smooth or Unsmooth command is used first.
Smooth/Unsmooth. These commands can be used to change the
straight line segments drawn with the polygon tool into a shape
with all curved lines, or back into a shape with straight line segments. The commands make similar changes to shapes or lines
drawn with the freehand tool.
Round corners ... This command can be used with rectangles or
rounded rectangles drawn with those tools. When the command
is chosen, a dialog box offers a selection of sizes for the radius of
the rounded corner. A rounded rectangle can be changed to a regular rectangle with square corners, and a regular rectangle can
be changed to a rounded rectangle.

The Font menu
The Font menu lists all of the names of the typefaces that are
installed in the System file on your startup disk. At least two
typefaces, Chicago and Geneva, are required for system operation
and are in all Font menus. There may be other typeface names for
other varieties of type designs. Additional typefaces can be added
to a System file, and those not required by the system can be
removed. For this reason the names and quantity of typefaces in
this menu may vary considerably depending on what is installed in
the system on the startup disk you are using.
A font is one style and size of a typeface. Most draw applications
use the Geneva typeface in the 12 point type size as the default
font. A check may appear before its name in the Font menu,
indicating it is the currently active typeface. Another font design
can be selected by choosing its name in the menu. Refer to the
description of the text tool, earlier in this chapter, for applying the
font design to the text in the draw window.
Making a selection in the Font menu changes the size of the
typeface as you see it in the draw window and when printed. The
size is always listed in points. A 12 point font size, for example, is
the height of the type from the bottom of the lowercase descenders
(the bottom of the letters p, y, or g) to the top of the lowercase
ascenders (the top of the letters 1, t, d, or h, and all capital letters).
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Since there are 72 points in an inch, a 12 point font size occupies a
maximum of 1/6 inch of vertical height.
The font sizes listed in the menu in outline style are the sizes of
fonts installed in your system file. Using one of the sizes shown in
outline style produces better looking text on the screen. Other sizes
in the menu not shown in outline style produce text of the correct
size but look more ragged on the screen. When printing with a dot
matrix printer, the text in draw programs prints out much like you
see it on the screen. However, all sizes used in text print out very
smoothly and crisply when using a higher-resolution printer, such
as a laser printer.
As with the typeface, the font size may be changed at any time
before entering text or while the text block in the draw window is
still active. In some applications, the text to be changed must first
be highlighted. See the description of the text tool earlier in this
chapter for additional details.

Plain teHt
Bold
I talic
Underline
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T he Style menu
The Style menu in most applications lists the six standard styles
available for each typeface. The name of each style appears on the
list in the same style that shows on the screen and printed copy.
The Plain style is the default style. The other five styles, Bold,
Italic, Underline, Outline, and Shadow, are alternate styles. All but
the Plain style can be u sed in combinations; for example, selecting
both Italic and Outline in the menu produces an italic outline style.
The Style menu usually includes text alignment commands also.
These align the text to the left, middle, or right of the spot where
the insertion point is first placed for a text block. If you wish several lines of text to be lined up on the left side of the block, you would
select the Align Left command, which is also the default selection.
Choosing the Align Middle command centers all lines of type within
the block, and Align Right lines up the right ends of each line. The
Style menus in some programs list the commands as Left, Middle,
and Right.
Specialized Menu Commands in Draw Programs

The number of menus and the kinds of commands in each menu
vary in different draw applications. The commands described in
this section are some of those common to most draw applications.
They are found in menus generally titled Layout, Arrange, Options,
or Draw. Some have been explained already in the descriptions of
the tools and used in the MACtivities earlier in this chapter. You
are encouraged to investigate other commands you may see in the
menus of the particular application you are using by consulting the
application's manual.
• Show (Hide) Rulers/Custom Rulers ... The Show Rulers command places a ruler along the top and left side of the drawing
window. Rulers are an aid in sizing and positioning elements in
your drawing. When the rulers are showing, a dotted line on the
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rulers follows the pointer when it is moved either in a vertical or
horizontal direction-the dotted line shows the location of the
pointer anywhere in the overall drawing area in relationship to
the zero point on the rulers. The zero point for the rulers is at the
top left corner of the overall drawing area. This is also the top
left corner of the screen when the scroll boxes are fully to the top
and left ends of the scroll bars. Some appl_ications allow you to
change the zero point by dragging a small box next to the zero
point where both rulers begin. The default measurement scale on
the rulers is usually in inches but may be changed in a dialog box
that appears when the Custom Rulers ... command is chosen.
Other choices include centimeters and, in some applications,
picas and points.
• Turn Grid Off (On)/Show (Hide) Ruler Lines. 'furn Grid Off
(or On) disables (or enables) the hidden feature that causes the
pointer to jump from one grid-snap increment to the next when
drawing or moving objects. The feature is an aid to sizing objects
to the exact increments of the grid, usually one-eighth of an inch,
and for aligning objects. Show (or Hide) Ruler Lines shows (or
hides) the ruler lines that are used to aid in sizing and aligning
objects. The ruler increments and ruler lines are spaced according to the measure chosen in the Custom Rulers ... dialog box. The
ruler lines show on the screen only and do not print. Some applications use the termgrid lines instead of ruler lines.
• Rotate. Most draw programs can rotate selected objects to any
angle after the Rotate command is chosen. The method varies
slightly in different applications, but usually the pointer changes
to a special symbol that can be placed on any of the selection handles and dragged in the direction of the desired rotation. In most
applications, text can be rotated as well as objects. Some applications may limit rotation of any drawn object to 90-degree increments and may not allow text rotation. Some applications have a
Flip Horizontal and Flip Vertical command that flips an object to
its mirror image along a horizontal or vertical axis.
• Align Objects ... When you wish to align several objects along a
vertical, horizontal, or center line, first select all of the objects to
be aligned, then choose Align Objects... (usually in the Arrange or
Draw menu). A dialog box appears in which you can stipulate
which parts of the objects are to be aligned and in what direction
(Figure 7-23). For example, clicking on Tops moves the objects so
the top of each object lines up along a horizontal line. Clicking on
L/R Centers (left-right centers) moves objects so the center point
of each object is lined up in a vertical line. Note that for oddshaped objects the selection handles define the edges that are
aligned. Text blocks can also be aligned with this command.
Using Draw Graphics in a Word Program
Draw graphics are particularly effective to use in a word program if
you are preparing text to print with a medium- to high-resolution
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The Align Objects dialog
box
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printer, such as the LaserWriter. Draw graphics take full advantage of the resolution of the printer.
To use a graphic done in a draw program, you must have a draw
application that can open the draw document you wish to use. If
you have a draw document you would like to try out in a text document, read Using Graphics With a Word Document at the end of
Chapter 6. The procedure for placing a draw document is the same
as for a paint document.
Quitting the Application
When you are ready to quit working on a document, save it, then
choose Quit from the File menu (or press Command and the letter
Q keys together). If you do not wish to save the document, choose
Quit, then click No in the dialog box that appears asking if you
want to save the changes. In a few seconds the desktop appears on
the screen.
Backing Up Documents
Occasionally something happens to a disk that can make the information on it unreadable. Fortunately, if reasonable care is taken
with disks, this occurrence is rare. However, if you value the work
you create with the computer, you will want to keep an extra copy
of your documents on a separate disk.
Backup copies can be made before quitting a document by saving
the document in the regular manner first, then choosing the Save
As ... command from the File menu and saving a separate copy on
another disk. To do this, click the Eject button in the Save As ... dialog box to eject the disk that contains the first copy of the document, then insert your separate backup disk. Click the Save button
and a copy of the document will be made on the backup disk. You do
not need to change the name of the document for the second copy as
you would if you were saving a second copy to the same folder on
the same disk.
To make a backup copy from the desktop, insert the backup disk
in the drive. Eject the application disk if you are using only one
drive. Drag the document icon over the backup disk icon or into its
window, if open. The computer copies the document; it asks for any
disk it needs to complete the copy operation. When finished, a copy
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of the document icon appears in the backup disk window. Further
details on copying documents can be found in Appendix A.
Shut Down
If you are stopping work at this point, use the shut down procedures described in previous chapters.
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Chapter 7 Self Test
Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.
A. Select one of the four choices that completes the sentence correctly.
1. Paint applications are called bit-mapped programs and draw

applications are called:
a. resolution-dependent programs
b. object-oriented programs
c. high-resolution programs
d. layer-oriented programs
2. To contrain a shape or line, or move objects in a vertical or horizontal path, a tool or selection arrow is u sed while pressing the:
a. Option key
b. Command key
c. spacebar
d. Shift key
3. If several objects in a drawing overlap, the object on top can be
selected and placed behind the other objects by:
a. using a special command in the Arrange or Draw menu
b. using the Cut and Paste commands in the Edit menu
c. moying it away from the other objects, then moving the other
objects on top
d. pressing the Option key while clicking on other objects
4. The maximum height of a line of 18 point type in inches is:
a .. 50
b .. 33
c ' .25
d .. 18
5. To move an unfilled shape, drag with the pointer:
a. on a corner handle
b. on a side handle
c. inside the borders of the shape
d. on the border between handles
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B. Select the statement on the right that defines each word at the
left.
1. - - grabber

2 . - - grid lines
3 . - - handles
4 . __ grid snap
5. -

- group

6. -

- tool palette

7. - - constrain

8. 9. -

fill

- an-ow tool

a . binds objects togeth er so they can be selected and treated as
one object
b. the pattern, including black and white, u sed inside shapes
c . non-printing guide line sthat show in the window
d . used to select and move shapes or lines
e. u sed to change the size and proportion of selected shapes or
lines
f . to make circles and squares with the oval and rectangle tools
g . a measure for type size
h. used to scroll the drawing area outside the window into view
i . displays the choices of drawing tools
j . causes objects to align with invisible grid measures

10 . - - point

oval
corner handle
Reshape
Rotate
Shift
side handle
Align
E dit
Option
grid snap
grid lines
r estrainer tool
Command
r uler
Undo
Corner

C . From the list of words at the left, choose one to fill in each
blank in the statements that follow. A word may be used more
than once.
1. To draw a circle, you use the _ _ __ _ _ __

tool and drng

while pressing the _ _ __ _ _ __ key.
2. To change the size of a rectangle to a larger or smaller rectangle
of the same proportion , you drag with the pointer on a
_ __ _ ____ while pressing the
key.
3. If a shape makes short hops as it is being moved, it means the
_ _ _ _____ is activated.
4. To make a copy of a selected object, you can use the Duplicate
command or press the

key and the letter

Don the keyboard.
5. To modify the configuration of a polygon, it is first selected,
then, the - - - -- - -dles at each corner.

command is chosen to place han-
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D. Mark the following with Tor F for true or false statements.
1. You must hide grid or ruler lines with a menu command before
printing your drawing if you do not wish the grid lines to show
on the printed copy.
2. In most draw applications, drawings can be much larger than
can be printed on a single sheet of 8 1/2- X 11-inch paper.
3. You can draw a filled shape with the polygon tool but not with
the freehand tool.
4. The Group command will bond only two selected objects at a
time, but an additional object can be added to the group by
using the command again.
5. The Reshape Polygon command changes the location of the
handles on a selected polygon shape.
6. If you do not close the border line completely around a shape
drawn with the polygon or freehand tool, it cannot be filled
with a pattern.
7. To erase a shape or line, you can select it and press the Delete
(backspace key.)
8. You can modify only the size and proportion of objects that have
been drawn with the rectangle, rounded rectangle, and oval
tools.
9. The text tool must be selected in order to move a text block.
10. You can add or remove individual pixels in draw applications
when you use an enlarged view of an object.

Printing

Objectives
After completing this chapter, you will be able to:
1. Check that the ImageWriter or LaserWriter is ready for printing.
2. Use the Chooser to select a printer if the computer is connected
to more than one printer.
3. Use the Page Setup dialog box to check the format specifications
for a do cum ent.
4. Use the Print dialog box to check the printing specifications.
5. Print a document.
Important terms
These terms are defined in this chapter and in the Glossary.

Chooser
dot-matrix printer
font substitution
footers

headers
landscape
laser printer
pin feed paper

portrait
smoothing
tall adjusted

Printers

The descriptions in this chapter apply to either the ImageWriter
dot-matrix printer or the LaserWriter laser printer. Some other
printers can be used with the Macintosh computer as well.
Generally the same procedure is used for preparing to print and
printing with other printers.
A dot-matrix printer is an impact printer, much like a regular
typewriter. Its print head strikes an inked ribbon to transfer ink to
the paper. However, unlike the fully formed letters of the typewriter, the dot-matrix print head is a matrix of very small pins that
strike the ribbon against the paper. Each pin leaves a dot. The
163
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group of pins is arranged so th at different patterns of individual
pins can be activated to make the shapes of letters and graphics.
Each letter or graphic sh ape is made of sequences of 72 dots to an
inch. The Image Writers I and II print with a resolution, or dot spacing, that closely matches what you see on the screen.
A laser printer uses laser light, electrical charges, and a toner
to transfer words or graphics to paper. Information is sent to the
printer by the computer in a form that the printer can translate
into a bit image. Each bit represents a black dot. The laser printer
dots are very close together, 300 to an inch. Inside the printer a
laser beam scans a positively charged drum , neutralizing the
charge at each spot where a black dot should be. The areas that are
to be white retain the positive charge. The drum is rotated through
positively charged powdered toner. The toner adheres only to the
neutralized areas of the drum, or the image areas. The printing
paper receives a negative ch arge as it enters the printer. When the
paper is rolled against the drum, the toner adhering to the drum is
attracted to the paper, transferring the image from the drum to the
paper surface. As the paper continues through the printer, it passes
between h eated rollers that fuse the toner to the paper.
Preparing to Print and Printing

Several checks should be made prior to choosing the command that
prints your document. If the computer is connected to more than
one printer, the printer must be selected in the Chooser. The Page
Setup dialog box should be ch ecked to see that the formatting
options you wish to use are selected. The Print dialog box should
also be checked for correct printing instructions. It is from the Print
dialog box that you st art the actual printing. Finally, the printer
must be set up and ready to receive the Print command.
Use the steps that follow for printing your first document.
Descriptions of th e Ch ooser, the Page Setup command, and the
Print dialog box appear later in this chapter. If any of the default
selections require a change, refer to these descriptions before
changing the selection. After your first document is printed, read
about other choices that can be made in the Chooser, the Page
Setup, and Print dialog boxes for future use.
1. Open the document to be printed by double-clicking its icon on
the desktop. If the document and its application ar e on separate
disks, open the application first . Choose Open from the File
menu and locate the name of the document in the directory. Eject
the current disk and insert the disk that has the document
stored on it, if necessary. Double-click on the document title or
select it and click on the Open button.
2. Select Chooser from the Apple menu (Figure 8-1 on page 166). If
your computer is connected to more than one printer, the icon for
the printer you wish to use must be selected. If no icons are highlighted when the window opens, click on th e icon for the printer
you will be using. If an ImageWriter printer is to be used, the
Chooser selection should look similar to the illustration on the
left (Figure 8-1). If a LaserWriter printer is to be used, the
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Chooser selection should look similar to the one on the right.
Click the close box on the title bar to close the Chooser window.
If a message box appears after you select a printer directing you
to choose Page Setup (Figure 8-2 on page 167), click the
Continue button, close the Chooser window, and follow the directions in Step 3 below. If no message box appears, skip to Step 4.
3. Choose Page Setup from the File menu (Figures 8-3 on page 168
and 8-6 on page 170). If no default selections are to be changed,
click the OK button. Check the screen image of your document to
make sure the margins, page breaks, and other formatting features are displayed as you wish to have them print.
4. Choose Print from the File menu (Figure 8-9 on page 172). Check
th e default selections but do not click OK yet.
5. Prepare the printer. The ImageWriter paper should be adjusted
so that the top edge of the sheet has just started under the paper
bale at the top of the platen. Then turn on the power switch for
the printer. Do not worry about the quality settings of the other
switches-the settings in the Print dialog box override any settings on the printer.
.
If you are printing on a LaserWriter and it is not turned on,
turn the power switch on and allow the printer to warm up.
After a minute or two, it prints a startup page. It is then ready
to print your document. Check the paper cassette to see that it
has adequate paper for printing.
If you have difficulty setting up the printer, or you are not
using one of the printers described, consult the manual for the
printer you are using.
6. Click OK in the Print dialog box or press the Return key.
Message boxes appear on the screen that inform you about the
status of the printing. Printing can be stopped at any time by
pressing the Command and period (.) keys together. Some applications provide a button to click that stops the printing. When
the printing is almost complete, the message boxes disappear,
and you can resume work in an application or on the desktop.
If several computers share the same printer, there may be a
delay until documents from other computers have completed printing. The order of printing depends on the sequence of the Print
commands.
You cannot use the computer for other work while the document
is printing unless your computer has a printer buffer or spooler.
This is a utility application that saves the document to the disk,
then sends the information to the printer. This frees the computer
to do other work much sooner since saving the document takes
much less time than printing. After a short interval for the saving
stage, you are able to resume work on th e computer while the document is printing.
The Chooser

The Chooser is a desk accessory that lets you access a variety of
resources, mainly printers, that are connected to the computer
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through the printer and modem ports at the back of the main unit.
Selecting Chooser from the Apple menu opens a window and places
it in front of other windows on the screen. The Chooser may be
opened at any time, either while on the desktop or in an application. If more than one printer is connected to the computer, an icon
for each printer appears in the Chooser window (Figure 8-1). Select
the printer you wish to use in the box on the left by clicking on its
icon to highlight it. When the ImageWriter is selected, two icons
appear in the box on the right, one for each port at the back of the
computer that can be u sed to connect printers. The icon with the
drawing of a printer is the printer port icon. The icon with the
drawing of a telephone represents the modem port which can also
be used for a printer (a modem is hardware used for telecommunication). If several computers sh are a printer through an Appletalk
network, the network cable is often connected to the printer port. If
an ImageWriter is connected directly to the computer as a second
Figure 8-1
The Chooser windows for
th e Image Writ.er a.nd
L aser Writer

Chooser
Selec t a printer port:
L.1serWriter

Use r Name:

AppleTalk

ff0I

~
lmageWriter

--
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3.3 . 1

Chooser
Sel eel a LaserWriter:

~

.......,"M'11d
,.__..J·.._.

Background Printing:

O On@ Off

User Name:

App l eTa l k

@Active
0 Inactive

3.3. 1
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printer, it can be plugged into the modem port. Usually the correct
port for the computer is highlighted au tomatically in the Chooser
when the printer is sel~~ted. If an Appletalk network is u sed, the
Appletalk Active radio button is highlighted. ·
When you change printer types in the Chooser, a message box
appears with a caution (Figure 8-2). The message is a warning to
select Page Setup from the File menu before proceeding with the
printing. Choose the Page Setup dialog box and close the box by
clicking OJ\ even though you make no changes in the Page Setup
options. In certain cases, changing the printer can effect the
appearance of your document on the screen. It is a good practice,
after closing the dialog box, to look over your document to be su re
the forma tting has not changed. Changes can occur in text
documents, primarily in the width of the text blocks, because of
variations in line lengths for different printers.
Figure 8-2
A message box may appear
after changing settings in
the Chooser wind-Ow.

Chooser

Be sure to choose Page Setup and
confirm the settings so that the
application can format documents
correctly for the I mageWriter.

[

Continue

D

1

i

AppleTalk

®Active

0 Ina ctive

3.2

The Page Setup Command
The page setup for a document is controlled by the application's
Page Setup command. The Page Setup command in the File menu
opens a dialog box that allows you to select the size of paper u sed
for printing, the page orientation, and some special effects. The
number of special effects depends on the printer being used.
Choices made in th e Page Setup dialog box apply only to the document that is currently open. These settings will be stored with the
document when th e document is saved. They still will be effective
when you r eopen the document, but they will not carry over to other document s. The choices in the Page Setup dialog box can be
made anytime prior to printmg, even before you start work on the
document.
Expect to fin d some variation in the appearance and number of
choices offered with the Page Setup command in different applications. All applications have a set of standard options but some
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applications offer additional choices. Some of the options in the
Page Setup dialog box change when different printers are selected
in the Chooser.
After choosing Page Setup from the File menu to open the dialog
box, you may not need to change any settings for most of your documents. The default settings already highlighted are those that are
used most of the time in any application.
lmageWriter Page Setup dialog boxes
If the ImageWriter is the printer selected in the Chooser, its name

appears at the top of the dialog box (Figure 8-3).
Figure 8-3
The ImageWriter Page
Setup dialog box

lmageWriter
Paper:

@ US Letter
0 us Legal
0 Computer Paper
Orientation
Special Effects:

0 A4 Letter
O International Fanfo l d
D Tall Adjusted
D 50 % Reduction
D No Gaps Betw een

( Cancel )

Pages

The round radio buttons in the top half of the box are choices of
Paper. When one of these buttons is selected, the page length and
margins for that size of paper are automatically adjusted. In most
applications, these adjustments show on the screen. US Letter is
the standard 8 1/2- by 11-inch size paper used for most documents.
A4 Letter is slightly narrower and longer than US Letter. A4 Letter
is a standard paper size in Europe. US Legal is 8 1/2- by 14-inch
paper often used for legal documents. Computer Paper is pin feed
paper, a continuous string of pages joined top to bottom with perforations between sheets. Pin feed paper is also called fanfold paper
or continuous form paper. The paper has holes punched in strips on
the vertical sides that engage sprockets in the printer. The rotating
sprockets, called the forms tractor, pull the paper into the printer.
The computer's software keeps track of the number of lines printed
and, when near the bottom margin of one page, advances the paper
to the top of the next page. After printing, you must separate the
individual pages and remove the strips along each side of the pages
that have the pin feed holes. The size of a trimmed sheet of computer paper is the same size as the US Letter. International Fanfold is
also a pin feed paper whose trimmed size is the same as US Legal.
The Orientation icons are used to change the printing orientation on the paper. Normally printing is done with the long dimension of the paper vertical. This is the default selection so the left
icon is already highlighted. Clicking on the right icon causes a document to print sideways on the paper. The vertical orientation is
often called portrait and the horizontal orientation called landscape. Selecting the landscape orientation also changes the page
orientation seen on the screen in many applications.
In the Special Effects choices, the Tall Adjusted box should be
checked if you are printing graphics. If it is not checked, graphic
images print slightly distorted in proportion compared to the image
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on the screen. If Tall Adjusted is selected, t h e printer adjusts the
line spacing so that the graphic appears in t he printed copy the
same as you see it on the screen. Selecting 50% Reduction prints
the document half size and centered on the page. Selecting No Gaps
Between Pages causes a multi-page document to print without top
and bottom margins between pages.
Some applications have additional choices in the Page Setup dialog box, or have an additional dialog box that is opened from the
main one. For example Microsoft Word has a Document button in
the box that first opens when Page Setup is chosen (Figure 8-4).
Clicking on the Document button opens a second dialog box with
additional page controls to enter or choose from (Figure 8-5). These
include text boxes to specify the size of margins between the text
and the edges of the printed page. The dialog box also has controls
that apply to multi-page documents printed on both sides of the
paper, page numbering, footnotes, and other formatting features.
Figure 8-4
Some Page Setup dialog
boxes have additional
choices.
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Figure 8-5
Making a selection in a
Page Setup dialog box may
bring up a new box.
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LaserWriter Page Setup dialog box
If the LaserWriter is the printer selected in the Chooser, its name
appears at the top of the Page Setup dialog box (Figure 8-6).
The Pape r choices for the LaserWriter include US letter, US
legal, and A4 letter, in the same sizes as offered in ImageWriter
Page Setup. Two additional paper size choices appear: B5 Letter
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and Tabloid. B5 letter is approximately 7 by 10 inches (17.6 by 25
centimeters), and· Tabloid is 11 by 17 inches, or double the US
Letter size. System versions earlier than 6.0 may not inclu de the
Tabloid size in paper choices.
Figure 8-6
The Laser Writer Page Setup
dialog box

n

ll

=L=a=se=r=W
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( Can cel )
Printer Effects:
( Options J
Reduce or
Enlarge:
[8] Font Substitution?
Help
18.1 Teut Smoothing?
Orientation
181 Graphics Smoothing?
181 Faster Bitmap Printing?

liimil%

The Orientation icons are the same as for the ImageWriter. The
normal, or portrait, orientation is alTeady selected. The icon on the
right, the landscape orientation, can be selected to print on the
paper sideways. Selecting the landscape orientation also changes
the page orientation seen on the screen in many applications.
In the Reduce or Enlarge text box, a new percentage number can
be entered to reduce or enlarge the document when printed-100%
is actual size. You can enter any percentage between 25%, onefourth actual size, to 400%, four times actual size. If entering an
enlargement, be sure the document will fit on the paper when
printed.
In most applications, the check boxes under Printer Effects are
already checked, or selected. Any may be deselected by clicking in
the box, but for most printing, they should stay selected. When
Font Substitution is select ed, the LaserWriter substitutes one of
its built-in PostScript fonts if a Macintosh bit-mapped font was
used in the document. For example, Helvetica substitutes for
Genev a, Times for New York, and Courier for Monaco. If F ont
Substitution is deselected, the LaserWriter prints the Macintosh
font; however, it takes longer, and the printed result looks much
like the bit-mapped typeface seen on the screen.
Selecting Smoothing makes bit-mapped fonts and graphics created in paint applications look slightly smoother when printed than
they appear on the screen. Paint graphics take longer to print with
Smoothing selected, and some paint applications have this option
deselect ed in the default setting. Faster Bitmap Printing is
designed to speed up printing when bit-mapped paint graphics or
Macintosh bit-mapped fonts are u sed in the document.
As with the ImageWriter Page Setup dialog box, the dialog box
for the LaserWriter also varies among applications. Microsoft Word
Page Setup has a Document button that opens a second dialog box
for additional margin and other formatting controls. These
duplicate the controls used in Microsoft Word's ImageWriter dialog
box (Figure 8-5). The Page Setup for Microsoft Works has text fields
to enter headers or footers, information you may want to h ave
printed on the top or bottom of each printed page (Figure 8-7). It
also h as boxes to specify page margins.
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All LaserWriter dialog boxes have an Options button located in
the Page Setup dialog box in the row of buttons at the right.
Clicking the Options button opens a new box with additional controls (Figure 8-8). Clicking in one of the check boxes changes the
illustration on the left, demonstrating the printed result of the
choice. Most of the selections are used more often with graphic documents than with text. Flip Horizontal reverses the image of your
page left to right, or prints a mirror image along a vertical axis.
Flip Vertical turns the image on the page upside down, or prints a
mirror image along a horizontal axis. Invert Image prints a negative image; all the blacks on the page print as whites against a
black background. Precision Bitmap Alignment prints bit-mapped
images, such as those done in a paint application, at an increment
in size that best matches the resolution of the LaserWriter. The
image size is reduced to 96% of the size that you see on the screen,
which avoids distortion of fill patterns and produces a smoother
image. The content of the whole page is reduced, including objectoriented graphics or text that may be on the page with the bitmapped image. Larger Print Area allows the image on the page to
be printed closer to the border of the paper. The maximum printed
area with letter-size paper is 8 by 10.9 inches. Some applications do
not allow you to fill a page area quite this large unless this option is
selected. Unlimited Downloadable Fonts in a Document allows an
unlimited number of downloaded fonts to be used, if available, in a
single document. Downloaded fonts are those not already installed
in the printer but available from a disk. When used, such fonts take
up additional memory in the printer. Checking this box provides
the means for several of these fonts, or typefaces, to be used within
a document without exceeding the printer's memory capacity.
The Print Command
When you are ready to print your document, choose Print from the
File menu. Print dialog boxes in most applications are similar in
the options they offer, whether printing with an ImageWriter or
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LaserWriter (Figure 8-9). The name of the printer selected in the
Chooser appears at the top of the box. You should always check
that the printer name is correct if your computer is connected to
more than one printer.
Figure 8-8
·w hen the Options button is
se/,ected, a new window
appears.
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Print dialog boxes from
various applications offer
similar options.
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Quality and Paper Feed options are found in ImageWriter Print
dialog boxes. Quality offers three choices, Best, Faster, and Draft. If
Best is selected, the pins in the printer head double-strike each dot
that makes up the letter and graphic images. This makes the spacing between dots less evident and the printed letter darker. This is
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often not the best choice for printing graphics because th e amount
of ink deposited may block in some fill patterns. Faster is the
default selection and is u sually the best choice for graphics. Faster
produces medium density in text and prints a document twice as
quickly as Best quality. Draft quality produces the least dense letters and prints a document the quickest. Draft quality is suitable
for review and editing, but you may choose to use Faster quality for
that also since the printed text is easier to read. Your choices for
Paper Feed for the ImageWriter depend on whether you are using
pin feed paper or single sheets. Select Automatic if you are using
pin feed paper. Be sure the paper release lever on the ImageWriter
is on the pin feed position, identified by the drawing of a spoked
single circle. Select Hand Feed if you are using single sheets of
paper that are loaded into the printer individually. In this case, the
paper release lever on the printer should be changed to the hand
feed position, identified by the drawing of two adjacent circles.
The choices in the Print dialog box t h at are common to both
ImageWriter and LaserWriter printers are Pages, or Page Range,
and Copies. Pages gives a choice of printing all pages in a multipage document or only one or selected pages in the document. The
All button, initially selected as the default setting, prints all pages
of the document. Select the button preceding From to print one or a
few pages. When the button is selected, an insertion point appears
in the From box. Enter the first page number of the group of pages
you wish to print. Tap the Tab key to move the insertion point to
the To box and enter the last page number of the group. You can
also click in each box to set an insertion point and then enter the
page numbers. The printing includes the page numbers entered. If
you wish to print just one page, enter that page number in both
boxes. The text box for Copies has one copy entered, and the field
may already be highlighted as the default when the Print dialog
box is first opened. If you wish to print more than one copy, enter
the number of copies in the box.
The final choice in the Print dialog box, Paper Source, applies to
LaserWriters only. Paper Cassette is selected as the default, indicating that paper will be fe d into the printer from the printer's
paper tray. Manual Feed is selected only when printing on material
that cannot be used in the paper tray. Manual feed is often used
when printing envelop es or when using odd-sized or heavier
papers.
A few variations of the Print dialog box for the LaserWriter may
be found in some applications. Microsoft Word, for example, has
additional choices for printing a multi-page document from back to
front, which makes collating easier on some LaserWriters (Figure
8-9, bottom dialog box). Other choices are available that can be
used with special features in the Word application.
A few graphic applications h ave their own version of th e Print
dialog box. Most of the same choices are available as in the dialog
boxes just described, but some have other components. For example, the FullPaint Print dialog box (Figure 8-10) shows a reduced
view of the graphic being printed on the page. As the page is print-
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ed, markers move over the graphic to indicate t he progress of the
printing.
Figure 8-10
Print dialog boxes are also
found in graphic and paint
programs.

Shut Down
Follow the shut down procedures used in previous chaptets when
you stop wor_k. Turn the ImageWriter power switch off. A
LaserWriter is usually left \vi.th the power on if the printei' is used
intermittently tfiroughout the day.
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Chapter 8 Self Test
Complete the Self Test below and then compare your answers to
those given in Appendix D. Review the chapter for information
about questions you have missed.
A. Select one of the four choices that completes the sentence correctly.
1. The menu command that is used when you want to select anoth-

er printer to print your document is:
a. PNnt
b. Page Setup
c. Chooser
d. Page Orientation
2. To change the orientation of the printing on the page from vertical (portrait) to horizontal (landscape), you click on an icon in
the dialog box opened by choosing the menu command:
a. Page Setup
b. Print
c. Chooser
d. Page Orientation
3. To avoid distortion in graphics printed on the ImageWriter, you
select the check box in the Page Setup dialog box under Special
Effects titled:
a. 50% Reduction
b. Tall Adjusted
c. P.recision Bitmap Alignment
d. Larger Print Area
4. Form feed paper is pulled into
device on the printer called a :
a . pin driver
b. perforator
c. sprocket feeder
d. forms tractor

th~

ImageWriter printer by a

5. Selecting a differ ent printer may affect the appearance of t h e
document on the screen by:
a. changing line length s and page breaks
b. substituting a different typeface
c. showing printer code sympols
d. removing all the formatting in a text document
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B. Select the command at the left whose dialog box has options to
perform the actions in the statements that follow.

1. _ _ _ reduce the size of the printed image

2.
3.
4.
5.
6.
7.
8.

change the print quality for the ImageWriter
switch to another printer port
print two copies of the document
has a button to open the LaserWriter print options
window
print only the second page of a multi-page document
change the size of the paper
print on a hand-fed single sheet on the ImageWriter

C. Mark the following Tor F for true or false statements.
1. Dot-matrix printers can print text only.
2. Laser printers can print at a higher resolution than dot-matrix
printers.
3 . Only the printer being used to print a document can be connected to the computer's printer port.
4. The Chooser needs to be used only when you change to another
printer.
5. Choosing a different printer can change how the document
appears on the screen.
6 . Standard 8 1/2- by 11-inch paper is called US Letter in the dialog box.
7. Form feed paper can be recognized because of its lines across
the pages.
8 . Choosing Print from the File menu immediately prints your
document.
9 . If Draft quality is selected on the ImageWriter, a document is
printed more quickly than if Best or Faster quality is selected.
10. When you change to a different kind of printer in the Chooser,
a message box appears that cautions you to check the settings
in the Print dialog box.

Managing Disks
and Directories

Preparing Data and Backup Disks
An application together with the startup System files often use
most of the storage space available on the application's disk. After
creating a document with the application and attempting to save it,
you may encounter a dialog box that tells you there is not enough
room on the disk to save the document. You must save the document on another disk. A data disk is used to store documents only.
It does not have the application or system files on it, so all the
space on the disk is available for documents.
A backup disk is a duplicate copy of documents or information on
other disks. A disk may be damaged physically, or information on
the disk may be scrambled so that the computer cannot read the
disk. Smart computer users routinely back up documents they create or modify after each work session. It is wise to make a habit of
saving work in progress often and copying it to a backup disk regularly.
Initializing Disks
Disks are available in both single-sided (SS) format with 400 kilobytes of storage and double-sided (DS) format with 800 kilobytes of
storage. Unless you are using an early model Macintosh that
accepts only single-sided disks, you should acquire the double-sided
kind.
The first step in preparing a disk to become a data or backup
disk is to initialize it. Initializing codes the disk to receive and
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interpret information from the computer. Disks can be initialized at
any time, whether you are on the desktop or working in an application. With a new disk, just insert the disk into the computer. A dialog box appears with three buttons to select from (Figure A-1). Click
on one of the buttons to start the actions described below.
Figure A-1
When a new disk is
inserted, a dialog box
appears.

This disk is unreadable:
Do you want to initialize it?
(

Eject

)

(One-Sided)

(Two- Sided)

• One-Sided. Click this button if the disk you are initializing is a
single-sided disk. Double-sided disks can also be initialized as
one-sided. If the disk needs to be used on an older model
Macintosh without the hierarchical file system or in a 400K external drive, the disk needs to be initialized one-sided. Also, some
utility programs designed to copy disks may not copy a single-sided disk to a disk initialized as double-sided.
• Two-Sided. Click this button if the disk you are initializing is a
double-sided disk. This takes full advantage of a double-sided
disk's capacity and installs the hierarchical file system. If you
click this button with a single-sided disk in the drive, the disk
will be initialized on both sides, but it is not wise to do so. Singlesided disks have been tested only on one side, and initializing
them two-sided can result in a loss of some of your documents.
• Eject. Click this button if you change your mind about initializing the disk in the drive or need to remove the disk from the drive
without further action.

Warning: The initialization dialog box appears if you insert any
disk that the computer cannot read. If the dialog box appears
when you insert a disk that already has data or applications on it,
it means that the disk has been damaged or has directory errors
that the computer cannot interpret. Click the Eject button immediately if this occurs-disk repair applications are available that
may enable you to recover the data on the disk. Clicking one of the
initialization choices erases all information on the disk.
After you click one of the initialization buttons, a second dialog
box appears warning that initialization erases all data that may
be on the disk (Figure A-2). This warning box appears even when
a new disk is being initialized*. Click Erase to continue the ini• System ver sions earlier than 5.0 do not present the second warning dialog box. Instead, the disk is initia lized after clicking OK in the first dialog box, and the title box a ppears after the disk has been initialized.
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tialization or click Cancel if you change your mind. If you continue, a title box appears with the title field highlighted and is ready
for you to enter a title for the disk (Figure A-3). Any combination
of typed characters except the colon(:) may be used for the title.
A period should not be used at the beginning of a title, and titles
cannot exceed 27 characters in length. Give each disk a different
title to avoid confusion since many times the computer will ask
you to insert a disk by name. After entering a title, click OK. The
message box then keeps you informed about the progress of the
initialization. The process of formatting, verifying the format,
and creating a directory for the disk takes about a minute. The
message box disappears, and a disk icon with the title you
entered appears on the desktop.
You may notice that once a disk has been initialized and its
window opened on the desktop, the amount of storage available
on the disk is slightly less than the full storage capacity of the
disk. Some of the storage is used for the directory functions.
FigureA-2
A warning box may be
displayed with a message.

This process will erase all
information on this disk.

[

FigureA-3
Enter the title of the new
disk in the title box.

Cancel

~==·=i

I.

I

K

)

Erase

D

Please name this disk:
Untitled

OK

Reusing Disks
Disks that contain documents you no longer wish to save can be reused for storing new material. One way to do this is to open the
disk's window on the desktop and drag all the icons into the trash.
Empty the trash with the Empty Trash command (Special menu),
and all of the storage becomes available. If the disk contains an
application, a dialog box appears asking if you are sure you want to
trash the application. If you are sure, click OK and the application
will be erased.
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A quicker way to erase the disk is to use the Erase command in
the Special Menu. Make sure the icon for the disk you want to
erase is selected, then choose the command. Again, if the disk contains an application, a dialog box appears asking if it is OK to trash
the application. You cannot erase the disk you are using as the
startup disk. If you wish to erase that disk, you must restart the
computer with another startup disk, eject it, insert the disk you
want to erase, then use the Erase command. The Erase command
opens an initialization dialog box with the same choices as when
using a new disk.
Disl< Labels
Labels for new disks are not u sually mounted on the disks. When
you attach a label, position it so the label fits inside the depression
on the disk. If properly positioned, several labels can be layered
over the original one without making the disk so thick it will hang
up in the disk drive. Adding a new label over an old one may be
necessary if you reuse a disk and change its title or contents. Avoid
removing old labels from disks-the effort required may distort or
damage the disk. Solvents strong enough to dissolve or soften the
adhesive may also damage the plastic disk cover. Be sure labels do
not have a loose flap that can stick in the drive.
Copying Documents
Copying is normally done on the desktop. You may be copying a
document or folder to a backup or data disk or copying applications
or System files to another disk.
To copy from a floppy disk to a backup or data disk, you need to
eject the source disk that has the document on it that you wish to
copy. Use the Eject command from the File menu or press
Cornmand-E. Insert the destination disk, the disk that receives the
copy. When the destination disk icon appears on the desktop, double-click on it to open its window. From the source disk window,
select and drag the document or folder to the destination disk window (Figure A-4). When the mouse button is released, the document is copied to the destination disk. The computer may ask you
to change the disk in the drive during the process. If the computer
has an updated system, a dialog box shows the progress of the copy.
The time needed to copy a document varies with the size and complexity of the document, but usually copying only takes a few seconds.
Multiple documents may be copied in one operation. Select all
the documents you wish to copy by holdi,1g down the Shift key
while you click on the document icons. When all the documents are
selected, drag them as a group to the destination disk.
Documents can be dragged to the destination disk icon, the disk
window, or to any folder within the window. A folder window does
not have to be open to place the document in the folder- just drag
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Figure A-4
Copying documents or
folders between windows of
separate disks.
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the icon on top of the folder until the folder is highlighted, and a
copy of the document is deposited in that folder. Also, it does not
matter how deeply the folder may be nested.
Copying a whole disk to another disk is simply a matter of
selecting the source disk icon and dragging it over the icon of the
destination disk (Figure A-5). Unlike copying individual documents, however, the contents of the source disk replace the contents of the destination disk. For this reason, the destination disk
should be a blank disk or one that has no items on it that you wish
to save. The destination disk whose contents will be replaced cannot be the disk used to start up the computer. To replace the contents of the startup disk, the computer must be started with another disk.
Figure A-5
Copying one disk to
another disk
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During the copying period, you will probably be asked to change
disks several times if you are using one disk drive. Copying is simplified if your computer has a second drive, either a floppy or hard
drive. The disk in one drive contains the source items, and the disk
in the other drive is the destination: No switching of disks is necessary during copying. However, you need to check to make sure
enough storage space is available on the destination disk to receive
the item or items you are copying. Use the Get Info box to determine the size of the source item, and check the storage available in
the destination disk window.

Hard Disk Management
Computers using a hard disk for storage are rapidly becoming the
norm rather than the exception. Hard disks have become less
expensive as their popularity and number increase. However, one
of the most compelling reasons to have a hard disk is that it permits you to u se larger applications and System files. Many applications for word processing, graphics, business, music, and other u ses
have greatly expanded the features they offer, and consequently,
their size. System files have also grown in size to include new features that improve on the basic system operation. In addition,
u sers often want a good selection of fonts and useful desk accessories available. It is not unusual for the combination of System
files and applications to occupy both drives when two floppy drives
are available. Some disk swapping is still required to get work
done.
The hard drive alleviates the disk swapping chore; usually the
only time the floppy drive is needed is for making backups or for
transferring documents to data disks. The hard disk is usually the
startup disk and stores both the applications and their documents.
A hard disk of very modest size, 20 or 30 Megabytes, stores a large
System file, a dozen applications, and hundreds of documents . Ten
megabytes of storage, for example, stores about 3500 pages of
word-processed documents. Hard disks with 80- or 100-megabyte
capacity are not uncommon. With compact laser disk s (CD), several
hundred megabytes are available.
The potential of accwnulating even several hundred documents
on a small hard disk makes a system of organization essential. If
you work with a computer regularly, you will find it does not take
long to accumulate a great number of documents. If you kept all
these documents in the single window of the disk, individual items
would be difficult to find. Many documents in one window slow the
computer down because more items must be redrawn each time the
window is activated or scrolled to a n ew viewing area. In addition,
finding documents in dialog box directories takes longer. Dialog
boxes typically display 5 to 8 titles at once, after which you must
scroll the box to read other titles. Imagine finding a title among
several hundred within this limited viewing field!
The hierarchical file system makes it simple to subdivide documents into folders as described in Chapter 3. Folders can be nested
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in other folders for as many deep as necessary to make a logical
and easy-to-use filing system. While individual filing systems vary
in structure, the suggestions that follow can help you develop a system that works well for you.
• Dialog boxes and directories are more efficient to use if they contain a limited number of titles. Try to keep a maximum of 12 to
15 documents or folders within each folder.
• The disk window is the top echelon of the windows. Limit the
items in it to folders only. The system folder is one of these folders. An application and documents done in that application are
often grouped in a folder. For example, a word processing application and folders of documents done with the a pplication can all be
placed in one folder titled Word. A separate folder can be used for
each application at the disk window level. If several applications
on the disk have related functions, they can share a folder. A
Graphics folder, for example, may have folders within it for separate paint and draw applications.
• Grouping within an application folder works well for many documents that are done exclusively in the application. However,
some categories of documents may use several kinds of applications and are more logically grouped by subject. For example, if
you spend a major amount of time doing reports that combine
word processing, business, and graphics applications, a folder
titled Reports might rate a spot in the disk window. Inside the
folder other folders might identify each project or individual
report and its documents from different applications.
• Consider how you need to access items as you gradually accumulate and place documents in a hierarchy of folders. If you must
use a document stashed in a folder within another folder within
still another folder, etc., nested six levels down, remember that
you must open each folder above that level one at a time to get to
the document.
• Categories that are used often should be kept near the top level
in the hierarchy. If you write many letters, the folder for letter
documents can be placed at the disk window level, or one step
down in a Word folder. When many letters accumulate, they can
be further subdivided into folders by kind (business, personal),
date (month, year), or alphabetical groups (A-M, N-Z).
• You may find that you open certain folders much more frequently
than others from directories in dialog boxes, such as the Save and
Open dialog boxes. It is convenient to have the titles of these folders n ear the top of the directory list when the dialog box is open
so that the need to scroll the directory list is minimized. If the
alphabetical order of folder titles does not place those most used
near the top, other characters can be placed in the title to give
them a higher priority.
The computer compiles lists in numerical order using the ASCII
code for the first character in each title. ASCII stands for American
Standard Code for Information Interchange and is a standard for
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the way computers store and communicate characters. Each character, including capital and lowercase letters, numbers, punctuation, and other special characters, is represented as a number
between 0 and 127. In the numerical hierarchy, titles starting with
numbers 0-9 (code numbers 48-57) precede those starting with capital letters A-Z (code 65-90). Titles starting with lowercase letters
(code 97-122) follow numbers and uppercase letters, respectively.
Some punctuation marks and other special characters have lower
ASCII code numbers and, thus, higher priority than numbers and
letters. The exclamation mark (!), quotation mark ("), pound sign
(#), ampersand(&), apostrophe('), asterisk("'), and plus sign(+) in
that order have code numbers smaller than those of number or letter characters. When any of these marks are used as the first character in a title, the title will have precedence in directory listings.

Warning: Do not tamper with titles of applications or System
files, or you may cause an operating malfunction. Modify only
titles of documents or folders that you have created.
Find File
Find File is a desk accessory included with Apple's system u tility
software (Figure A-6). Find File searches for titles of documents,
folders, or applications stored on the hard disk or on disks in the
floppy drive. The DA is very useful if you have a great many documents stored in folders that may be nested several layers deep. If
Find File is installed on the startup disk, open it by selecting its
title in the Apple menu. By entering a title (filename) in Find File's
Search for box and clicking the Walk button, the whole disk directory is searched for a matching title. When a matching title is found,
it is displayed in the middle section of the window. You may not
remember the complete title of the document you are seeking. If
you know a portion of the title or a word in the title, this can be
entered in the Search box. All titles of documents, folders, or applications on the disk that include the word or words entered appear
Figure A-6
The Find File desll
accessory window.

0
c::i

Find File
Big Mac 11

Search for:
1.3

I'

I

•oo

JQ1

~

F-i

lQJ

185

Managing Disks and Directories

in the middle display area (Figure A-7). Scroll bars become active if
more than five titles are found. Press and hold the pointer on the
scroll arrows to view the additional titles. The icons preceding each
title identify the item as a document, folder, or application.
FigureA-7
The middle section of the
Find File window lists all
the titles on the disk that
contain the search word.
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If one of the titles on the list is selected, additional information
about it is displayed in the lower section of the Find File window
(Figure A-8). The left side shows the date created and modified.
The dates may help identify a document or folder as the one for
which you are looking. The left side also displays the size in bytes
and kilobytes if the item is a document or an application. The right
side displays the hierarchy of nested folders and the disk name in
the levels above the selected title. The top folder on the list is the
folder where the selected item can be found. If this folder is nested
in another folder, that folder appears next on the list, and so on.
The disk name appears at the bottom of the list.
FigureA-8
Selecting one of the titles
displays information about
it and its location.
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If a large number of items are stored on a disk, and in many
nested folders, a search can take some time. A search can be
stopped at any time by clicking on the Halt button in the upper
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right corner of the window or by clicking on the close box to close
the window.
The icon and name of the disk being searched appear at the
upper left corner of the Find File window. If you wish to search on
another disk other than the one showing and the disk is in one of
the drives, click on the icon until the title of the disk you wish to
search appears.

Desk Accessories

Alarm Clock
Calculator
Chooser
Control Panel
Key Caps
Note Pad
Puzzle
Scrapbook

The Apple Menu
The Apple menu, opened by pressing and holding the pointer on the
drawing of the small apple at the left end of the menu bar, contains
a list of desk accessories (DAs) that are installed on the startup
disk you are using. A desk accessory is a small application that can
be used at any time while you are working on the desktop or on a
document in an application.
DAs are designed for a variety of tasks. The Control Panel DA
adjusts the operating characteristics of the computer, such as the
rate the insertion point blinks or the interval between clicks of the
mouse button for double-clicking. The Chooser DA is used to choose
a printer if the computer is connected to more than one. Other DAs
include a clock, a calculator, a chart of the keyboard to aid in locating special typeface characters, a note pad, and a scrapbook that
you can use to store illustrations or text that you use frequently.
These are standard DAs that are included in the system software
that comes with the computer. A multitude of other DAs that do a
large variety of tasks are available commercially, or from shareware or public domain channels. Shareware programs are those
you can try without cost; if you decide to use them, you then send a
fee to the developer. Public domain programs are free. Both shareware and public domain programs are available from Macintosh
user groups, or clubs, and can be downloaded from telecommunication exchanges or purchased by the disk for a small fee from distributors who specialize in this kind of software.
When the title of a DA is selected from the Apple menu, its window opens on top of the other windows on the screen. The window
contains the configuration for that DA and is usually much smaller
187
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than the screen in size. Like other windows, the DA window can be
moved by dragging its title bar and closed by clicking on its close
box. Several DAs can be open at one time, but only one can be
active. Inactive windows are made active by clicking inside the window. Work can continue in most applications while a DA is open.
However, clicking in the application window to make it active may
completely hide the DA window when the application window
comes to th e front. Reactivating the DA window in such a case can
be done by adjusting the size of the application window until a portion of the DA window can be seen and clicked on. The DA window
can also be reactivated by selecting the title of the DA again from
the Apple menu .
Apple Menu DAs
The desk accessories described are included with the basic computer system, and most may be present on startup application disks.
However, DAs can be added or removed from any System fil e by
using a utility called the FontJDA mover. Since each DA occupies
some storage space on the disk, some of the DAs often are removed
from disks containing applications so that more room is available to
store documents on the disk. This may be the case if the startup
disk you are using does not have some of the DAs listed.
The configuration of th e windows that open when a DA is chosen
may vary from those illustrated, depending upon which system version is installed on your startup disk and what model of Macintosh
you are using. For example, some items in the Control Panel windows are changed wh en the system is updated. Adding utilities to
the System folder may also a dd items. Items in the Chooser window
change depending on the version and on the number of printers and
other r esources being u sed. The keyboard layout in KeyCaps
changes to reflect the type of keyboard being u sed-earlier k eyboards will be displayed with a slightly different layout than later
model keyboards. If you are using an extended keyboard, KeyCaps
reflects that layout.

• About the Finder... The top item on the Apple menu is not a DA
but opens a dialog box that gives information about the application (Figure B-1). About the Finder... appears in th e menu if you
Figure B-1
About the Finder dialog
box
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are on the desktop. If you are in an application, About the (application name ) ... appears. The information in the dialog box
includes the name of the application, its version number, the
release date, the firm that produced the software, and often a
credit line to the developers and programmers of the application.
• Alarm Clock. Selecting Alarm Clock opens a small narrow window that contains a digital clock (Figure B-2). The clock is connected to the internal battery and continues to keep the time current even when the computer is off or unplugged. The square box
at the left of the strip is a close box; the dot with the tiny flag on
the right is the lever used to open or retract additional segments
of the clock window display. Clicking on the lever opens a display
below the time of day that contains the date, and below that,
three icons in the shape of a clock face, a calendar, and an alarm
clock. The bottom two strips in the display are used to adjust the
time of day, to display and adjust the date , and to set the alarm
clock.
Figure B-2
The Alarm Clock desli
accessory
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To set the clock, select the clock face icon at the lower left so it
is highlighted. The center strip changes to the time of day, the
same time as in the top strip. Click on the part of the time you
want to change, either the hour, minute, second, or the AM/PM.
When you click on one of these to highlight it, a set of up and
down arrows appears to the right on the center strip. Click on one
of these to change the highlighted part of the time display. Click
on the up anow to advance the number or on the down arrow to
decrease the number. The arrows function like arrows in a scroll
box-click to advance one number at a time or press to scroll
quickly. When you have adjusted that part of the time, click on
another part and repeat the number scrolling. Click on either
arrow to toggle between AM and PM. To change the date, highlight the date icon at the lower center by clicking on it. The date
display shows the month, day, and year. Click on any of these
date segments to highlight it and u se the number scroll arrows to
change it. To set the alarm clock, click on its icon at the lower
right to highlight it. The center display reads 12:00:00 AM. As
just described, change the time to the time you want the alarm to
sound. Then click on the small switch (the alarm button) at the
left of the strip. Click the date icon so that none of the numbers
are highlighted and the date returns to the center strip. Note
that the alarm clock icon now has radiating lines. At the time for
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which the alarm is set, the computer beeps once, and the apple
icon in the menu bar flashes on and off until you tuTn the alarm
button off.
The clock can be moved anywhere on the screen, except onto
the menu bar, by dragging the top strip. If you wish to have it
open while working on an application, you will h ave to reduce the
size of the working windows on many applications. Expose a strip
of desktop where you can place the clock; otherwise, it will be hidden when the application window is active .
If you want to include the current time and date in a docu ment, these can be transferred directly using the copy and paste
method. Click on the clock to make it active. The time and date
are automatically selected even though they do not appear highlighted. Just choose Copy from the File menu to place the time
and date on the clipboard, click an insertion point at the desired
location in the document, then choose Paste.
• Calculator. The calculator is a replica of a four-function, handheld calculator and works the same way (Figure B-3). The keys of
the calculator are arranged like a ten-key pad or a numeric keypad if your k eyboard h as one. Calculations can be done either
with the keys on the keypad or by clicking the pointer on the
number buttons on the screen image. Two operator keys may be
different than those you have seen on other calculators. The key
with the asterisk (*) is the operator for multiplication; the slash
(/) is the division operator.

D Calculator

As with other windows, the calculator can be moved around by
dragging its title bar. The calculator has a close box to the left of
its title. You can transfer the results of your calculations directly
into a document. As with the Alarm Clock, when the Calculator is
active, its display is automatically selected, although it is not
highlighted. Use the Copy and Paste commands as described for
the Alarm Clock above.
Numbers from documents or other DAs can also be pasted into
the calculator. Select the number in the document or DA by dragging to highlight it and choose Copy (File menu). Make sure the
calculator is active, then choose Paste. Once in the Calculator display, the number can be u sed for further calculations in the same
way as a number entered with the number buttons or keys.
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• Chooser. If your computer is attached to more than one printer,
an icon for each pdnter appears in the Chooser window. To switch
from one printer to another, you must select the printer icon in
the Chooser for the printer that will be used. Selecting another
pdnter changes other dialog boxes , such a s the Page Setup and
Print dialog boxes. Details on the Chooser appear in Chapter 8.
• Control Panel. The control panel modifies the characteristics of
a number of elements u sed both in the desktop and in applications. Most of these controls never need changing once they are
adjusted to your personal preferences.
The system in the startup disk you are using may have a
Control Panel that varies from the ones illustrated (Figure B-4
and Figure B-5). These are early and recent versions of the
Control Panel. The appearance and function of the control panel
has been modified periodically with revisions in the system software; however, most of the functions described should be on the
system you are using and can be adjusted in the same way.
Figure B-4
Control Panel desk
accessory (early version)
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The overall pattern of the desktop that lies behind windows
can be changed with the Desktop Pattern control. The left square
in that control is an enlarged view of the pattern, and the right
rectangle is a sample of how the pattern appears in actual size.
Clicking the arrows in the strip above the right rectangle
changes the pattern in both windows, displaying a range of flat
values between white and black and other patterns with each
click. If you continue to click one of the arrows, you will eventually return to the first pattern. When you have chosen a pattern,
click inside the right rectangle to put the pattern into effect for
th e desktop.
The rate the insertion point blinks can be made slower or
faster by clicking on one of the buttons in the Rate of Insertion
Point Blinking control box. The sample insertion point indicates
the speed of blinking when working with text on the desktop, in
applications, and in DAs.
The time and date can be set in the Time and Date control
panel by the same method used in the Alarm Clock DA. In addition you can have the clock read as a 24-how· clock (often called
military time). When you have completed adjusting the time and
date, click on their icons to start them running.
The Speaker Volume control adjusts the loudness of the beeps,
music, and other sounds that can be produced by the computer.
Position the cross h air on the slide bar and drag it to a higher
number to increase the volume of the sound or toward zero to
soften it. When you release the mouse button, the tone you hear
is at the volume used for beeps and other sounds. Unless absolutely necessary, it is not good practice to turn the sound off completely (zero on the scale). Beeps are frequently used as alerts for
incorrect procedures or as warnings.
The RAM cache is a temporary storage area set aside to hold
information that applications use repeatedly while you are working on a document. The cache allows the computer to draw the
information from its internal memory rather than going to the
disk for it. Accessing internal memory is much faster th an accessing th e disk. Generally th e RAM cache should be modest in size,
16K or 32K, when the On button is highlighted.
Note: If you have a recent version of the Control Panel (Figure
B-5), you need to select the Keyboard or the Mouse icon in the left
section of the panel to display the controls described below. Scroll
the window if necessary to find those icons.
Each character on the keyboard and the keypad repeat, and
continu e to repeat, if you keep its key depressed. This facilitates
typing a series of the same character, such as a row of periods,
asterisks, dashes, or underline characters. The Key Repeat Rate
control box (Keyboard display) adjusts how rapidly a character
repeats (Figure B-6).
The Delay Until Repeat control box (Keyboard display) adjusts
the interval between the time when you first depress a key and
the time when the key character starts repeating on the screen
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(Figure B-6). Typists vary in how rapidly they complete each
keystroke when typing straight text. Increasing the delay interval lessens the chance of repeating unwanted characters. If you
often get multiple characters with a keystroke, click the button
that lengthens the delay time or turn the repeat function off
entirely by clicking on th e Off button.
Figure B-6
The Key Repeat Rate and
Delay Until Repeat control
boxes
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The Mouse Tracking control box (Mouse display) a llows you to
adjust the ratio between th e distance you move the mouse and
the distance the pointer moves on the scr een (Figure B-7).
Clicking on the Fast button makes the pointer move a long distance on the screen with a relatively short movemen t of t h e
mouse. If you are doing something that requires very precise control, such as a detail in a graphic application, you may wish to
have the setting on Slow so that the pointer moves a shorter distance relative to the movement of the mouse. If a graphic tablet
and stylus are used instead of a mouse, the tracking is generally
set at the slowest setting so the pointer movement and the stylus
movement are closely coordinated. For most purposes, use one of
the two middle settings.
Figure B-7
The Mouse Tracking and
Double-Click Speed control
boxes
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The Double-Click Speed (Mouse display) is used to adjust the
interval between clicks of the mouse button when using its double-clicking function (Figure B-7). If you are having trouble making your double-clicks work as they should to open windows or
applications, select one of the buttons that increases the interval
between clicks so that the second click does not have to follow so
quickly after the first.
• Key Caps. Selecting Key Caps opens a window that is a replica
of the keyboard with a single line text field above it. Also a new
title, Key Caps, is added to the menu bar. The keyboard replica
displays the character for each key that corresponds to the real
keyboard. The characters are displayed in one of the typefaces in
the System file on the startup disk (Figure B-8). Pressing the
Shift key on the keyboard displays the uppercase characters on
the keys of the replica. Pressing the Option key on the keyboard
displays special characters on the replica. This represents the key
combinations to use on the keyboard if you need those characters
while working on a document in an application. With some fonts,
pressing the Option and Shift keys together displays additional
special characters.
Figure B-8
The Key Caps desk
accessory

Key Caps

The typefaces that are installed on the startup disk you are
using are listed in the Key Caps menu. The typeface currently
shown in the Key Caps display is checked in the Key Caps menu.
Selecting another typeface changes the character style on the
keyboard replica to that typeface style. Word processing, graphic,
and some of the other applications allow you to choose typefaces
to use in your documents; with Key Caps you can see what each
available typeface looks like.
Typing on the keyboard or clicking on the character keys on
the replica enters text into the text field when Key Caps is active.
Combinations of the Shift, Option, and Command keys with a
character key, however, must be done partly on the keyboard. The
text can be edited in the same way as other text. Backspace
(Delete) erases the characters to the left of the insertion point.
The pointer becomes an I-beam when inside the text field and can
be used to reposition the insertion point. The characters you type
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in the text field change to any new typeface you choose from the
Key Caps menu, just as they change on the keys of the replica.
The contents of the text field are not automatically selected as
is the case with the Alarm Clock and Calculator. If you wish to
copy and paste all or part of the contents, you must first drag
over the text with the I-beam to highlight it, then use the Copy
and Paste commands.
• Note Pad. Selecting the Note Pad DA from the Apple menu
brings up a window that looks much like the scratch pads often
used for jotting notes as reminders or random bits of information.
This note pad serves much the same function (Figure B-9). It can
be called up while working on a document if a message needs to
be recorded for later reference. The message is stored as part of
the Note Pad application on the current disk and stays there
until you remove it. It can be recalled in any document on the
disk or on the desktop.
FigureB-9
The Note Pad desk
accessory

D

Note Pad

Keep your notes, references,
lists, or any text on this pad.
Click on the dog eared corner to
go to the next page. Click on the
bot tom 1eft corner to go to the
previous page. The note pad has
eight numbered pages.

The Note Pad offers eight pages of notes, each numbered at
the bottom of the pad. To change the page, click on the upturned
corner of the pad at the lower left. To go back a page, click on the
corner triangle. As with many of the other DA windows, you can
move the window by dragging its title bar and close the window
by clicking on the close box.
The text you type into the pad can be edited as in other word
applications. The text can be highlighted, cut or copied, and then
pasted into other documents. The reverse is not true, however;
you cannot paste text from another source into the Note Pad.
• Scrapbook. The Scrapbook DA is a good place to store text or
graphics that you use frequently in documents, such as letterheads, logos, or art images (Figure B-10). The items in the scrapbook become part of the scrapbook application until you remove
them and are available while working in any document on the
same disk. It is also a handy place to store items temporarily,
such as a number of illustrations that will be inserted at inter-
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vals into a text document. These can be taken from the scrapbook
individually and pasted into the text document at the appropriate
spot.
Fig ureB-10
The S crapbook desk
accessory

Scrapbook

The Scrapbook is a good p 1ace
to keep text or graphics that
you use frequent 1y, such as a
1etterhead, or as a coll ecting
area for illustrati ons to be
used in a word processing
document.

1 / 6

M\\IRT, TEXT

When you paste from the scrapbook to a document, the whole
scrapbook page must be cut or copied; therefore, only as much
text or a graphic that you want at one time should occupy a page.
The page of the scrapbook in view is automatically selected when
the scrapbook window is active. To transfer items to the scrapbook, they must be copied or cut from their original documents
and pasted into the scrapbook. When you open the scrapbook to
paste an item into it, the last item entered shows in the window.
Choosing paste adds a page to the scrapbook in front of the page
displayed.
To transfer an item from the scrapbook to another document,
open the scrapbook and scroll until the item you wish to transfer
is displayed. Choose Copy or Cut from the Edit menu. The scrapbook item is transferred to the Clipboard. From there you can
paste the item into the new document.

Special Characters

Most typeface fonts have th e special characters shown in the chart
below. To type a special character, press the Option key, or the Shift
and Option keys together, then type the key shown in the left column. Diacritical marks, such as the acute accent ('), grave accent
('), circumflex (A), umlaut ("), and tilde (-), must be typed first and
then followed immediately by the character to be placed under the
mark (example: e, e, e, e, ii).
Special typefaces, s uch as Symbol, Cairo , Mobile, or Zapf
Dingbats, devote all keys and key combinations to a wide variety of
symbols and icon s. To review all the characters on specialized fonts
installed in the system of your startup disk, use the Key Caps desk
accessory described in Appendix B.
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Answers to the
Self Test Questions

Chapter 1
Part A

PartB

1.
2.
3.
4.
5.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

a
d
b
d
b

PartC

g
d
j
e
f
b

1.
2.
3.
4.
5.
6.

a

1.

i
h
c

8.
9.
10.

startup
System file, Finder
icons
arrow
I-beam
Option, Command
menu
highlighted
insertion point
window

PartD
1. a
2.
3.
4.
5.
6.
7.
8.

b

a
c
d
d

a
d

Chapter2
Part A
PartB

PartC

PartD

1.
2.
3.
4.
5.

1.
2.
3.
4.
5.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

b
c
a
b
a

1.
2.
3.
4.
5.
6.
7.
8.

h
g

a
f
c
e
b
d

check boxes, radio buttons
disk
dialog box
Close, New
kilobytes

F
F
T
T
T
F
F
T
F
T
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Chapter 3
Part A
1. b
2. c
3. a
4. d
5. a

Chapter4
Part A
1. b
2. c
3. d
4. a
5. c

Chapter5
Part A
1. b
2. c
3. d
4. a
5. c

PartB
1. a
2. h
3. f
4. c
5. e
6. b
7. g
8. d

PartC
1. documents, folders,
applications
2. Shift
3. selection rectangle
4. hierarchical
5. View

PartD
1. F
2. T
3. F
4. F
5. F
6. T
7. F
8. F
9. T
10. T

PartB
1. F
2. F
3. T
4. T
5. F
6. F
7. F
8. T
9. T
10. F

PartC
1. desk accessories
2. File
3. select
4. insertion point
5. comment box
6. application

PartD
1. e
2. g
3. i
4. b
5. f
6. d
7. h
8. j
9. a
10. c

PartB
1. g
2. e
3. f
4. b
5. j
6. c
7. 1
8. a
9. h
10. d

PartC
1. screen font
2. colon
3. decimal
4. margin, first-line
5. Command

PartD
1. F
2. F
3. T
4. T
5. F
6. T
7. F
8. T
9. F
10. F
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Chapter 6
Part A
PartB
1. i
1. c
2. j
2. a
3. b
3. f
4. c
4. c
5. b
5. e
6. g
7. b
8. a
9. d
10. h
Chapter 7
Part A
PartB
1. b
1. h
2. d
2. c
3. a
3. e
4. c
4. j
5. d
5. a
6. i
7. f
8. b
9. d
10. g
Chapters
Part A
1. c
2. a
3. b
4. d
5. a

PartB
1. b
2. c
3. a
4. c
5. b
6. c
7. b
8. c
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PartC
1. paint tools, fill patterns
2. grabber
3. polygon, freehand
4. Option
5. Shift

PartD
1. T
2. F
3. F
4. T
5. T
6. F
7. T
8. T
9. F
10. F

PartC
1. oval, Shift
2. corner handle, Shift
3. grid snap
4. Command
5. Reshape

PartD
1. F
2. T
3. F
4. F
5. T
6. F
7. T
8. T
9. F
10. F

PartC
1. F
2. T
3. F
4. T
5. T
6. T
7. F
8. F
9. T
10. F

active window:
The window where action
can take place. An active window is identified
by the hor izontal stripes in its title bar and is
in front of all other windows.
application: A program for specialized work
such as word processing, graphics, manipulating numbers or other data, or composing or
playing music. Applications are r eferred t o as
software.
backup disk: A duplicate disk that contains
a second copy of documents. Backup copies
save redoing work in case the original disk is
damaged or lost.
bit-mapped: Letters and graphics are made
up of arrangements of black pixels, or bits,
contrasting with white pixels. The computer
keeps track of, or maps, the location of each
pixel and whether it is black or white.
check boxes: Small square boxes, often used
in dialog boxes, that offer a range of options in
which one, a few, or all can be selected.
Chooser:
A desk accessory that lets you
access printers and other resources that are
connected to the computer through the printer
and modem ports at the back of the main unit.
clicking: Pressing and quickly releasing the
mouse button without moving the mouse. For
example, clicking is u sed to select icons or
place insertion points.
clipboard: A temporary holding place in the
computer's memory for text or graphics which

is available in applications or on the desktop.
Text or graphics are moved to the clipboard
when you choose the Cut or Copy command.
close box: The small box at the left end of the
title bar in an active window. Clicking with
the pointer on the box closes the window.
command:
A word or phra se that, when
selected, directs the computer to take a particular action . Most commands are found in
menus, in dialog boxes, or on text buttons.
Command key: The key with the cloverleaf
symbol next to the spacebar. For many menu
commands, you can use this key plus a letter
key rather than selecting the command from
the menu with the mouse.
comment box: A text box in the Get Info
window for entering a reminder or description
of a document, folder, or disk.
constrain: In paint and draw applications, to
limit a tool's action to a vertical, horizontal, or
45-degree direction by pressing the Shift key
while dragging the tool. Shapes drawn with
the rectangle and ellipse tools are constrained
to squares and circles. Objects being moved
can be constrained to horizontal and vertical
directions.
data disk: A disk devoted entirely to storing
documents. A data disk does not need to have
the syst em folder or the application on it, so
all the storage space can be u sed for documents.
default: The setting that the application will
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use unless you specify another setting. For
example, in a word processing application,
format and typeface are already set but can
be changed after the application is open.
desk accessories: Small applications that
are designed to do a specific task, such as control the operating characteristics of the keyboard and mouse, show the time and date,
connect a printer, or store notes and graphics.
One or more desk accessories can be opened
while working in an application.
desktop: The grey area and menu bar that
fills the screen when the computer is on. The
desktop is the working environment for the
Macintosh.
dialog box: A box that asks for more information. A dialog box may list choices you can
make by clicking on a check box or button or
by performing an action such as typing a title .
Dialog boxes may also contain a message or
warning.
directory: A list of the contents of a folder or
disk. Directories may list titles in alphabetical or chronological order and may use icons
as a pictorial reference as well. A Finder window on the desktop is a directory. Some dialog
boxes, such as those for the Save and Open
commands, include directories.
document: What you create with an application. Information, such as text, numerical
data, or graphics, that has been entered and
saved is a document.
do t-matrix printer: A type of impact printer,
such as the ImageWriter, that uses a matrix
of pins in its print head. The pins are activated in different patterns to make up letter
shapes or graphics when they strike an inked
ribbon against the printing paper.
do uble-clicking: Pressing the mouse button
twice in rapid succession without moving the
mouse. Double-clicking extends the action of
clicking an additional step, such as opening
an application from the desktop.
dragging: Pressing and holding the mouse
bu tton while moving the mouse. Dragging
performs many actions such as moving icons,
selecting words, or drawing in graphic programs.
FatBits: A command that enlarges an area of
the screen in some paint applications so you
can see each individual pixel and can make
very detailed revisions.
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Finder: A system application that manages
icons and directories on the desktop and
allows you to move information to and from
disks.
first line marker:
A small symbol on the
ruler of word processing applications that can
be set to automatically indent the first line of
a paragraph any desired number of spaces, or
to create a hanging indent.
floppy disk: The 3 1/2-inch disk in the rigid
plastic housing is referred to as a floppy.
Floppy is a carryover from the original computer disks that were flexible.
flush: Used to describe the alignment of text.
Flush left means all the lines of text are
aligned evenly on the left side of the text
block, or an equal distance from the left margin of the page.
folder: A folder, much like a real file folder,
that stores documents, applications, and other folders on the desktop. Folders are used to
organize your desktop.
font: Usually used in applications as synonymous with typeface; however, font means only
one of what can be many variants in size and
style of a typeface. For example, Helvetica is
a typeface; 12 point Helvetica italic is a font.
font substitution:
An option in the
LaserWriter Page Setup dialog box. If selected, the LaserWriter substitutes one of its
built-in PostScript fonts if a Macintosh bitmapped font was used in the document.
footer:
Information that appears at the bottom of each printed page in a document. A
footer usually has the same function as a
header.
format: The layout of text on a page of a written document, such as margin settings, line
spacing, paragraph alignment, columns, and
tab settings.
Get Info window: A window that displays
information about a document, application,
folder, or disk. The window is opened by
selecting the appropriate icon on the desktop
and choosing Get Info from the File menu.
grabber: The hand-shaped pointer in paint
applications and in some draw applications
used to drag parts of the working area that
are hidden into view.
grid lines: Dotted lines, or a pattern of dots,
that show on the screen in paint and draw
applications. The lines are an aid in aligning
and sizing while constructing images but do

Glossary
not appear on the printed page. Some applications use the term ruler 1ines.
grid snap: A command that causes the pointer to jump to the nearest hidden grid increment when drawing or moving objects in a
graphic program. Grid snap is an aid in aligning objects and ca n be turned off to make fine
adjustments between grid increments.
group: A command that bonds two or more
selected objects into a single object. The command is found in draw programs.
handles: Small boxes that appear at intervals around the s hape of a graphic when
selected. The handles are used to modify the
shape. Ha ndles appear on graphics in a word
processing document and around images in
draw applications.
hanging indent:
A paragraph format in
which the first line in a paragraph starts to
the left of all other lines in the paragraph.
This paragraph is formatted with a hanging
indent.
header: Information that appears at the top
of each printed page in a document. Headers
usually include the title of the document a nd
the page number but can have any information you specify.
hierarchical file system:
Enables th e
Finder to keep track of the contents of nested
folders; in this system, folders may be inside
other folders, which are also within folders,
for as many layers as necessary to organize
documents efficiently. Folders are used in a
way similar to subdirectories in other systems.
highlighted: When an icon or text is selected, it becomes highlighted. The whites a nd
blacks are reversed-lines and letters that
were originally black become white, and the
background that was originally white
becomes black.
I-beam: The shape of the text pointer when it
is over an area where text can be entered or
edited. The shape is similar to an I, like the
end of a structural I-beam.
icon: A small picture of an object, such as a
disk, document, folder, or application. Icons
are often used instead of word descriptions to represent an item, conce pt, or a
message.
insertion point: A blinking vertical bar that
marks the spot in text where a keyboard
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action will take place. An insertion point is
placed in t ext by moving the I-beam pointer to
the desired spot and clicking the mouse button. The insertion point is also called a cursor.
keyboard:
The hardware component with
keys for entering text, numbers, or special
characters. Special keys pressed in combination with letter keys can also perform many
commands.
kilobyte: 1024 bytes, often rounded to 1000.
The amount of storage available or used on a
disk is expressed in kilobytes, indicated by
the K tha t follows the number. One single spaced typewritten page occupies about 3
kilobytes of storage on a disk.
landscape: An orientation of the layout on a
page. In la ndscape orientation, the page is
turned sideways with the long sides of t he
paper at the top and bottom of the page.
laser printer: A printer that uses electrophotography to produce images on paper, a process much like that u sed in office copiers.
Laser printers are capable of printing much
higher r esolution images than can be ob tained from dot-matrix printers.
lasso: A paint tool that can be used to select
and cut, copy, or move an image or parts of an
image in the paint window.
layering: The relationship of drawn shapes
stacked over other shapes in draw progra ms.
Each shape retains its entity as a separate
unit. Shapes can overlap or completely cover
other sha pes without one layer affecting the
other. Although a filled shape might block out
any other shape it covers, it does not cha nge
the shape underneath.
Locked box: A check box in the upper right
corner of the Get Info window t hat can be
clicked if you wish to prevent anyone from
trashing your document or changing its name
or contents.
margin marker: A symbol on the ruler used
to set the left and right margins for the text
in word processing documents.
menu:
A list of commands directing t h e
computer to perform a n act ion. Mo st
menus drop down when the menu name
is selected in the menu bar.
menu bar:
The strip along the top of t he
desktop that contains the t itles of the dropdown menus. Some titles in the menu bar
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change a nd new titl es are added wh en a n
application is open.
message box: A type of dialog box tha t contains informa tion, instructions, or w a rnings .
·
m ouse: The small ha nd-held device that is
rolled on a flat surface to move the pointer on
the screen.
m ouse button:
Th e button on top of th e
mouse tha t signals the computer to take some
action at the location of the pointer.
object-oriented: Shapes, lines, or patterns
drawn in a dra w program that the computer
stores as math ematical inform a tion. Thi s
data iden tifies ch a racteristics of the drawn
object such as size, loca tion , fill pattern, or
line width . Because informa tion sent to the
printer describes the object instead of relaying a bi t map, the object is printed at the resolution of the printer.
Option key: A speci al key on the keyboa rd
used in conjunction with oth er keys to offer a
ran ge of s peci al t e xt chara cte r s . Th ese
include symbols used in mathematics and scie ntific t ext, diacritical marks used in lan guages, t r ue open a nd cfosed quote marks,
and a variety of symbols used in business a nd
other writing. The Option key has additional
special functions in gra phic and other types of
programs.
paint window: The area used for crea ting
images in a paint progr am.
palette: One or more strips a t the sides of
paint a nd draw progra m windows that hold
choices of paint or dra w tools, fill patterns,
a nd line thickness.
p in fe ed paper: Printing paper with a continuous chain of pages joined end to end with
holes along the ma rgins tha t engage sprockets in the printer. The rotating sprockets pull
t he paper into the printer. Pin feed pa per is
a ls o call ed continuous fo r m or compute r
paper.
Bl ack an d white squa r e dot s t ha t
p ix els:
make up the shapes on the screen. The standard Macintosh screen is made up of 72 pixels
per linear inch, or over 5000 pixels per square
inch.
point: A measure of type size or type height.
One point is 1/72 of an inch.
poi nter:
A s mall graphic symbol on th e
screen th at moves when th e mouse moves.
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Th e arr ow a nd I-beam a re poin ter sha pes
used on t he desktop. The pointer ma y have
many other shapes in applications.
portrait: An orien tation of the layout on a
page. In portrait orientation , the shor t sides
of the pa per are at the top and bottom of the
page. Mos t printing is done in portrait orienta tion.
radio button: A small round button often
used in di alog boxes. Each button offer s a
choice among two or more options. Selecting
one button usually deselects other options.
ragged: A word describing the uneven alignment of t ext lines. Ragged is the opposite of
flu sh . A text block may be formatted to be
evenly aligned (flush ) on one side and unevenly aligned (ragged) on the other.
screen fonts:
Files t hat reproduce the ty pe
on the screen or on a dot-m atrix prin ter.
Screen fonts are bit-mapped fonts designed to
match th e resolution of the scr een (72 dots
per inch) for the best appearance a nd legibility.
scroll arrows:
The a rrows in boxes a t th e
ends of scroll bars . Pressing a nd holding the
pointer on one of the a rrows moves items outside the window into view.
scroll bars : The shaded vertical a nd horizont al ba r s along the right side a nd bottom of
most windows. Scroll bars a re used to move
other pa rts of a document t hat a re not currently displayed in the window into view.
scroll box: A small white movable squa re in
active scroll bars. The box moves in the direction of the a rrows at the ends of the scroll
bars as you press the mouse button with the
pointer on the arrows. Also, you can move the
scroll box independently by dragging it along
the scroll bar with the pointer.
sel ecting:
Selecting designa t es wh er e the
next action will take place. A selection is often
highlig hted. Selecting also includes se tting
insertion points and clicking on buttons.
selection r ectangle: A rectangle that can be
dragged with the pointer to enclose and select
several icons on the desktop or a n image in a
graphic application document.
A box in t he lower right corner of
size box:
most \vindows represented by a small square
ove rlapping a la rger square. Draggin g the
size box with the pointer cha nges t he size of
the \vindow.
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smoothing: An option in the Page Setup dialog box for laser printers that, when selected,
makes bit-mapped fonts and graphics created
in paint applications look slightly smoother
when printed than they appear on the screen.
software: Programs or instructions that the
computer reads from a disk.
startup disk:
A disk that has the System
files needed to start the computer and run
applications. An application disk that has
the System files included on the disk is a
startup disk.
System files:
System applications used to
start the computer and provide system-wide
information for desktop and applications
management. Fonts and desk accessories are
a lso stored in the System file.
tab marker: Small symbols on the ruler in
word processing applications that can b e
place d at intervals along the ruler for tab
stops. Tab stops locate the positions where the
insertion point moves when the Tab key is
depressed.
tall adjusted: An option in the Image Writer
Page Setup dialog box. The box, if checked,
prevents distortion in graphics when printed.
text block: A unit of text that has the same
formatting. A block may be one line, a paragraph, or larger unit.
text button: A rectangular button with a title
or command written on it. These buttons usua lly cause an immediate action to happen
when clicked. Buttons such as Save, Cancel,
and OK in dialog boxes are examples of text
buttons.
text field: An area in a dialog box or window
that can receive text. For example, the space
where you enter a title in the Save dialog box
is a text field.
title bar: The strip across the top of a window
that contains the name of the window. An
active window h as a pattern of horizontal
lines in the title bar.
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trash: An icon on the desktop shaped like a
trash can. Documents can be erased from the
disk by dragging their icon into the trash.
Trashing a document means to put it in to the
trash can.
type size: The measure of a type's height in
points. For example, there are 72 points in an
inch so a 12 point type size is one-sixth of an
inch tall.
type style:
Variations within a typeface.
Plain, bold, italic, underline, outline, and
shadow are styles found in the Style menu for
almost all applications used for creating text
or graphic documents.
typeface: Type of a uniform design. The characteristic design of a set of type fonts. Each
design i s identified by name, such as
Helvetica, Times, New York, or Geneva. The
names in the Font m enu are typefaces
installed in the system file on the startup
disk.
window:
On the desktop, the area that
displays icons for documents, applications, or
folders that are stored on a disk or in other
folders. In applications, the window is the
working area.
wordwrap:
When a word in a line of text
automatica lly moves to the next lin e as it
approaches the right-hand margin of the text
block.
write-protect tab:
A tab on a floppy disk
that can be set to prevent the computer from
writing information to the disk. However, the
computer can still read information from the
disk.
zoom box: The small box within a box at the
right end of the title bar. Clicking on the zoom
box enlarges the window instantly to nearly
the full size of the screen and a llows you to
see more of the contents of the storage field in
the window.

Alarm Clock, 189-190
Apple menu, 54, 187-188
application
defined,2
icon, 25-28
opening, 72-73
quitting, 30-31, 89
using an, 23-24
backing up document, 89
bit-mapped, 95
calculator, 190
check box, 34-35
chooser, 165-167, 191
Command key, 17-18
constrain, 134
control panel, 191-194
copying documents, 180-182
creating a new document, 30
default, 78-79
desk accessories, 54, 188-196
desktop, 3-4
dialog box, 33
directory, 33
disk, 13-17
backup, 15
data, 15, 72
floppy, 13-16
hard, 16-17

initializing, 177-178
labels, 180
preparing, 1 77
reusing, 179-180
storage, 24-25
write-protect tab, 14
document
backing up, 89
copying, 180-182
creating, 30
defined,23
editing text, 76-78
entering text, 73-75
formatting text, 78-86
icon, 25-28
placing graphic in, 88-89
saving, 28-30, 87-88
writing a, 73-86
dot-matrix printer, 163
draw and paint applications, differences
between, 95-97, 129-130
draw application
duplicating objects, 141
entering text, 143-144
fill, 139-140
grouping objects, 140
layering, 143
line thickness, 139-140
menu commands, 150-154
moving shapes, 136-137
opening, 130-131
selecting objects, 135-136
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specialized menu commands, 154-155
draw tool
a rc, 149-150
freehand, 148-149
line-only, 133
straight line, 148
shape tools, 134
draw window, 131

menu commands
draw applications, 150-155
using in paint application, 115-120
message box, 35
mouse, 4-11
button, 6-8
pointer, 4-5
moving shapes 136-137

Edit menu, 57-59
Edit menu commands, 62-63
eraser tool, 111

Note Pad, 195

Fa tBits, 96
File menu, 54-57
File menu commands, 61-62
Finder, 188-189
Find File, 184-186
folder, 9-10
folders, moving icons between, 42
Font Substitution, 170
footer, 170
grabber, 99, 133
graphics
placing in a document, 88-89
using with a word document, 120-122
grid, 132
grid snap, 137
group, 140
handles, 135
hanging indent, 81
hard disk management, 182-184
header, 170
hierarchical file system, 39-40
I-beam, 12
icon
defined,2
moving, 42-43
selecting, 42-43
insertion point, 12
keyboard, 11-12, 17-18
u sing to perform commands, 60
Key Caps, 194-195
kilobyte, 24
landscape, 168
laser printer, 164
lasso, 106
line spacing, 83-84
Locked box, 56
margin markers, 79-80
menu, 8-9

object-orient ed, 96
opening
application, 72-73
paint application, 97
Option key, 18
Page Setup command, 167-171
paint and draw applications, differences
between, 95-97, 129-130
paint application
opening, 97
using menu commands, 115-120
paintbrush t ool, 114-115
paint bucket, 105
paint tool
defined, 101
paintbrush, 114-115
shape tools, 102
spraypaint, 115
straight line, 103
paint window, 97-98
palette
\
defined,97
drawing tool, 131-132
fill, 99
line thickness, 98
paint tool, 98
paragraph alignment, 83
pencil tool, 110
pixel, 95
portrait, 168
Print command, 171-174
printer, 163-164
dot-matrix, 163
laser, 164
printing, 164-165
quitting an application, 30-31, 89
radio button, 34
saving a document, 28-30, 87-88
Scrapbook, 195-196
screen font, 85-86
scroll bars, 44-45
selecting objects, 135-136

Index
selection rectangle, 106
selection tools, 106-107
lasso, 106
rectangle, 106
setting tabs, 82-83
Shift key, 18
shut down, 12-13, 32
Smoothing, 170
software, 2
Special menu, 59, 63-64
spraypaint tool, 115
starting the computer, 2-3
startup disk, 2
system file, 15
tab markers, 82
Tall Adjusted, 168-169
text block, 143
text button, 34
text field, 34
text tool, 105-106
tool palette, 131-132
typeface, 85-86
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type size, 85-86
type style, 85-86
View menu, 47-48
window
draw, 131
features, 40-46
paint, 97-98
moving, 41
moving icons between, 42
multiple, 40
scroll bars, 44-45
size box, 44
sizing, 43-44
zoom box, 43-44
word document, using graphics with,
120-122
word processing applications, 71-72
wordwrap, 74
writing a document, 73-86
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